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Copyright and Disclaimer
Product specifications are subject to change without notice and do not represent a commitment on the part 
of Avid Technology, Inc. The software described in this document is furnished under a license agreement. 
You can obtain a copy of that license by visiting Avid's Web site at www.avid.com. The terms of that license 
are also available in the product in the same directory as the software. The software may not be reverse 
assembled and may be used or copied only in accordance with the terms of the license agreement. It is 
against the law to copy the software on any medium except as specifically allowed in the license 
agreement. Avid products or portions thereof are protected by one or more of the following United States 
patents: 4,746,994; 4,970,663; 5,045,940; 5,267,351; 5,309,528; 5,355,450; 5,396,594; 5,440,348; 
5,452,378; 5,467,288; 5,513,375; 5,528,310; 5,557,423; 5,568,275; 5,577,190; 5,584,006; 5,640,601; 
5,644,364; 5,654,737; 5,715,018; 5,724,605; 5,726,717; 5,729,673; 5,745,637; 5,752,029; 5,754,851; 
5,799,150; 5,812,216; 5,852,435; 5,883,670; 5,905,841; 5,929,836; 5,929,942; 5,930,445; 5,946,445; 
5,987,501; 5,995,115; 6,016,152; 6,018,337; 6,023,531; 6,035,367; 6,038,573; 6,058,236; 6,061,758; 
6,091,778; 6,105,083; 6,118,444; 6,128,001; 6,130,676; 6,134,607; 6,137,919; 6,141,007; 6,141,691; 
6,157,929; 6,198,477; 6,201,531; 6,211,869; 6,223,211; 6,239,815; 6,249,280; 6,269,195; 6,301,105; 
6,317,158; 6,317,515; 6,327,253; 6,330,369; 6,351,557; 6,353,862; 6,357,047; 6,392,710; 6,404,435; 
6,407,775; 6,417,891; 6,426,778; D396,853; D398,912. Additional U.S. and foreign patents pending. No 
part of this document may be reproduced or transmitted in any form or by any means, electronic or 
mechanical, including photocopying and recording, for any purpose without the express written permission 
of Avid Technology, Inc.

Copyright © 2003 Avid Technology, Inc. and its licensors. All rights reserved. Printed in USA.

The following disclaimer is required by Apple Computer, Inc.
APPLE COMPUTER, INC. MAKES NO WARRANTIES WHATSOEVER, EITHER EXPRESS OR IMPLIED, 
REGARDING THIS PRODUCT, INCLUDING WARRANTIES WITH RESPECT TO ITS 
MERCHANTABILITY OR ITS FITNESS FOR ANY PARTICULAR PURPOSE. THE EXCLUSION OF 
IMPLIED WARRANTIES IS NOT PERMITTED BY SOME STATES. THE ABOVE EXCLUSION MAY NOT 
APPLY TO YOU. THIS WARRANTY PROVIDES YOU WITH SPECIFIC LEGAL RIGHTS. THERE MAY BE 
OTHER RIGHTS THAT YOU MAY HAVE WHICH VARY FROM STATE TO STATE.

The following disclaimer is required by Sam Leffler and Silicon Graphics, Inc. for the use of 
their TIFF library:
Copyright © 1988–1997 Sam Leffler 
Copyright © 1991–1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software [i.e., the TIFF library] and its 
documentation for any purpose is hereby granted without fee, provided that (i) the above copyright notices 
and this permission notice appear in all copies of the software and related documentation, and (ii) the 
names of Sam Leffler and Silicon Graphics may not be used in any advertising or publicity relating to the 
software without the specific, prior written permission of Sam Leffler and Silicon Graphics.

THE SOFTWARE IS PROVIDED “AS-IS” AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, 
IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, 
INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES 
WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER OR NOT ADVISED 
OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING OUT OF OR IN 
CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

The following disclaimer is required by the Independent JPEG Group:
Portions of this software are based on work of the Independent JPEG Group.

The following disclaimer is required by Paradigm Matrix:
Portions of this software licensed from Paradigm Matrix.

The following disclaimer is required by Ray Sauers Associates, Inc.:
“Install-It” is licensed from Ray Sauers Associates, Inc. End-User is prohibited from taking any action to 
derive a source code equivalent of “Install-It,” including by reverse assembly or reverse compilation, Ray 
Sauers Associates, Inc. shall in no event be liable for any damages resulting from reseller’s failure to 
perform reseller’s obligation; or any damages arising from use or operation of reseller’s products or the 
software; or any other damages, including but not limited to, incidental, direct, indirect, special or 



consequential Damages including lost profits, or damages resulting from loss of use or inability to use 
reseller’s products or the software for any reason including copyright or patent infringement, or lost data, 
even if Ray Sauers Associates has been advised, knew or should have known of the possibility of such 
damages.

The following disclaimer is required by Videomedia, Inc.:
“Videomedia, Inc. makes no warranties whatsoever, either express or implied, regarding this product, 
including warranties with respect to its merchantability or its fitness for any particular purpose.”

“This software contains V-LAN ver. 3.0 Command Protocols which communicate with V-LAN ver. 3.0 
products developed by Videomedia, Inc. and V-LAN ver. 3.0 compatible products developed by third parties 
under license from Videomedia, Inc. Use of this software will allow “frame accurate” editing control of 
applicable videotape recorder decks, videodisc recorders/players and the like.” 

The following disclaimer is required by Altura Software, Inc. for the use of its Mac2Win 
software and Sample Source Code:
©1993–1998 Altura Software, Inc.

The following disclaimer is required by Ultimatte Corporation:
Certain real-time compositing capabilities are provided under a license of such technology from Ultimatte 
Corporation and are subject to copyright protection.

The following disclaimer is required by 3Prong.com Inc.:
Certain waveform and vector monitoring capabilities are provided under a license from 3Prong.com Inc.

Attn. Government User(s). Restricted Rights Legend
U.S. GOVERNMENT RESTRICTED RIGHTS. This Software and its documentation are “commercial 
computer software” or “commercial computer software documentation.” In the event that such Software or 
documentation is acquired by or on behalf of a unit or agency of the U.S. Government, all rights with 
respect to this Software and documentation are subject to the terms of the License Agreement, pursuant to 
FAR §12.212(a) and/or DFARS §227.7202-1(a), as applicable.

Trademarks
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Acrobat, Adobe, Photoshop, and Reader are either registered trademarks or trademarks of Adobe 
Systems Incorporated in the United States and/or other countries. Apple and Macintosh are trademarks of 
Apple Computer, Inc., registered in the U.S. and other countries. Hi8 is a trademark of Sony Corporation 
of America. Microsoft and Windows are either registered trademarks or trademarks of Microsoft 
Corporation in the United States and/or other countries. QuickTime and the QuickTime logo are 
trademarks used under license from Apple Computer, Inc. The QuickTime logo is registered in the U.S. 
and other countries. RealMedia is a trademark or registered trademark of RealNetworks, Inc. All other 
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Footage

Arri — Courtesy of Arri™/Fauer — John Fauer, Inc.
Bell South “Anticipation” — Courtesy of Two Headed Monster — Tucker/Wayne Atlanta/GMS.
Canyonlands — Courtesy of the National Park Service/Department of the Interior.
Eco Challenge British Columbia — Courtesy of Eco Challenge Lifestyles, Inc., All Rights Reserved. 
Eco Challenge Morocco — Courtesy of Discovery Communications, Inc.
It’s Shuttletime — Courtesy of BCP & Canadian Airlines. 
Nestlé Coffee Crisp — Courtesy of MacLaren McCann Canada. 
Saturn “Calvin Egg” — Courtesy of Cossette Communications. 
“Tigers: Tracking a Legend” — Courtesy of www.wildlifeworlds.com.
Windhorse — Courtesy of Paul Wagner Productions.

GOT FOOTAGE?

Editors — Filmmakers — Special Effects Artists — Game Developers — Animators — Educators — 
Broadcasters — Content creators of every genre — Just finished an incredible project and want to 
share it with the world?

Send us your reels and we may use your footage in our show reel or demo!*

For a copy of our release and Avid’s mailing address, go to www.avid.com/footage.

*Note: Avid cannot guarantee the use of materials submitted.

Avid Products Getting Started Guide • Part 0130-05032-01 • January 2003
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Using This Guide

This guide provides information about how to get started using your Avid 
system. It presents the essential features of the system; most chapters also 
contain hands-on tutorials so you can practice what you learn.

n The documentation describes the features and hardware of all models. 
Therefore, your system might not contain certain features and hardware 
that are covered in the documentation. 

Who Should Use This Guide

This guide is written for video and film editors who are learning to use an 
Avid video-based editing system.

About This Guide

This guide was designed to be used for both the Avid Symphony™ product 
and the Avid Media Composer® or Film Composer® product.

The Contents that precedes this Using This Guide section lists all topics 
included in the guide. They are presented with the following overall 
structure:

• Chapter 1 explains how to turn on your system, install the tutorial 
media, and use Help and online documentation.

• Chapter 2 presents basic editing concepts and walks you through a 
typical workflow scenario.
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• The main body of the guide presents introductory material on various 
aspects of your workflow, followed in most chapters by a tutorial 
section. Work through the tutorial for guided hands-on experience with 
your Avid system.

• A detailed Index helps you quickly locate specific topics. 

This guide should get you started with your Avid system. For more 
information, see the Help and the Avid Symphony Editing Guide or the 
Avid Media Composer and Film Composer Editing Guide.

Symbols and Conventions

When the text applies specifically to the Symphony product, it is marked as 
follows:

• (Symphony only) means the information applies to the Avid 
Symphony product only.

Unless noted otherwise, the material in this document applies to the 
Windows 2000 and Mac OS X operating systems. When the text applies to 
a specific operating system, it is marked as follows:

• (Windows) or (Windows only) means the information applies to the 
Windows 2000 operating system.

• (Macintosh) or (Macintosh only) means the information applies to the 
Mac OS X operating system.

The majority of screen shots in this document were captured on a 
Windows 2000 system, but the information applies to both Windows 2000 
and Mac OS X systems. Where differences exist, both Windows 2000 and 
Mac OS X screen shots are shown.
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Avid documentation uses the following symbols and conventions:

Symbol or Convention Meaning or Action

n A note provides important related information, 
reminders, recommendations, and strong 
suggestions.

c A caution means that a specific action you take could 
cause harm to your computer or cause you to lose 
data.

w A warning describes an action that could cause you 
physical harm. Follow the guidelines in this 
document or on the unit itself when handling 
electrical equipment.

> This symbol indicates menu commands (and 
subcommands) in the order you select them. For 
example, File > Import means to open the File menu 
and then select the Import command.

t This symbol indicates a single-step procedure. 
Multiple arrows in a list indicate that you perform 
one of the actions listed.

k This symbol represents the Apple or Command key. 
Press and hold the Command key and another key to 
perform a keyboard shortcut.

Margin tips In the margin, you will find tips that help you 
perform tasks more easily and efficiently.

Italic font Italic font is used to emphasize certain words and to 
indicate variables.

Courier Bold font Courier Bold font identifies text that you type.

Click Quickly press and release the left mouse button 
(Windows) or the mouse button (Macintosh).

Double-click Click the left mouse button (Windows) or the mouse 
button (Macintosh) twice rapidly.
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If You Need Help

If you are having trouble using your Avid system, you should:

1. Retry the action, carefully following the instructions given for that task 
in this guide. It is especially important to check each step of your 
workflow.

2. Check the release notes supplied with your Avid application for the 
latest information that might have become available after the hardcopy 
documentation was printed.

3. Check the documentation that came with your Avid application or 
your hardware for maintenance or hardware-related issues.

4. Visit the online Knowledge Center at www.avid.com/support. Online 
services are available 24 hours per day, 7 days per week. Search this 
online Knowledge Center to find answers, to view error messages, to 
access troubleshooting tips, to download updates, and to read/join 
online message-board discussions.

5. For Technical Support, please call 800-800-AVID (800-800-2843).

For Broadcast On-Air Sites and Call Letter Stations, call
800-NEWSDNG (800-639-7364).

Right-click Quickly press and release the right mouse button 
(Windows only).

Drag Press and hold the left mouse button (Windows) or 
the mouse button (Macintosh) while you move the 
mouse.

Ctrl+key
k+key

Press and hold the first key while you press the 
second key.

Symbol or Convention Meaning or Action

www.avid.com/support
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Related Information

The following documents provide more information about Avid’s 
products:

• Avid Symphony Release Notes for the Windows 2000 Operating 
System or Avid Symphony Release Notes for the Mac OS X Operating 
System or Avid Media Composer and Film Composer Release Notes 
for the Windows 2000 Operating System or Avid Media Composer and 
Film Composer Release Notes for the Mac OS X Operating System

These release notes include important information you should read 
before installing and using the Avid system.

• Avid Symphony and Composer Products Site Preparation Guide for 
the Windows 2000 Professional Operating System or Avid Symphony 
and Composer Products Site Preparation Guide for the Mac OS X 
Operating System

These guides provide electrical, environmental, size, and weight 
information for users who are responsible for preparing a site for 
installation of the Avid system.

• Avid Symphony and Composer Products Setup Guide for the Windows 
2000 Professional Operating System or Avid Symphony and Composer 
Products Setup Guide for the Mac OS X Operating System

These guides are designed for anyone who is installing an Avid 
system, moving a system, or solving problems that can arise with the 
system hardware.

• Avid Products Getting Started Guide (this book)

This guide provides a step-by-step tutorial covering the basic features 
of the Avid system video projects.

• Avid Symphony Quick Reference for the Windows 2000 Operating 
System or Avid Symphony Quick Reference for the Mac OS X 
Operating System or Avid Media Composer and Film Composer Quick 
Reference for the Windows 2000 Operating System or Avid Media 
Composer and Film Composer Quick Reference for the Macintosh 
Operating System

These folded cards list convenient keyboard shortcuts for using Avid 
products.
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• Avid Symphony Editing Guide or Avid Media Composer and Film 
Composer Editing Guide

These guides provide complete information on all editing tasks, such 
as viewing and marking footage, editing, and trimming transitions.

• Avid Symphony Effects Guide or Avid Media Composer and Film 
Composer Effects Guide

These guides describe techniques for using digital video effects, titles, 
third-party plug-in effects, mattes, keys, and layering options.

• Avid Symphony Input and Output Guide or Avid Media Composer and 
Film Composer Input and Output Guide

These guides provide instructions for creating input (logging 
digitizing, importing) and generating output (digital cuts, exporting). It 
also includes conceptual information on workflows and film-to-tape 
transfer.

• Avid Symphony Color Correction Guide or Avid Color Correction 
User’s Guide

These guides provide complete information on the advanced color 
correction features, including Color Correction mode, Safe Color 
limiting and warning, and Spot Color Correction.

• Avid Symphony Online Publications CD-ROM or Avid Media 
Composer and Film Composer Online Publications CD-ROM

These online collections provide electronic versions of most 
documents listed in this section, as well as documents for related Avid 
applications. You can view these PDF documents with Adobe® 

Acrobat® Reader®, which you can install from the CD-ROM. 

• Avid Symphony Help or Avid Media Composer and Film Composer 
Help

These Help systems provide all the information included in the editing 
guides, the input and output guides, the effects guides, and the color 
correction guides supplied with your system. The Help operates in a 
Web browser. To open the Help, select Help > Symphony Help in the 
Symphony application or select Help > Media Composer Help or 
Help > Film Composer Help in the Media Composer or 
Film Composer application. For information on using Help, click the 
Using Help button in the Contents list in the Help browser.
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n References to the above documentation are noted throughout this guide. 
The specific names of the documents will not be used and you should use 
the appropriate document that applies to your particular system. For 
example, when the text states: “See the appropriate effects guide for more 
information on this feature,” you should see the Avid Symphony Effects 
Guide or the Avid Media Composer and Film Composer Effects Guide 
depending on which system you have.

If You Have Documentation Comments

Avid Technology continuously seeks to improve its documentation. We 
value your comments about this guide, the Help, the Online Publications 
CD-ROM, and other Avid-supplied documentation.

Simply e-mail your documentation comments to Avid Technology at 

TechPubs@avid.com

Please include the title of the document, its part number, and the specific 
section you are commenting on in all correspondence. 

How to Order Documentation

To order additional copies of this documentation from within the United 
States, call Avid Sales at 800-949-AVID (800-949-2843). If you are 
placing an order from outside the United States, contact your local Avid 
representative.

Avid Educational Services

For information on courses/schedules, training centers, certifications, 
courseware, and books, please visit www.avid.com/training or call 
Avid Sales at 800-949-AVID (800-949-2843).

www.avid.com/training
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Chapter 1

Introduction

This chapter sets you up to use this guide and explains how to work 
through the tutorial sections that teach you the basics of your Avid system. 

This chapter contains the following sections:

• Using the Tutorial Sections

• What You Need

• Turning on Your Equipment

• Installing the Tutorial Files (Windows)

• Installing the Tutorial Files (Macintosh)

• Starting the Avid System (Windows)

• Starting the Avid System (Macintosh)

• Electronic Licensing

• How to Proceed

• Using Help

• Using Online Documentation
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Using the Tutorial Sections

The self-paced tutorial sections included in this guide are designed as 
guided Avid editing sessions, using the basic features of the system. In the 
tutorial sections, you’re going to edit a 1-minute sequence about a 
company in Amesbury, Massachusetts that makes small fishing boats 
called dories.

The footage for the sequence is on the Tutorial CD-ROMs that came with 
your system. The CD-ROMs contain digitized media that is ready for you 
to use.

The instructions in the tutorial take you through each step of the editing 
process. The steps are:

• Starting a project (in Chapter 3)

• Getting ready to edit (in Chapter 5)

• Editing a rough cut (in Chapter 6)

• Refining the edit (in Chapter 7)

• Adding effects and titles to the sequence (in Chapter 8 and 
Chapter 9)

• (Symphony only) Finishing mode adds the finishing touches to your 
effects (in Chapter 10)

• Preparing output (in Chapter 11)

• Backing up (in Chapter 12)

To complete this tutorial, you need a basic familiarity with the 
Windows® operating system or Macintosh® computer. If you have never 
used a Windows or Macintosh system, refer to the Windows or the Apple® 
Macintosh manuals.

You don’t need any previous experience with the Avid system. The terms 
and techniques needed for each tutorial section are in each chapter. 
However, it will help to read Chapter 2 of this guide before starting any of 
the tutorial sections. You can also use the Help system (see “Using Help” 
on page 36) and online books (see “Using Online Documentation” on 
page 42) for more information. 
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This tutorial takes approximately 4 hours. Before you begin, you need:

• An installed Avid system

If you have not yet set up your system, see the appropriate setup guide. 
If you need to install the software, see the appropriate release notes.

• The Boat Shop media and project files on the Avid Video Editing 
Tutorial CD-ROM

What You Need

The Tutorial CD-ROMs packaged with your Avid system include all files 
necessary to complete this tutorial. They are:

• OMFI MediaFiles folder — contains the digitized files you need for 
the tutorial. You need to copy the OMFI MediaFiles folder to your 
external media drive.

• Avid Projects folder — contains the project and bins you need for the 
tutorial. You need to copy the project folder to the following location:

\Program Files\Avid\Avid product\Avid Projects (Windows) 

Macintosh HD/Users/Shared/Avid Projects (Macintosh).

Turning on Your Equipment

Begin your edit session by turning on the components of your Avid system. 
If any part of your system fails to turn on, make sure its electrical cord is 
plugged snugly into an appropriate electrical outlet or power strip. For 
information on setting up your system, see the appropriate setup guide.

c If you fail to follow the proper sequence for starting up your system, 
you could damage your computer or storage drives.
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Always turn on the devices in the following order:

1. Fixed-storage drives: Turn on fixed-storage drives before starting the 
computer. Allow 10 to 15 seconds for the drives to spin up to speed 
before starting your PC or Macintosh.

2. Other peripheral hardware: Turn on all other peripheral units except 
the PC or Macintosh. These include:

- Monitors and speakers

- Tape decks and additional autoassembly configurations (switcher, 
time-base corrector, and so on) if you plan to digitize or conduct an 
autoassembly

- Meridien™ I/O box

- Black burst generator (to maintain proper sync between audio and 
video while digitizing and editing)

3. The PC or Macintosh:

Windows: 

For information on 
your Windows features, 
such as the desktop and 
icons, see your 
Windows 
documentation.

a. Turn on your PC.

The computer goes through a self-check routine, and the 
Windows startup screen opens.

b. Press Ctrl+Alt+Delete and log on.

The Windows desktop opens.
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Macintosh: 

Press the Power On key located on your computer.

When you start the Macintosh:

- You hear a tone that means the hardware is operational.

- The computer goes through a self-check routine. If the
Macintosh passes all of its internal logic tests, the smiling
Macintosh icon appears.

For information on 
Macintosh features, 
such as the desktop and 
icons, see your 
Macintosh 
documentation.

- The Mac OS X startup screen opens and the initialization process 
begins.

- Select a user and type the password, and then click Log In.

- The Macintosh desktop opens.

c To avoid system damage, do not disconnect or turn off external drives 
while the PC or Macintosh is on.

Installing the Tutorial Files (Windows)

The Tutorial CD-ROMs contain all the files you need for the tutorial 
sections of this guide. The CD-ROMs contain an NTSC version and a PAL 
version of the tutorial media files digitized at a 20:1 resolution. The tutorial 
files require three CD-ROMs for NTSC and three for PAL. The installation 
procedure is the same for installing either type.

Macintosh HD

Media drives
(external)

(internal)
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Each CD-ROM has its own installation program and is installed 
independently of the other CD-ROM. You will need approximately 
1 GB of free space available on your external media drive.

It takes approximately 30 minutes to install the media files from the 
CD-ROMs to the external media drive. 

To install the Avid Video Editing tutorial on a Windows system:

1. Insert the Avid Video Editing (NTSC or PAL) Tutorial Disc 1 of 3 into 
the CD-ROM drive. The Avid Video Editing Tutorial screen opens.

2. Click Install Avid Video Editing Tutorial.

The Welcome to Avid Video Editing Tutorial (NTSC or PAL) Setup 
dialog box opens.



Installing the Tutorial Files (Windows)

31

3. Click Next.

The Choose Destination Location dialog box opens. This allows you to 
place the Boat Shop project files in the Avid Projects folder. If an Avid 
Projects folder is not already created, the installation will create one for 
you.

4. Select the destination location for the project files, and then click Next.

The Select a Drive dialog box opens. This allows you to select the drive 
where you want to store the media files. The media files take up 
approximately 1 GB. Select a drive with adequate space.

5. Click the appropriate drive, and then click Next.

t If an OMFI MediaFiles folder already exists on the drive, the 
media files are copied into that folder.

t If there is no OMFI MediaFiles folder on the drive, a message 
appears asking if you want to create an OMFI MediaFiles folder 
on the drive. Click Yes. The folder is created and the media files 
are copied to the external drive.
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The Setup Needs Another Disk dialog box opens. The system prompts 
you to insert Tutorial CD 2.

6. Eject the Avid Video Editing Tutorial (NTSC or PAL) Disc 1 of 3 from 
the CD-ROM drive.

7. Insert the Avid Video Editing Tutorial (NTSC or PAL) Disc 2 of 3 into 
the CD-ROM drive.

8. Click OK.

The system installs the tutorial media files.

When the media files on Disc 2 are copied to the drive, the system 
prompts you to insert Tutorial CD 3. 

9. Eject the Avid Video Editing Tutorial (NTSC or PAL) Disc 2 of 3 from 
the CD-ROM drive.

10. Insert the Avid Video Editing Tutorial (NTSC or PAL) Disc 3 of 3 into 
the CD-ROM drive.

11. Click OK.

A final dialog box opens informing you the installation is complete.

12. Click Finish, and then click Exit to close the Avid Video Editing 
Tutorial screen.

13. The installation is complete.
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Installing the Tutorial Files (Macintosh)

The Tutorial CD-ROMs contain all the files you need for the tutorial 
sections of this guide. The CD-ROMs contain an NTSC version and a PAL 
version of the tutorial media files digitized at a 20:1 resolution. The tutorial 
files require two CD-ROMs for NTSC and two for PAL. The installation 
procedure is the same for installing either type.

Each CD-ROM has its own installation program and is installed 
independently of the other CD-ROM. You will need approximately 
1 GB of free space available on your external media drive.

It takes approximately 30 minutes to install the media files from the 
CD-ROMs to the external media drive. 

To install the Avid Video Editing tutorial on a Macintosh system:

1. Quit all active applications.

2. Insert the Avid Video Editing Tutorial CD 1 into the CD-ROM drive.

3. Double-click the Video Editing Tutorial (NTSC or PAL) CD-ROM 
icon on your desktop. 

4. Double-click the Video Editing Tutorial (NTSC or PAL) Installer icon 
to start the installer. 

The opening window of the installer opens.

5. With Easy Install selected, click the Install button.

If you have more than one Avid Projects folder created on your system, 
a Select Folder dialog box opens asking you to select the Avid Projects 
folder where you want to install the tutorial project. Click OK.

The installation begins. If you do not have an OMFI MediaFiles folder 
created on your Macintosh HD, a message appears. When the 
installation is finished with Tutorial CD 1, the system prompts you to 
insert Tutorial CD 2.

6. Insert Tutorial CD 2 into the CD-ROM drive.
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7. Click OK. 

The system installs the tutorial media files.

8. When the installation is complete, click Quit.

The installation program copies the following folders to your system:

• Boat Shop project folder: This folder contains the project and bins 
you need for the tutorial and is copied into the Avid Projects folder on 
your hard drive.

• OMFI MediaFiles folder: This folder contains the media files you 
need for the tutorial and is copied to a media drive.

Starting the Avid System (Windows)

To start the Avid system on a Windows system, do one of the following:

t Double-click the Avid application icon on your desktop.

t Click the Start button, and select Programs > Avid > Symphony or 
Media Composer. 

Starting the Avid System (Macintosh)
For more information 
on making an alias and 
using the Go menu, see 
your Macintosh 
documentation.

To start the Avid system on a Macintosh system, do one of the following:

t Double-click the Avid application icon on your desktop.

t Select Go > Applications, and then double-click the Avid application 
icon.
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Electronic Licensing

To accept your Avid product license electronically:

1. Read the License Agreement, then click the Accept button or the 
Decline button at the bottom of the screen.

The agreement appears the first several times you start the application. 
After several starts, a new button appears at the bottom of the screen.

2. If you do not want to see the license agreement again, click the Accept 
and Don’t Show Again button.

A dialog box opens.

3. Type the name of your organization in the dialog box, and click OK.

After the application starts, the Select User and Project dialog box opens, 
as described in “Opening a Project” on page 68.

How to Proceed

The following are a few tips for taking full advantage of Avid 
documentation and other resources:

• Complete the tutorial sections in this guide before starting a project.

• Begin learning about basic procedures using the default settings. As 
your confidence increases, begin to explore additional procedures and 
settings.

• Instead of using the standard menus to find the command you need in a 
window, try using shortcut menus. Right-clicking (Windows) or 
pressing Ctrl+Shift and clicking (Macintosh) in a window brings up a 
shortcut menu that shows the most frequently used commands for that 
window.

• Keep the appropriate quick reference card available during editing 
sessions to speed the use of shortcuts and keyboard commands. 

• Make a habit of reading Avid’s newsletters, mailings, and other trade 
publications.
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• Make use of additional training resources provided by Avid whenever 
possible, such as classes and instructional videotapes. For more 
information, contact Avid at 800-867-2843.

• Check the following Avid Web site for listings of courses, schedules, 
and locations:

www.avid.com/education

Using Help

You can get help and background information for tasks, windows, dialog 
boxes, and screen objects through your Avid Help system. Your Help 
system is HTML-based and operates in a Web browser. You need v4.5 or 
later of Microsoft® Internet Explorer. On a Macintosh system, Avid 
recommends Internet Explorer v5.0 or later.

Setting Up Your Browser

You must have cookies enabled in your browser to use several capabilities 
of your Avid Help system. Avid does not retain personal information about 
you or your system other than your frequently visited Help topics.

To enable cookies:

1. Select Internet Explorer Tools > Internet Options.

2. Click the Security tab.

3. Click the Custom Level button.

4. Scroll down to the Cookies section.

5. Make sure the Enable button is selected.

6. Click OK, and then click OK again.

www.avid.com/education
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Getting Help for Windows and Dialog Boxes

The Help system provides you with context-sensitive Help for windows 
and dialog boxes, such as tools and settings. 

To get Help for windows and dialog boxes:

1. Make sure the Avid application is active.

2. Position the mouse pointer anywhere in the window or dialog box for 
which you want help.

3. Press the F1 key (Windows) or the Help key (Macintosh) on the 
keyboard.

If there is no information about a window or dialog box, a Navigation 
Canceled message appears in the browser. Open the Help and use the 
Search or Index functions to look for information on that window or 
dialog box.

Getting Help for Screen Objects

You can use What’s This? Help to find out about buttons and other screen 
objects.

To get help for screen objects:

1. Do one of the following:

t (Windows) Using the right mouse button, click the screen object 
(for example, a button).

t (Macintosh) Ctrl+Shift+click the screen object (for example, a 
button).

A pop-up menu opens.

2. Click the pop-up menu, and select What’s This?.

A browser window opens that explains how you use the item. Many 
windows include a link (marked by underlined text) to more 
information.

n (Windows only) For some dialog boxes, such as Import and Print, use the 
Question Mark button to access What’s This? Help.
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Keeping Help Available (Windows Only)

When you access a Help topic and then return to the Avid application, the 
Help browser disappears behind the Avid system.

To keep Help available, you can use one of the methods in the following 
topics:

• Restoring Help from the Taskbar (Windows Only)

• Resizing the Application (Windows Only)

• Using Alt+Tab (Windows Only)

Restoring Help from the Taskbar (Windows Only)

You can restore the Help from the taskbar at the bottom of the screen. All 
your active applications are represented by buttons on the taskbar.

To restore Help, click the browser button on the taskbar, and the Help 
reappears.

If you can’t see the taskbar, you might have set a property that hides it.

To keep the taskbar on top:

1. Right-click in an area of the taskbar where there are no buttons.

2. Click the pop-up menu, and select Properties. 

The Taskbar Properties dialog box opens.

3. Select Always on top.

4. Deselect Auto hide.

5. Click OK.

The taskbar remains visible at all times.

n If you want the taskbar to appear only when you pass the pointer over the 
bottom of the screen, select Auto hide along with Always on top.
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Resizing the Application (Windows Only)

To resize the application and leave Help available:

1. With Help active, click the purple Help title bar and drag it to the top of 
the screen. 

2. Click in the Avid application.

The Help browser disappears behind the Avid system.

3. Click the Restore button in the top right corner of the application.

The application shrinks slightly and reveals the Help browser behind it.

This allows you to click back and forth between the application and the 
Help browser without significantly reducing the size of the Avid 
application.

Using Alt+Tab (Windows Only)

To use Alt+Tab:

1. Press and hold the Alt key.

2. Press and release the Tab key.

A window opens containing icons and names for all the applications 
currently started on your system. A box surrounds the active 
application.

3. Continue to hold the Alt key and press and release the Tab key until the 
box surrounds the Help browser icon, and then release both keys.

Finding Information Within the Help

You see the Help browser when you open Help from the Help menu. The 
left frame of the Help browser includes a Contents list and buttons for 
several other methods of finding information.
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Using the Contents List

The Contents button provides a list of topics covering the entire Help 
system.

To view the Contents list using the Contents button, do one of the 
following:

t Select Help > Avid Symphony or Media Composer Help, and then 
click the Contents button.

t From a Help topic, click the Contents button.

To display a topic, double-click the topic title in the Contents list.

n The Contents displays only the top-level topics. Many entries link to 
subtopics with related information or procedures.

Using the Index

The Index button provides an alphabetized list of entries, like the index of a 
printed book.

To find topics using the Index button:

1. Select Help > Avid Symphony or Media Composer Help, and then 
click the Index button (or click the Index button from a Help topic).

2. From the alphabet at the top, select the letter that begins the topic you 
want to find (for example, click A to jump to index entries listed under 
audio).

3. Scroll through the topics beginning with that letter until you find the 
topic you want.

4. Click the number to the right of the index entry. The number indicates 
how many topics that index entry has associated with it.

The topic opens in the right frame of the browser.
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Using the Search Feature

The Search button lets you search the entire Help system for words or 
phrases, and then lists topics that include those words or phrases.

To search for topics using the Search button:

1. Select Help > Avid Symphony or Media Composer Help, and then 
click the Search button (or click the Search button from a Help topic).

2. In the text box, type the word or phrase that you want to find. You can 
type up to three words, not including invalid words like “the” or 
misspellings.

3. Press Enter (Windows) or Return (Macintosh) or click the Search 
button.

A list shows topics that contain the word or words for which you 
searched.

n Do not type quotation marks or asterisks in the text box.

4. Click a topic in the list.

The topic opens in the right frame of the browser.

Using the Glossary

The Glossary defines and explains many terms common to the industry. 
Some entries might not apply to your particular system.

To use the Glossary:

1. Click the Glossary button.

2. Click the letter that begins the term or concept for which you are 
searching.

3. Scroll through the section to find your term.

4. Click links to see related information.
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Printing Help Topics

You can print a Help topic if you need to refer to it during a complicated 
procedure or for reference later.

To print a Help topic:

1. Open or click the topic to make it active.

2. From the browser menu select File > Print, or click the Print button in 
the browser toolbar.

3. Select the print options.

4. Click OK (Windows) or Print (Macintosh).

(Windows only) Right-click and select Print to print a topic.

Using Online Documentation

The Avid Symphony Online Publications CD-ROM includes:

• Avid Symphony Editing Guide

• Avid Symphony Input and Output Guide

• Avid Symphony Effects Guide

• Avid Symphony Color Correction Guide

• Avid Products Getting Started Guide (this book)

• Avid Symphony Help system

The Avid Media Composer and Film Composer Online Publications 
CD-ROM includes:

• Avid Media Composer and Film Composer Editing Guide

• Avid Media Composer and Film Composer Input and Output Guide

• Avid Media Composer and Film Composer Effects Guide

• Avid Color Correction User’s Guide
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• Avid Products Getting Started Guide (this book)

• Avid Media Composer and Film Composer Help system

The books are PDF files. You can view them with the Adobe 
Acrobat Reader, which you can install from the CD-ROM.

The online version of the books enables you to:

• Navigate through books using bookmarks and hyperlinks.

• Speed up information retrieval by performing keyword searches.

• Annotate the books with your own notes.

• Zoom in on a page, enabling closer review of text and images.

• Print any or all pages.

• View the books with full-color graphics.

• View movies that illustrate Avid effects.

n Avid gives you permission to print up to three complete copies of each 
book.
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Chapter 2

About the Avid System

This chapter provides a general overview of the capabilities of the Avid 
systems. It introduces basic concepts along with some tips for the 
beginning user in the following sections:

• About the Avid System

• Editing Basics

• Project Workflow

• Behind the Scenes

About the Avid System

The Avid system streamlines the editing process by combining the 
traditional tools of postproduction, the creative control of digital editing, 
and the simplicity of the user interface.

More than a method of saving time and money, nonlinear editing 
introduces a whole new style of craftsmanship into the postproduction 
suite by allowing greater experimentation in the composition of full-
motion visual media.

The Avid system blends the traditional benefits of previsualization familiar 
to the conventional offline editor with the advanced production tools and 
image quality of high-end online production.
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About Avid Symphony

Symphony is Avid’s uncompressed finishing system offering 
uncompromising quality, performance, and capability for the creation of 
television programs and commercials. Three uncompressed streams make 
it the ideal tool for finishing your most demanding program types. It places 
all the tools you need right at your fingertips—from audio finishing to 
color correction, from keying to scratch removal to complex matte 
creation. And, when you need to work with dedicated effects and audio 
workstations, it includes strong links to Avid’s family of products as well 
as third-party applications.

If you are still finishing in a linear suite, chances are your sequences are 
offlined on an Avid system. Avid Symphony can perfectly re-create your 
entire offline session with the touch of a button. That means every edit, 
every composite, every audio setting, and every effect move in their 
entirety to the online session. No more conforming from EDLs. No more 
hours spent re-creating layers. Simply redigitize your media and you have 
a totally conformed program.

Avid Symphony includes 24p Universal Editing and Mastering 
technology. Universal Editing and Mastering enables content producers to 
edit 24-frame progressive content in its native format and to deliver NTSC, 
PAL, 4:3, 16:9, and letterbox versions. It also outputs list formats such as 
film cut lists and 24-fps and 25-fps edit decision lists (EDLs) for high-
definition television (HDTV) conforming. It can Total Conform 24p and 
25p projects, complete with Pan and Scan information, from 
Media Composer XL systems equipped with the new Universal Offline 
Editing feature.

About Avid Film Composer

Film editors have long wanted access to the real-time effects and 
previsualization tools available in the online videotape suite, without 
losing their traditional sense of craftsmanship. The Film Composer 
nonlinear editing system makes this possible.
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The nonlinear editing process is not new to film. In fact, you will discover 
many familiar terms and procedures of film editing preserved in this 
system. At the same time, Film Composer introduces random access to 
footage and the ability to easily create multiple versions of a cut.

This unique combination of traditional film concepts and state-of-the-art 
nonlinear technology dramatically shortens the distance between a concept 
and its execution in the cutting room, making the process of film editing 
more fluid. Film Composer includes new 24p and 25p editing technology 
which enables content producers to edit 24-frame progressive and 
25-frame progressive content in its native format and to deliver NTSC, 
PAL, 4:3, 16:9, and letterbox versions. It also outputs list formats such as 
film cut lists and 24-fps and 25-fps edit decision lists (EDLs) for high-
definition television (HDTV) conforming.

About 24p Media

With new digital television (DTV) formats expanding the options for 
content distribution, there is renewed interest in the oldest format in the 
industry — 24-fps film. In addition to its common format, film provides 
the highest resolution master for archiving purposes. Through a telecine 
transfer and the digitizing process, the Avid system captures and stores 
film frames as 24-fps progressive media, or 24p.

Progressive media is composed of single frames, each of which is 
vertically scanned as one pass. The Avid system creates 24p media by 
combining (deinterlacing) two video fields into a single, full, reconstructed 
frame. For NTSC film-to-tape transfers, the system creates 24p media by 
removing the extra fields inserted by the 2:3 pulldown process and creating 
progressive frames.

Working in 24p simplifies digital editing of film or other 24-fps-originated 
content, such as HDTV video that has been downconverted to ITU-R 601 
digital video. In addition, 24p media requires less storage and processing 
power than 30-fps media. Because 24p provides a common production 
format for multiversion, multiformat delivery, it promises to become the 
new universal format for all film and video content.
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About 25p Media

The 25p format is primarily for use in countries where PAL video is 
standard. When you transfer 25-fps film footage to 25-fps PAL video, no 
modifications are necessary due to matching frame rates.

The 25-fps feature provides the following advantages:

• Simultaneous input of video and audio in sync

• Frame-accurate ink number tracking

• Digital cut recording directly to videotape 

• Frame-accurate cut lists and change lists

• Frame-accurate audio EDLs for online editing of audio tracks

• Frame-accurate EDLs for assembling footage from the transfer or for 
preparing an online show master

The source for 25p media is typically 25-fps film or 25-fps HDTV format. 
The methods for creating and storing 25p media are the same as for 24p 
media.

Editing Basics

The unique nature of nonlinear editing — and the specific features of the 
Avid system — suggest a new process of editing and the flow of your work 
on projects, as described in this section.

About Nonlinear Editing

As a digital, nonlinear editing tool, Avid systems provides complete 
random access to footage, with instantaneous cueing and retrieval of 
sequences, segments, clips, and frames.

In addition, traditional editing requires that you electronically copy video 
from a source tape to a master tape. When you make changes in this linear 
arrangement, you must reassemble all of the clips that follow the change. 
By contrast, when you edit with an Avid system, you are not actually 
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cutting or dubbing the footage. Instead, your source tapes are digitized into 
media files that can be played just like the original tapes. When you edit, 
you work with these images and sounds (objects) with great freedom, 
creating data files that refer to the media files and to your original source 
tapes. You can make changes, and the entire sequence is immediately 
updated. This is the primary benefit of nonlinear editing.

The system maintains frame-accurate links between each alteration of the 
objects you work with and the original media files. This allows you to 
experiment with every edit you make through multiple generations. When 
you play back your work, the system immediately accesses and plays the 
appropriate portions of the digitized video and audio.

Editing Components

Knowing some basic terms for the editing components will help you use 
your Avid system more effectively. They are:

• Bin: the window in which you organize the material to be edited

• Cut list: a series of output lists containing specifications used to 
conform the work print or film negative

• Digital cut: a copy made directly from disk to tape

• EDL: edit decision list containing detailed information on your 
sequence for editing of a videotape master

• Effect mode: the controls in the Timeline and the Effect Editor 
window to apply, render, and edit effects into the sequence

• Finishing mode (Symphony only): a mode composed of a Playback 
monitor that displays the assembled sequence

• IN and OUT points: the starting and ending points of an edit

• Master clip: an editing object that references the compressed media

• Media file: the stored, compressed digital data representing the 
original video and audio

• Project: the job that results in one or more sequences; the Project 
window organizes all the clips, sequences, effects, and media file 
pointers for a program or series of programs
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• Segment mode: the editing controls for moving, deleting, marking, 
and editing segments in the Timeline

• Sequence: an edited composition that includes audio and video clips 
and rendered effects

• Source clip: the smallest media object that contains all the information 
necessary to reference footage

• Source/Record mode: a mode composed of a Source monitor that 
displays source clips, a Record monitor that displays the assembled 
sequence, and controls for making basic edits

• Subclip: a part of a master clip, which references the master clip

• Timeline: the graphical representation of every edit made to a 
sequence, including all nested effects and layered tracks

• Trim mode: the controls for fine-tuning edits and transitions with 
various trim procedures

Project Workflow 

The following sections introduce the five stages of a project, along with the 
system terms you encounter in the Avid system. Complete procedures for 
each phase are described in this guide, in the Avid Help system, in the 
online books, and in the appropriate editing guide. 
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Starting a Project

1. Turn on your 
equipment in a 
prescribed order and 
start the Avid software.

2. Select or create a 
new project: the job 
that will result in one or 
more finished 
sequences.

3. Create and organize 
bins.

4. Back up your project 
on a regular basis.

Starting a project involves the following steps:

2. Select or create a project.

3. Create and organize bins.

4. Back up the project.

1. Turn on and start your Avid system.
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Preparing to Edit

1. Import your shot 
logs into the bins, or 
log the material 
manually to create 
source clips.

2. Digitize your analog 
footage, creating media 
files and master clips.

3. Work with bins and 
clips to organize your 
source material for easy 
access during editing.

4. (Option) Build a 
storyboard, to begin 
previsualizing your 
final cut before editing.

5. Manage media files 
using controls provided 
by the system, such as 
the Media tool.

Preparing to edit involves the following steps:

3. Sort and organize clips in the bins.

4. Previsualize with storyboards.
5. Manage media files for 
storage efficiency, and backup

2. Digitize footage, creating
master clips and media files.

security. 

1. Import shot logs into the bin.
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Editing a Sequence

1. View your clips in 
advance and mark IN 
points and OUT points, 
or create subclips based 
on selected portions of 
your master clips.

2. Build your sequence 
in Source/Record 
mode, which provides 
nonlinear editing 
controls with Source 
and Record monitors, 
and in the Timeline.

3. Fine-tune your edits 
and effects using 
functions of the various 
edit modes, such as 
Segment mode, Trim 
mode, and Effect mode.

4. Adjust and mix 
multiple audio tracks 
and prepare for final 
playback or output, 
using the Avid Audio 
tool and Audio Mix 
tool.

5. Return to editing if 
further adjustments are 
required.

Editing a sequence involves the following steps:

Source

monitor

Record
monitor

Timeline

2. Edit in Source/Record mode and in the Timeline.

3. Fine-tune edits and effects.

4. Fine-tune audio pan, volume, and EQ.

5. Screen and continue
editing as necessary.

1. Screen, mark, and subcatalog footage.
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Finishing a Sequence (Symphony Only) 

1. Batch digitize your 
clips at a 1:1 resolution 
(uncompressed).

2. In Finishing mode, 
you can sweeten audio, 
make any color 
corrections, add a 
chroma or luma key 
effect, repair dropouts, 
or add complex matte 
creations.

3. Link to Avid’s 
family of products or 
third-party 
applications.

Finishing a sequence involves the following steps:

1. Batch digitize at an uncompressed rate.

2. Adjust color, add key effects, and 
repair dropouts.

3. Link to other applications.
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Generating Output

1. Export and exchange 
material for audio 
sweetening or graphics 
enhancement in a third-
party application, or for 
incorporating into a 
multimedia project.

2. Record the final 
sequence as a digital 
cut as NTSC or PAL, 
with 16:9 or 4:3 screen 
ratio.

Or

3. Generate a cut list to 
be used for conforming 
a film negative or work 
print.

Or

4. Generate an EDL to 
create an HDTV online 
master.

Generating various forms of output based on your sequence involves 
selecting among several options:

1. Export and exchange material for
import into third-party applications.

2. Record a digital cut directly to tape.

4. Generate an EDL for HDTV online master.

3. Generate a cut list for film negative 

Cut list

or work print.
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Behind the Scenes

Every time you work and make changes to a project it’s backed up and 
saved to a folder.

The Avid Attic Folder

The Avid system saves copies of your current project and its bins at regular 
intervals and whenever you save or close a project or bin. These auto-save 
files are stored in the Avid Attic folder in the Avid application folder. If at 
any time you lose work due to a power outage or system error, open the 
Avid Attic folder and look for a project or bin of the same name with the 
file name extension .bakxx, where xx is the version number. For example, 
the first backup file for the bin Rough Cut would be named Rough 
Cut.bak01. Later versions would be named Rough Cut.bak02, Rough 
Cut.bak03, and so on.



Chapter 3

Starting a Project

The Project window provides controls in five different display modes for 
structuring and viewing important information about your current project. 
These include a display of bins and folders associated with the project, a 
list of all settings, and basic information about the format of the project and 
use of system memory, hardware, and project usage.

Starting a project is described in the following sections:

• About Avid Projects and Avid Users Folders

• Copying Project Information

• Using the Bins Display

• About Trash

• Using the Settings Display

• About Settings

• Customizing Your Workspace

Tutorial: Starting a Project contains the following sections:

• Starting the Application (Windows)

• Starting the Application (Macintosh)

• Opening a Project
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About Avid Projects and Avid Users Folders

Avid Projects and Avid Users folders allow you to move whole projects or 
selected project and user settings between systems by copying and moving 
files on your desktop.

When you create a new project or user, the system creates the following 
files and folders:

• When you create a new user, the system creates three items: a user 
profile file, a User settings file, and a user folder containing the two. 
Each item is given the user name you provide. This new folder is 
stored in the Avid Users folder on your internal hard drive in \Program 
Files\Avid\Symphony or \Program Files\Avid\Media Composer 
(Windows), or in Macintosh HD/Users/Shared (Macintosh).

• When you create a new project, the system creates three items: a 
project file, a Project settings file, and a folder containing the two, each 
of which is given the project name you provide. This new folder is 
stored in the Avid Projects folder on your internal hard drive in 
\Program Files\Avid\Symphony or \Program Files\Avid\Media 
Composer (Windows), or in Macintosh HD/Users/Shared (Macintosh).
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Your settings are initially set to the default values. As you work, the files 
maintain current settings, or are adjusted to your use, while the project 
folder fills with bin files.

Copying Project Information

The Avid system allows you to copy a project from one Avid product to 
another, such as from an Avid Media Composer system to an Avid 
Symphony system. You can also move a project to another Avid system 
through Avid EDL Manager or by importing an OMFI file (composition 
only).

To copy project information to your Avid system:

1. On the offline system, copy the project folder to a PC-formatted disk 
or a location on a server.

You can also copy settings. User Settings folders are located in the 
Avid Users folder at the top level of the internal hard drive (Windows) 
or the Macintosh HD drive (Macintosh). Site settings are located in the 
Avid product folder, also at the top level of the internal hard drive 
(Windows) or the Macintosh HD drive (Macintosh). 

2. On the Avid system (Windows), copy the project folder from the disk 
or server to the following folder:

C:\Program Files\Avid\Avid product\Avid Projects

Copy the User settings to:

C:\Program Files\Avid\Avid product\Avid Users

Copy the Site Settings folder to:

C:\Program Files\Avid\Avid product\Settings

3. On the Avid system (Macintosh), copy the project folder from the disk 
or server to the following folder:

Macintosh HD/Users/Shared/Avid Projects

Copy the User settings to:

Macintosh HD/Users/Shared/Avid/Avid Users
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Copy the Site Settings folder to:

Macintosh HD/Application/Avid product/Settings

The next time you see the Select User and Project dialog box, the new 
project will appear in the project scroll list. New User settings will 
appear in the user list.

Using the Bins Display

Bins are windows that contain titles, thumbnails (small pictures that 
represent clips), and information about the material you digitize. These 
editable files are called master clips. They refer to the actual media files 
created when you digitize source material. While the physical media are 
stored on external hard drives, the master clips that refer to that media 
reside in the bin. Bins also store the sequences, subclips, group clips, and 
effects clips that you create during a project. The Project window allows 
you to make a new bin, close it, reopen it, and move clips among these 
bins. You can also open bins created for different projects.

After you select a user and project in the Select User and Project dialog 
box, the Project window opens. To view a complete list of bins associated 
with the project, click the Bins tab in the Project window. A list of bins 
appears.

Bins tab

Open bin
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From the Bins list you can examine the number, names, size, and location 
of bins, and you can also open bins. Dotted bin icons next to bin names 
indicate bins that are currently open; solid icons indicate closed bins.

About Trash

Avid stores deleted bins in the Trash. The Trash icon is located in the 
Project window and only appears when you delete a bin. You can use the 
Trash to retrieve bins you deleted in error, or empty the Trash to create 
more disk space. 

To empty the contents of the Trash:

1. Click the Trash icon to display its contents. 

2. Click the Bin Fast Menu button at the top of the Bin window.

3. Select Empty Trash.

c Clips, subclips, and effects that are in a bin appear in the Trash after 
you delete the bin. However, if you select a clip, subclip, or effect 
directly and press the Delete key, the item does not appear in the 
Trash.

Trash icon with file in Trash

Bin Fast Menu button
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Using the Settings Display

From the Settings display, you can view, select, open, and alter various 
User, Project, and Site settings, as described in this section.

To view the Settings display, click the Settings tab in the Project window. 
The Settings scroll list appears.

Settings tab

Settings type
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About Settings

Three types of settings are displayed in the Settings scroll list:

• User settings are specific to a particular editor. User settings reflect 
individual preferences for adjusting the user interface in your Avid 
system. Individual User settings are stored in each user folder within 
the Avid Users folder on your internal hard drive in \Program 
Files\Avid\Symphony or \Program Files\Avid\Media Composer 
(Windows), or in Macintosh HD/Users/Shared (Macintosh).

• Project settings are directly related to individual projects. When a 
Project setting is changed, it affects all editors working on the project. 
Specific Project settings are stored in each project folder within the 
Avid Projects folder on your internal hard drive in \Program 
Files\Avid\Symphony or \Program Files\Avid\Media Composer 
(Windows), or in Macintosh HD/Applications/Avid Symphony or 
Macintosh HD/Applications/Avid Media Composer (Macintosh).

• Site settings establish default parameters for all new users and projects 
on a particular system. These can apply to particular configurations of 
equipment installed at the site, for example, specifications and node 
settings for an external switcher. They can also include other User or 
Project settings that you copy into the Site Settings window. Site 
settings are stored in a separate Settings folder in the Symphony or 
Media Composer folder on your internal hard drive in \Program 
Files\Avid\Symphony or \Program Files\Avid\Media Composer 
(Windows), or in Macintosh HD/Applications/Avid Symphony or 
Macintosh HD/Applications/Avid Media Composer (Macintosh).

Reviewing Basic Settings
For a complete 
description of all 
settings and their 
options, see the Help 
system.

The following list describes basic system settings to review at the start of 
your project:

• Bin settings

• General settings

• Interface settings

• Workspace settings
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Double-click each setting in the Settings scroll list of the Project window 
to view the following dialog boxes:

• Bin settings define general system functions related to bins, including:

- Parameters of the Auto-save function

- Maximum number of bin backup files stored in the Avid Attic 
folder 

• General settings define fundamental system defaults, including:

- Starting timecode for sequences edited in your Avid system

- Setup default for either American NTSC or NTSC-EIAJ video 
input (affects calibration)

- Whether the system uses Windows compatible file names and 
allows file names to exceed more than 27 characters

• Interface settings determine the level of basic information displayed 
in the interface, including whether written labels are displayed beneath 
icons in the various command palettes.

• Workspace settings let you associate a configuration of windows with 
a workspace setting name. You can customize any user settings and 
link the settings to a workspace. You can have as many workspace 
settings as you want. For more information, see the appropriate editing 
guide and “Workspace:assigning” in the Help index.

Customizing Your Workspace

A workspace is the arrangement and size of tools displayed on your Avid 
system. If you are accustomed to working with a particular group of 
windows arranged and sized in a particular setup, you can assign them to a 
workspace setting that saves that arrangement. 

You can also link user settings to a workspace. You can create a 
customized workspace and set up specific options in any Settings window, 
and link them together by name.
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For example, you can create an Audio workspace that opens the Audio 
Mix tool and Audio tool. This workspace will also open a customized 
Timeline (with enlarged audio tracks and rubberbanding displays). You 
can also link this workspace to a Settings window with customized options 
selected. You do this by creating a setting and giving it the same name in 
the Project window as the name of the workspace.

You can assign up to eight buttons that allow you to switch between user-
customized workspaces. This is very useful if there is more than one user 
accessing the same Avid system. Each user can assign up to eight 
workspaces using the workspace buttons. For more information on 
creating workspace settings, see “Creating a New Workspace Setting” in 
the appropriate editing guide.
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Tutorial: Starting a Project

In this tutorial, you start your Avid system, create a user, and select a 
project. Before starting this procedure, make sure you have installed the 
Tutorial files (see “Installing the Tutorial Files (Windows)” on page 29 or 
“Installing the Tutorial Files (Macintosh)” on page 33).

Starting the Application (Windows)

To start the Avid system on a Windows system, do one of the following:

t Double-click the desktop shortcut icon.

t Click the Start button, and select Programs > Avid > Symphony or 
Media Composer.

After a few moments, the Select User and Project dialog box opens.

n To start the application from the desktop, Avid recommends you create a 
shortcut and place it there.

n If the license agreement window opens, click either Accept or Accept and 
Don’t Show Again.
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For this tutorial, you will use the Boat Shop NTSC or Boat Shop PAL 
project (along with its settings file) that you installed into the Avid Projects 
folder in “Installing the Tutorial Files (Windows)” on page 29.

Starting the Application (Macintosh)

To start the Avid system on a Macintosh system, do one of the following:

t Double-click the desktop shortcut icon.

t Select Go > Applications, and then double-click the Avid application 
icon.

After a few moments, the Select User and Project dialog box opens.

n If the license agreement window opens, click either Accept or Accept and 
Don’t Show Again.

For this tutorial, you will use the Boat Shop NTSC or Boat Shop PAL 
project (along with its settings file) that you installed into the Avid Projects 
folder in “Installing the Tutorial Files (Macintosh)” on page 33.
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Opening a Project

To open a project, you create a new user and select an existing project.

Creating a User

To create a new user:

1. Click the New User button in the Select User and Project dialog box.

The New User dialog box opens.

2. Type your name and click OK. 

The Select User and Project dialog box reopens with your name 
highlighted in the list of users.
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Selecting a Project

To select a project:

To get help for the 
Project window, press 
Ctrl+Shift and click in 
the Project window. 
(Macintosh only)

1. Select Boat Shop NTSC or Boat Shop PAL from the Avid Projects list 
and click OK.

The Project window opens. It lists the bins, or storage areas, created to 
hold the clips and sequences you will need for this tutorial. 

2. Double-click the icon to the left of Source Clips to open the bin.

This bin contains the clips of the source footage you will use to begin 
to build the Tutorial sequence.

You’ve finished this tutorial. The next tutorial is “Tutorial: Getting Ready 
to Edit” on page 96. Be sure to read Chapter 4 and the introductory 
material in Chapter 5 before continuing the tutorial.
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Chapter 4

Digitizing

This chapter discusses the digitizing process and related tools. 

Digitizing is described in the following sections:

• Selecting Settings

• About the Digitize Tool

• About the Audio Tool

• About the Video Input Tool

• Digitizing Preparations Check List

• About Digitizing

Selecting Settings
A number of settings have a direct bearing on the digitizing process. 
Before digitizing, review the following options for General Settings, Deck 
Settings, and Digitize Settings:

• Drive Filtering Based on Resolution causes the system to dim all 
drives for which speed capabilities are unknown or untested in a 
particular video resolution. This setting is selected by default in the 
General Settings dialog box.

c The Avid system does not prevent you from using non-Avid drives, but 
their reliability cannot be assured.
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• Deck Preferences include various options for source deck, sync mode, 
preroll, drop/non-drop-frame preference, and deck control.

• Deck Configuration Settings allow you to establish deck control 
parameters for a single deck or for multiple decks. You can manually 
configure the deck or use the Autoconfigure option.

• Digitize Settings include essential options for digitizing and batch 
digitizing, including general parameters for capture of the source 
material, and special conditions such as digitizing across timecode 
breaks or capturing a single video frame.

About the Digitize Tool
For more information 
on the Digitize tool, see 
“Digitize tool:setting 
up” in the Help index.

The Digitize tool provides controls for digitizing your footage.

To open the Digitize tool, select Tools > Digitize. The Digitize tool opens.

Channel Selection

Deck controls

Message bar

Deck Selection

Source Tape

Trash 

Digitize/Log Mode

Audio Tool

Video Input Tool

Toggle Source

Enable

Target Drive

Clip name Resolution

Drive time

Bin

Digitize
indicator

and comment

available
Single/Dual 
Drives

Timecode

display 

Record

Custom Preroll

Sets specific
timecode for
digitizing

Color/Monochrome

 Selection button

Video Input

Audio Input
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The Digitize tool has the following options:

• Audio Input pop-up menu allows you to select Analog, AES/EBU, 
or S/PDIF.

• Audio Tool button opens the Audio tool.

• Bin pop-up menu lets you select a target bin as the destination for the 
master clips created when you digitize on-the-fly. You can also select 
a target bin containing the logged clips you will use to batch digitize 
your media.

• Channel Selection panel lets you select which audio and video tracks 
you want to digitize from the source tape, whether you want to digitize 
video or audio only, and whether you want to record timecode.

• Clip name and comment allows you to enter a clip name and any 
other information about the clip.

• Color/Monochrome Selection button allows you to filter out all of 
the color from each frame of video when digitizing.

• Custom Preroll check box allows you to select a preroll of 1 to 30 
seconds.

• Deck controls operate the deck.

• Deck Selection pop-up menu lets you select the deck you want to 
play from. It also lets you check and reset serial port connections to 
decks.

• Digitize indicator flashes on and off while you are digitizing.

• Digitize/Log Mode button lets you switch between Digitize mode and 
Log mode.

• Drive time available is displayed after you select a video resolution 
and target a drive or drives for the digitized media.

• Enable Timecode button allows the system to digitize timecode from 
the source tape. If this is deselected, the system digitizes the time-of-
day timecode.

• Message bar displays information on the current status of the tool.
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• Record to the Timeline allows you to digitize footage directly from 
tape into a sequence loaded in the Timeline in one step. Recording to 
the Timeline works best when you are digitizing on-the-fly.

• Red Record button begins the digitizing process.

• Resolution pop-up menu next to the Bin pop-up menu lets you select 
a video resolution including an uncompressed resolution to digitize 
three uncompressed streams of media.

• Single/Dual Drives button lets you target a single or separate media 
drives for digitizing the audio and video for each clip.

• Source Tape display shows the name of the source tape.

• Target Drive pop-up menu lets you select the target drive.

• Toggle Source button switches the deck online or displays the 
External Timecode icon, which allows you to select LTC (longitudinal 
or linear timecode).

• Trash button stops the digitizing process and deletes the digitized 
media.

• Video Input pop-up menu allows you to select Composite, 
Component, or S-Video.

• Video Input Tool button opens the Video Input tool.
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About the Audio Tool
For more information 
on the Audio tool, see 
“Audio tool:setting up” 
in the Help index.

The Audio tool controls parameters for audio input and output.

To open the Audio tool, select Tools > Audio Tool or click the Audio Tool 
button in the Digitize tool. The Audio tool opens. Click the Output and 
Setup buttons to fully open the Audio tool.

The Audio tool has the following options:

• Analog VU scale on the right displays a fixed range of values that you 
can conform to the headroom parameters of your source audio.

• Channel Selector pop-up menus let you map tracks in the sequence 
to output channels.

• Digital VU scale on the left displays a fixed range of values from 
0 to –90 decibels (dB), according to common digital peak meter 
standards.

• In/Out buttons switch the meter displays for each channel between 
input levels from a source device, and output levels to the speakers and 
record devices. I indicates Input and O indicates Output.

Output Setup

Reset Peak

Peak/Hold

In/Out

Setup 

Analog VU scale

Digital VU scale

Output
display display

Meters

Channel
Selectors

Track
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• Meters dynamically track audio levels for each channel as follows:

- Meters show green below the target reference level (the default 
reference level is –14 dB on the digital scale).

- Meters show yellow for the normal headroom range, above the 
reference level to approximately –3 dB.

- Meters show red for peaks approaching overload, between
–3 dB and 0 dB.

- Thin green lines at the bottom indicate signals below the display 
range.

• Output button displays the Output display.

• Output display contains a single slider control for raising or lowering 
global audio output.

• Peak/Hold button allows you to select options for customizing the 
meter displays, and setting and playing back the internal calibration 
tone.

• Reset Peak button resets the current maximum peak measurements. It 
also stops the playback of the internal calibration tone.

• Setup button displays the Setup display.

• Setup display contains information and controls for adjusting various 
audio hardware parameters.

• Track indicator displays the audio track number.

n For more information on using the Audio tool, see the Help system.
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About the Video Input Tool
For more information 
on the Video Input tool, 
see “Calibrating:for 
video input” in the 
Help index.

The Video Input tool controls parameters for incoming video.

To open the Video Input tool, select Tools > Video Input Tool or click the 
Video Input Tool button in the Digitize tool. The Video Input tool opens. 
Click the Internal Waveform Monitor and Vectorscope Monitor buttons to 
fully open the Video Input tool.

The Video Input tool has the following options:

• 100% Bars is used if the source displays 100% bars for calibration.

• Consumer Source is selected if you are using a consumer-grade video 
deck (VCR), or a deck that has no built-in time-based corrector.

• Input pop-up menu lets you select either Composite, Component, or 
S-Video input source.

• Internal Waveform Monitor button lets you adjust luminance 
(Y gain and black setup) values.

Vectorscope VectorscopeInternal
Waveform
Monitor

Internal
Waveform
monitor

Slider

button

Preset buttons

Monitor monitorInput

Settings
Consumer Source
and 100% Bars

button
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• Preset buttons are lit when the factory preset levels are displayed. 
When you click a lit Preset button, it dims and the slider returns to the 
most recent manual level setting.

• Settings pop-up menu lets you save the Site settings for an individual 
tape each time you calibrate bars.

• Sliders let you change the value for: Black, Y Gain, Saturation, and 
Hue.

• Vectorscope Monitor button lets you adjust hue and saturation.

Digitizing Preparations Check List

1. Consider striping your drives in advance according to the appropriate 
setup guide, Avid MediaDrive Utilities User’s Guide (Windows), or 
AVIDdrive Utility 2 User’s Guide (Macintosh) if you are working on a 
complex project with multiple streams of video and high-resolution 
images.

2. Consider labeling each of your external drives. If there are no labels, 
you can add a specific name to help identify the information on the 
drive, for example, Boat Shop (G:). When digitizing audio, you must 
keep the audio files on a separate external drive from the 
uncompressed video files. To keep both the audio and video on 
separate drives, label your drives, for example: Audio (F:) and Media 
(G:).

3. Check your hardware configurations: power switches, cable 
connections, and remote switch on the source deck for deck control 
(for hardware configurations, see the appropriate setup guide).

4. In the Project Settings scroll list, make sure you have selected the 
options you want in the General Settings, Deck Settings, Deck 
Preferences, Deck Configuration, and Digitize Settings dialog boxes.

5. Insert a tape into the deck and set up the Digitize tool for track 
selection, target bin, target drives, source tape, and source deck.
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6. Set up the Compression tool for video resolution and color 
compression (for more information, see the appropriate editing guide 
and “Compression tool:setting up” in the Help index).

7. Use the Audio tool to set the audio input levels.

8. Use the Video Input tool to set the video input levels; save your video 
settings for future use.

About Digitizing

You can digitize your source material in one of the following ways:

t Digitize and log at the same time

t Batch digitize

t Redigitize

Digitizing and Logging at the Same Time

When you digitize without entering log information in a bin ahead of time, 
the system creates clips and associated media files while you digitize. 
Digitizing in this manner involves manually cueing source footage with an 
Avid-controlled deck, using the deck controls in the Digitize tool.

For more information 
on digitizing, see 
“Overview:digitizing” 
in the Help index.

There are several ways to digitize and log at the same time. They are:

• Digitizing from a mark IN to a mark OUT. This method lets you 
specify the exact timecode location to begin and end digitizing. You 
can also specify only a mark IN or mark OUT, and enter the other mark 
on-the-fly.

• Digitizing on-the-fly. This method is easier than setting marks, but it 
is more imprecise. It involves using the deck controls in the lower left 
corner of the Digitize tool to cue, play, and stop the source footage 
manually while digitizing.
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• Autodigitizing. This method requires the least amount of supervision 
and effort, but usually calls for more digitizing time and disk storage 
space. It involves playing each source tape from a cue point near the 
beginning and letting the system digitize the entire tape, automatically 
naming and entering each long clip into the bin.

Batch Digitizing
For more information 
and procedures, see 
“Batch digitizing” in 
the Help index.

Once you have imported a log or manually logged a group of clips into a 
bin, you can automate the digitize process using your Avid system’s 
batch–digitizing capabilities. To batch digitize, source tapes must have 
timecode.

(Symphony only) In Symphony, after selecting all the clips you want to 
batch digitize, select Res > uncompressed resolution.

(Symphony only) If your media was analog (not digital) when digitized, 
you will need to reset the color bars in the Video Input tool before batch 
digitizing. 

For more information 
and procedures, see 
“Adjusting color bars” 
in the Help index.

(Symphony only) After you batch digitize the media at the uncompressed 
resolution, you will have to re-create title media and rerender any non-real-
time effects you might have in your sequence. See “Re-creating Title 
Media” and “Rendering Multiple Effects “in the appropriate effects guide.

Redigitizing
For more information 
and procedures, see 
“Redigitizing” in the 
Help index.

Redigitizing is the process of capturing previously digitized source footage 
based on existing clips and sequences. Redigitizing uses the batch–digitize 
process and does not require extra logging time because the clip 
information for such things as source tracks, timecodes, and resolution 
settings already exists in the bin. 



Chapter 5

Getting Ready to Edit

Before starting an editing session, you need to understand how to organize 
and manipulate your clips.

Preparing to edit is described in the following sections:

• About Bin Views

• Controlling Playback

• Marking IN and OUT Points

• Creating Subclips

Tutorial: Getting Ready to Edit contains the following sections:

• Viewing Clips

• Playing Clips

• Marking Edit Points

• Subclipping

• Clearing IN Points and OUT Points
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About Bin Views

You can use four views for working with clips in a bin: Brief view, Text 
view, Frame view, and Script view.

The Bin Fast menu 
displays the same menu 
as the Bin menu on the 
toolbar along the top of 
your screen.

• In Brief view, clips are displayed in a database text format that uses 
columns and rows, with icons representing the various objects. Brief 
view displays only five standard columns of information about your 
clips and sequences. 

To enter Brief view, click the Brief tab.

Column headings

Object icons

Brief tab

Bin Fast
Menu button
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• In Text view, clips are displayed in a database text format that uses 
columns and rows, with icons representing the various objects. You 
can save various arrangements of columns, text, and objects as 
customized views using the Bins settings in the Project window and the 
Bin Fast menu.

To enter Text view, click the Text tab.

To the right of the Bin Fast Menu button in Text view, is a pop-up menu of 
titles for different Bin views. Bins have the following default views that 
are automatically loaded:

• Statistics view uses the standard statistical column headings derived 
from information established during capture, such as Start and End 
timecodes, Duration, Resolution, and so on.

• Custom view allows you to create and save customized views. The 
only required heading is the clip name, displayed by default. You can 
customize the view by adding, hiding, or rearranging column 
headings.

Text tab

Bin View pop-up menu



 Chapter 5 Getting Ready to Edit

84

• In Frame view, each clip is represented by a single picture frame, with 
the name of the clip. You can play back the footage in each frame, 
change the size of frames, and rearrange frames in any order within the 
bin.

To enter Frame view, click the Frame tab.
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• In Script view, the Avid system combines the features of Text view 
with Frame view, and adds space for typing notes or script. The frames 
are displayed vertically on the left side of your screen with a text box 
to the right of each clip. Clip data is displayed above the text box.

To enter Script view, click the Script tab.
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Controlling Playback

There are several ways to play, view, and cue clips. You can:

• Instantly access frames or move through footage using the position 
indicator within the position bar under the Source or Record monitors 
and under the Playback monitor (Symphony only) in the Symphony 
system’s Finishing view

For additional 
keyboard and user-
selectable button 
shortcuts, see the 
appropriate quick 
reference card.

• Play, step (jog), or shuttle through footage using user-selectable 
buttons

• Play, step, or shuttle using keyboard equivalents

• Step or shuttle using the mouse

Using Position Bars and Position Indicators

You can quickly access frames within a clip that’s been loaded into a 
monitor, or move through the footage using the position indicators that 
appear in the position bars under Source or Record monitors and in the 
Timeline when you are viewing a sequence.

• You can move the position indicator within the position bar under the 
Source or Record monitors by clicking anywhere in the position bar, or 
by clicking the position indicator and dragging it to the left or right. 
The speed with which you drag the position indicator determines the 
speed at which you move through the footage.

Position bar

Position indicator
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• In the Timeline, the position indicator shows your position within the 
sequence. It is always in the same position as the position indicator in 
the Record monitor’s position bar, and works in the same way. You 
can click anywhere in the Timeline to relocate the position indicator, 
or you can click the position indicator and drag it through footage at 
varying speeds.

• You can go directly to the beginning or end of a clip or sequence by 
clicking at the far left or far right of the clip or sequence.

Using Buttons

You can use the user-selectable buttons that appear below the Source and 
Record monitors to play and step through your footage. You can also use 
the keyboard to manipulate footage.

These buttons can be remapped from the Command palette onto any of the 
user palettes and the keyboard in any configuration.

Play Reverse, Play, Pause, Stop, Rewind, and Fast Forward Buttons

The Play Reverse, Play, Pause, Stop, Rewind, and Fast Forward buttons 
work much like the buttons on any conventional VCR. With a clip loaded 
in a monitor, the Play button plays your footage at a normal rate. The Play 
Reverse button plays backward at a normal rate.

Position indicator in Timeline

Fast

Rewind

StopPause

Play
Reverse

Play
Forward
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n During playback, the Play button also acts as a Stop button.

The Fast Forward and Rewind buttons instantly cue the footage to the next 
transition between clips. By default, the buttons cue footage to the head 
frame of the next transition. You can select the following alternatives in 
the Settings dialog box:

• Stop at Tail Frames

• Stop at Locators

• Ignore Track Lights

n To access the Settings dialog box, click the Settings tab in the Project 
window.

The Play, Fast Forward, and Rewind buttons appear by default in the first 
row of buttons below the Source and Record monitors and the pop-up 
monitors. You can map the Play Reverse, Stop, and Pause buttons from the 
Command palette.

When viewing sequences in the Playback monitor (Symphony only) or 
Record monitor, you can play only video and audio tracks that are 
currently monitored in the Track Selector panel.

To play a clip:

1. Load a clip or sequence into a monitor.

2. For sequences in the Record monitor, click the Video Track Monitor or 
Audio Track Monitor button in the Track Selector panel if they appear 
dimmed.

Video Track
Monitor button

Audio Track

Track
Selector

panel

Monitor button
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3. Go to the start of the clip or sequence by clicking the start of the 
position bar under the monitor, or by pressing the Home key.

4. To play the clip or sequence, click the Play button under the selected 
monitor.

5. To stop playback, press the space bar or click the Play button again.

Step Buttons

You can also use the Step buttons under the monitors to play the clip 
backward or forward in 1-frame or 10-frame increments.

When you have a single row of buttons displayed under your monitors, the 
Step Forward and Step Backward buttons appear. If you press and hold the 
Alt key (Windows) or the Option key (Macintosh) while clicking either 
button, you can advance 1 or 10 frames forward and 1 or 10 frames 
backward.

n To display all four Step buttons, you must display two rows of buttons 
under the monitors when configuring the Source and Record monitors in 
the Settings dialog box.

To step through footage:

1. Load a clip or sequence into a monitor.

2. Click the appropriate button to step 1 or 10 frames forward or 
backward.

1 frame
forward

1 frame
backward

10 frames
forward

10 frames
backward
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Using the Tool Palette

The Tool palette provides additional buttons for editing and 
navigating.

You can view the Tool palette by clicking the Fast Menu button between 
the Source and Record monitors. Click the Tool palette and drag it to any 
other location on the screen for easy access. You can also map additional 
buttons from the Command palette to the Tool palette (see “Using the 
Command Palette” on page 139).

To view the Tool palette with text, make sure the Show Labels in Tool 
Palette option is selected in the Interface Settings dialog box.

n To access the Settings dialog box, click the Settings tab in the Project 
window.

Using the Keyboard

The default keyboard contains all of the buttons mentioned, except the 
Single-Field Step buttons.

You can view your keyboard settings by selecting Keyboard from the 
Settings scroll list in the Project window.

n You can move and reassign buttons on the keyboard using the Command 
palette; see “User-selectable buttons:mapping” in the Help index.

Tool palette without text Tool palette with text
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J-K-L Keys (Three-Button Play)

The J-K-L keys on the keyboard allow you to play, step, and shuttle 
through footage at varying speeds. This feature, also referred to as 
three-button or variable-speed play, allows you to use three fingers to 
manipulate the speed of playback for greater control.

To shuttle through the footage using the J-K-L keys on the keyboard:

1. Do one of the following:

t Load a clip or sequence into the Source or Record monitor.

t Select a clip in a bin in Frame view.

2. Use the following keys to shuttle at varying speeds:

- Press the L key to move forward through the footage at normal 
speed. Press once to increase the forward speed 2 times, twice to 
increase it 4 times, and three times to increase it 8 times normal 
speed, as desired.

- Press the J key to move backward at the same shuttle speed 
increments.

- Press and hold the K and L keys together for slow forward.

- Press and hold the K and J keys together for slow backward.

3. To pause the shuttling, press the K key or press the space bar. 

Play button

Stop button

Play/Step/Shuttle buttonsStep buttons Home key
End key
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Home, End, and Arrow Keys

You can use the Home, End, and arrow keys on the keyboard to move 
through footage when a clip is loaded in a monitor.

• The Home key takes you to the beginning of a clip or sequence.

• The End key takes you to the end of a sequence.

• The Left Arrow key moves the footage one frame backward.

• The Right Arrow key moves the footage one frame forward.

Using the Mouse

You can use the mouse for one-handed control of playback. You can either 
step or shuttle using the mouse.

Stepping with the Mouse

To step using the mouse:

1. Do one of the following:

t Load a clip into the Source monitor or a sequence into the Record 
monitor.

t Select a clip in a bin in Frame view.

2. Do one of the following:

t Press the N key to activate mouse control for stepping.

t Activate the buttons on the Command palette by selecting Active 
Palette at the bottom of the Command palette. Then click the 
Mouse Jog button, which appears on the Play tab of the Command 
palette. This button can be mapped to any button under the 
Record monitor by selecting the Button to Button Reassignment 
option (see “Using the Command Palette” on page 139).

3. Move the mouse to the right to step forward, or to the left to step 
backward.

4. To quit stepping with the mouse, press the space bar.

Mouse Jog
button
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Shuttling with the Mouse

To shuttle using the mouse:

1. Do one of the following:

t Load a clip or sequence into the Source or Record monitor.

t Select a clip in a bin in Frame view.

2. Do one of the following:

t Press the semicolon (;) key to activate mouse control for 
shuttling.

t Activate the buttons on the Command palette by selecting Active 
Palette at the bottom of the Command palette. Then click the 
Mouse Shuttle button, which appears on the Play tab of the 
Command palette. This button can be mapped to any button 
under the Record monitor by selecting the Button to Button 
Reassignment option (see “Using the Command Palette” on 
page 139).

3. Move the mouse to the right to increase the shuttle speed, or to the left 
to decrease the shuttle speed.

4. To quit shuttling with the mouse, press the space bar or double-click 
the mouse button.

You can also use the keyboard in conjunction with the mouse to control 
shuttling. For example, if you are shuttling with the mouse and you press 
the L key, the playback speeds up to the next normal play rate (30, 60, 90, 
150, or 240 fps for NTSC; 25, 50, 75, 125, or 200 fps for PAL). You can 
continue to change the shuttle speed and direction with the mouse.

Mouse Shuttle
button
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Marking IN and OUT Points

You can mark IN and OUT points for your clips in advance, which 
provides several advantages:

• You can quickly build a sequence by splicing the marked clips into 
place one after another.

• You can use the process of rough-cut or storyboard editing, which 
allows you to instantly splice several prepared clips into a sequence 
(see “Storyboarding” on page 145). 

• You can play back and mark clips in the bin before loading a single 
clip, saving several steps.

Even if your marks are not accurate now, the Avid system allows you to 
trim the edit points and fine-tune the sequence later without reediting the 
material.

Creating Subclips

When you mark footage with IN and OUT points, you can either save the 
entire clip along with the new marks, or you can create subclips based on 
the marks you set to break up longer master clips into smaller segments of 
selected footage. 

Unlike master clips, subclips do not directly reference the original media. 
Subclips remain linked to the master clips from which they are created, and 
the master clips in turn reference the digitized media files located on your 
storage drives. As a result, none of the original footage is lost.
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You can also create 
subclips while 
digitizing
as described in 
“Subclips:creating 
on-the-fly” in the Help 
index.

You can create subclips directly from the marked section of material in the 
monitors using the following methods:

• Alt key (Windows) or the Option key (Macintosh): Press and hold 
the Alt key (Windows) or the Option key (Macintosh), then click the 
picture and drag it from the monitor to the bin in which you want to 
store the subclip.

• Clip icon: Click the icon next to the clip name in the Source monitor, 
then drag the icon to the bin in which you want to store the subclip.

The pointer changes to an icon of a hand pointing at a frame while you 
drag the frame. When you release the frame the subclip acquires a new 
name with the file name extension Sub.x, and a Subclip icon appears in 
the intended bin.

• Make Subclip button: Click the Make Subclip button located in the 
Command palette to create the subclip and place it into the active bin 
by default. If you press and hold the Alt key (Windows) or the Option 
key (Macintosh) while you click the Make Subclip button, a dialog 
box allows you to select the destination bin for the subclip.

For more information 
on trimming, see “Trim 
edits” in the Help 
index.

The new subclip is listed in the bin, preceded by a Subclip icon and 
identified with a numbered .Sub file name extension, as shown in the 
following illustration.

Clip icon

A new subclip as 
referenced in 
Text view
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Tutorial: Getting Ready to Edit

This tutorial takes you through the early stages of editing.

n If you need more information, be sure to read the preceding overview 
sections of this chapter before you start this tutorial.

1. If your Avid system is not already running, start it by double-clicking 
the Avid application icon.

2. Select your user name and your Boat Shop NTSC or Boat Shop PAL 
project and click OK.

3. From the Project window, double-click the Source Clips bin.

The clips are displayed in the bin.

Viewing Clips

The information in a bin can be viewed in the following ways:

• Brief view displays only five standard columns of information about 
your clips and sequences.

• Text view displays multiple columns of information about your clips 
and sequences.

• Frame view displays each clip as a single representative image.

• Script view displays each clip with an image and an area in which to 
enter text as part of a storyboard.
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Using Text View

Let’s look at Text view.

1. Click the Text tab to view information about clips in the Source Clips 
bin.

If the tab is highlighted, you are already in Text view.

You can rearrange the clips in the bin by sorting on a particular 
column. Let’s sort by clip name so we can easily locate any clip.

2. Click the Name heading in the bin.

3. Select Bin > Sort along the top of the screen.

The clip names are rearranged in alphabetical order.

n To sort in numerical order, select another heading, for example, duration.

Text view Frame view

Bin Fast
Menu button



 Chapter 5 Getting Ready to Edit

98

Using Frame View (Windows)

Now let’s look at Frame view.

1. Click the Frame tab to see a picture-frame representation of each clip 
in the bin.

n The sorted order of clips does not carry over to Frame view.

2. Select Edit > Reduce Frame or Enlarge Frame.

To change frame size at the keyboard, you can also press Ctrl+K 
(Reduce Frame) and Ctrl+L (Enlarge Frame).

If some clips are now off screen, do one of the following:

t Click the Maximize button in the upper right corner of the bin 
window.

t Select Bin > Fill Window.

t Click and drag the window corner in the lower right corner of the 
bin window. 

The clips are arranged in neat rows and columns in the bin.

Using Frame View (Macintosh)

Now let’s look at Frame view.

1. Click the Frame tab to see a picture-frame representation of each clip 
in the bin.

n The sorted order of clips does not carry over to Frame view.

2. Select Edit > Reduce Frame or Enlarge Frame.

To change frame size at the keyboard, you can also press Command 
(k)+K (Reduce Frame) and k+L (Enlarge Frame).
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If some clips are now off screen, do one of the following:

t Click the Zoom button in the upper right corner of the bin 
window.

t Select Bin > Fill Window.

t Click and drag the size box in the lower right corner of the bin 
window. 

3. Click the Zoom button in the upper right corner of the bin window 
labeled Source Clips.

The bin zooms out to enclose all the clips. However, they might be 
scattered randomly in the bin window. Let’s fix that.

4. Select Bin > Fill Window.

The clips are arranged in neat rows and columns in the bin.

Now you can adjust frame size so the clips are “readable” but not so 
large that they won’t fit in the bin window.

The clips are arranged in neat rows and columns in the bin.

Playing Clips

Your Avid system offers a variety of ways to play clips. The more you 
practice the various methods, the more control you will have over the 
editing process.

Playing Clips in the Source Monitor
(Symphony only) To 
display both the Source 
and Record monitors, 
click the 
Source/Record button 
to exit Finishing mode.

The Source and Record monitors are windows in which you can play clips.

1. In the Source Clips bin, open the clip named bridge by double-
clicking anywhere in the frame.
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The bridge clip opens in the Source monitor.

2. Press the Home key on the keyboard (between the main keyboard and 
the numeric keypad) to go to the start of the clip.

The End key, just below the Home key, moves the position indicator to 
the end of the clip.

3. Press the Play (5) key on the keyboard to play the clip at normal speed.

4. Press the Play (5) key again (or press the space bar on the keyboard) to 
pause playback at any point.

5. Press the L key (Play) on the keyboard to play the clip forward at 
normal speed. Press the key repeatedly to play the clip forward at 60, 
90, 150, and 240 frames per second (fps). 

6. Press the J key (Reverse Play) on the keyboard to play the clip 
backward at normal speed. Press the key repeatedly to play the clip 
backward at 30, 60, 90, 150, and 240 frames per second (fps). 

7. Press the K key (Pause) on the keyboard to pause playback.

8. To move forward or backward at slow speed, press and hold the 
K key while you press and hold the L or J key.
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9. Use the 4, 3, 2, and 1 keys to step through the footage forward or 
backward in 1-frame or 10-frame increments.

Controlling Playback

In the Source and Record monitor, you can use:

• Playback control keys

• Equivalent buttons under the Source and Record monitor

• Blue position indicator to go to a specific position or scroll (move) 
through a clip

To play through the clip:

1. Double-click the tools clip to open it.

The tools clip opens in the Source monitor.

You can press the Play 
(5) key on the keyboard 
for the same purpose.

2. Click the Play button.

3. Click the Play button again (or press the space bar on the keyboard) to 
pause playback at any point.

Step 10
Frames Backward Step 10

Frames Forward

Step 1
Frame Backward

Step 1
Frame Forward

Play 
 

Position
bar

Step Step

Position indicator

Backward Forward



 Chapter 5 Getting Ready to Edit

102

4. Step through the footage forward or backward in 1-frame and 
10-frame increments using the Step Forward and Step Backward 
buttons under the Source monitor. You can also use the 4, 3, 2, and 1 
keys on your keyboard.

5. Locate the vertical blue position indicator in the position bar in the 
Source monitor.

To step several frames 
forward, click just to 
the right of the position 
indicator.

6. Click just to the left of the position indicator to step several frames 
back in the clip.

7. Press the Home key to go to the beginning of the clip.

Press the End key to go 
to the end of the clip.

8. Step through the clip by clicking different spots in the position bar.

9. Click the position indicator and drag it to the left, then to the right, to 
scroll through the clip.

Marking Edit Points

Before making your first edit, you can mark the segments of the clips you 
want to use in your sequence. You can mark clips in the Source monitor.

In this section, you will:

• Mark IN and OUT points in the Source monitor.

• Locate IN and OUT points by timecode in the Source monitor.

Marking the planing ms Clip

Let’s first display clips in the Source monitor, and then mark a couple of 
clips you will use when you edit the sequence.

1. Activate the Source Clips bin by clicking anywhere in it.

The bar above the active window changes to purple.

2. Double-click the planing ms clip to open it.

The clip name is highlighted and the clip opens in the Source
monitor.
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3. Play the clip from the head by pressing the Home key and then the 
Play (5) key, and find the approximate place where the boatbuilder 
begins to plane. Then use the Step Forward and Step Backward 
(3 and 4) keys to locate the frame where he starts the first planing 
stroke.

4. Mark an IN point by pressing the Mark IN (I) key.

A white sawtooth pattern appears on the left edge of the Mark IN 
frame.

5. Step forward two full strokes of the plane.

6. Mark an OUT point by pressing the Mark OUT (O) key.

A white sawtooth pattern appears on the right edge of the Mark OUT 
frame.

The system saves your IN and OUT points until you change them.

Marking the ducks Clip

Now mark the IN and OUT points for the ducks clip. This time, instead of 
using the Play (5) key, use the J-K-L keys to play the clip.

1. Double-click the ducks clip to open it.

2. Locate the frame where the second duck enters the right edge of the 
frame behind the duck swimming in the foreground.

Use the 3 and 4 keys to locate the precise frame.
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3. Mark an IN point by pressing the I key.

A white sawtooth pattern appears on the left edge of the Mark IN 
frame.

4. Step forward to locate the first frame where the same duck flies 
beyond the left edge of the screen.

5. Mark an OUT point by pressing the O key.

A white sawtooth pattern appears on the right edge of the Mark OUT 
frame.

Marking the draw knife cu Clip

Let’s mark another clip we’ll use in the sequence.

1. Double-click the draw knife cu clip to open it.

When you edit the sequence, you want to show just three strokes of the 
knife.

2. Place the position indicator near the midpoint of the clip, and play 
forward until just after the first fairly large wood chip falls off.

Use the Play button (or J-K-L keys) to get close to the frame, and then 
use the Step buttons to locate the frame you want to use as your IN 
point.

3. Mark an IN point by clicking the Mark IN button under the monitor.

A white sawtooth pattern appears on the left edge of the Mark IN 
frame.

4. Step forward and locate a frame just after three strokes of the knife.

5. Mark an OUT point by clicking the Mark OUT button under the 
monitor.

A white sawtooth pattern appears on the right edge of the Mark OUT 
frame.
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Using Timecode to Find a Frame

You can mark IN and OUT points using timecode as your reference point. 
If you know the timecode for the frame you want to mark, you can go to 
that frame instantly by typing it on the numeric keypad.

In this section, you will use visual cues to mark an IN point, and then 
locate a specific timecode. First, you need to display the appropriate 
timecode information.

1. Double-click the chiseling clip to open it.

2. Place the pointer in the gray title bar area over the timecode 
information displayed above the Source monitor.

3. When the pointer changes to a downward arrow, click to display the 
pop-up menu, and select TC, V1 (timecode for track V1). A check 
mark means it is already selected.

The timecode references the frame displayed in the Source 
monitor.

4. Mark an IN point by clicking the Mark IN button under the 
monitor.

The timecode references the frame displayed in the Source 
monitor.

5. Read the timecode in the Timecode display at the IN point. Add 15 
frames (13 frames PAL) to the timecode number. (Remember, there 
are 30 frames in a second.)

One second holds 30 frames.

Timecode shows the following:
Hours
Minutes
Seconds
Frames
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For example, if the timecode is 04:11:34:15, adding 15 frames gives 
you a result of 04:11:35:00.

6. Type +15 on the numeric keypad on the right side of the keyboard and 
press the Enter key on the numeric keypad.

As you start typing, a window opens in the middle of the Source 
monitor, showing the numbers you type. When you press the Enter 
key, the position indicator locates the specified frame.

The Timecode window displays the current timecode. 

n To locate frames using the numeric keypad, you must show the appropriate 
timecode in the Timecode display. For example, the timecode display must 
show track V1 to go to a specific frame on the V1 track.

7. Click the Mark OUT button.

Current 

Timecode
display

timecode 
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Using Frame Offset
Whenever you use the 
numeric keypad, you 
must press the Enter 
key on the numeric 
keypad after typing the 
number. 

You can also use the numeric keypad to move the position indicator 
forward or backward a specified number of frames, with the frame offset 
feature. Let’s mark an IN point for the planing cu clip and then use frame 
offset to locate the OUT point.

1. Double-click the planing cu clip to open it.

2. Use the Play and Step buttons to locate the frame where the 
boatbuilder begins making the first stroke of the plane.

3. Click the Mark IN button.

4. To advance 2 seconds, type +129 (+124 PAL) on the numeric keypad 
and press the Enter key on the numeric keypad. The system inserts the 
colons for you.

Since the system counts the frame it is parked on, you type one frame 
fewer than 2 seconds.

When using frame 
offset, type one frame 
fewer than the number 
of frames you want to 
advance.

If you want to move back a certain number of frames, type a minus 
sign (–) instead of a plus sign (+) in front of the number.

5. Mark that frame as the OUT point.

Subclipping

Now you will copy portions of one clip into shorter clips, called subclips. 
Subclipping is a great way to organize your footage into manageable units.

1. Double-click the tools clip to open it.

2. Press the Home key to go to the start of the clip.

3. Scroll through the clip by clicking the Play button or by dragging the 
blue position indicator. There are two separate actions that can be 
copied into separate subclips.

4. Mark an IN point when the boatbuilder begins turning the auger drill.

5. Mark an OUT point 14 seconds later by typing +1400 on the numeric 
keypad and pressing the Enter key on the numeric keypad.
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Actually, you have marked an OUT point after 14 seconds and 
1 frame, but that’s acceptable because you need not be so precise here.

6. Click the Clip icon next to the clip name in the upper left corner of the 
Source monitor, and drag the icon into the Source Clips bin.

As you begin dragging, the pointer changes to a hand attached to a 
small box.

The subclip has the 
name of the original 
clip, followed by 
Sub.n, where n is the 
number of times the 
master clip has been 
cataloged to that bin. 

A new item called tools.Sub.01 appears in the Source Clips bin. The 
name is highlighted.

7. Type drilling and press the Enter key (Windows) or the Return key 
(Macintosh) to name the subclip.

Clearing IN Points and OUT Points

To remove IN and OUT points:

1. With the tools clip in the Source monitor, click the Clear Both Marks 
button under the Source monitor to clear the IN and OUT points.

2. Mark an IN point in the clip when the boatbuilder begins hammering, 
after he takes a few practice swings.

3. Mark an OUT point at the end of the clip.

4. Press and hold the Alt key (Windows) or the Option key (Macintosh), 
click the clip, and drag it from the Source monitor to the Source Clips 
bin.

The clip name is highlighted in the Source Clips bin.

5. Type hammering and press the Enter key (Windows) or the Return 
key (Macintosh).

You’ve finished this tutorial. You can go on to “Tutorial: Rough Cut” on 
page 122, or quit the Avid system.

Clip icon
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Closing the Project

To close the project:

1. Select File > Close Bin.

The bin closes.

2. Click the Project window and select File > Close.

The system saves and closes the project. A dialog box opens.

3. Do one of the following:

t Select an existing project.

t Create a new one.

t Click Quit.

Ending the Session

To end the session:

1. Select File > Save Bin or Save All Bins.

2. Click the Project window labeled Boat Shop NTSC or Boat Shop PAL.

3. Select File > Save All.

4. Do one of the following:

t Go to the next tutorial.

t (Windows) If you are ready to take a break, select File > Exit to 
quit the Avid system.

(Macintosh) If you are ready to take a break, select File > Quit to 
quit the Avid system.

The system returns to the desktop.
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Chapter 6

Editing a Rough Cut

Beginning to edit involves working with various elements of the Avid 
system interface.

Editing a rough cut is described in the following sections:

• Viewing Methods

• Navigating in the Timeline

• Displaying Source Material in the Timeline

• Using the Track Selector Panel

Tutorial: Rough Cut contains the following sections:

• Making the First Edit

• Splicing Video into the Sequence
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Viewing Methods

You can work with clips and sequences in several different ways, 
depending upon your needs and preferences. Each method has its own uses 
and advantages, as follows:

• Viewing in bins: Frame view shows you pictorial images of the clips 
in your bins; Brief and Text views show you the clips listed by name.

• Viewing in the Source monitor: You can load clips and sequences 
into the Source monitor to view and mark or subcatalog clips for use in 
a sequence that you build in the Record monitor.

• Viewing in the Record monitor: You can load a sequence into the 
Record monitor to view, mark, or modify an existing sequence. Press 
and hold the Alt key (Windows) or the Option key (Macintosh), and 
click a clip or group of clips and drag them into the Record monitor to 
create a sequence.

Source monitor
with clip loaded

Record monitor
with sequence loaded
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• Viewing in Finishing mode: (Symphony only) The default monitor 
that opens for Avid Symphony is the Record monitor. You can 
perform all your editing functions in this mode. To exit Finishing 
mode, click the Source/Record button. This displays both the Source 
monitor and Record monitor.

• Viewing in pop-up monitors: You can load clips into pop-up 
monitors to view and mark one or several clips simultaneously in 
smaller, movable windows.

Two pop-up
monitors with
clips loaded
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• Viewing in the Timeline: Use the Timeline to view individual tracks 
for either a sequence or a source clip.

• Viewing in the Client monitor: You can use the Client monitor to 
view your footage in a larger screen format.

Navigating in the Timeline

The Timeline window provides various controls for quickly moving 
through a sequence and adjusting your view of details displayed in the 
tracks while editing. You can make changes in the Timeline format using 
the Timeline Fast menu or by selecting Timeline in the Bin Settings scroll 
list.

Using the Position Indicator

The position indicator (the vertical blue line) in the Timeline marks your 
place in the sequence. It also determines how some of your commands are 
interpreted. For example, when you perform an edit, the system takes the 
location of the position indicator as the mark IN in the absence of 
established marks.

When you move the position indicator in the Timeline, the smaller position 
indicator within the Record monitor’s position bar also moves.

The Timeline is used for viewing tracks.
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Using the Scroll Bar

The scroll bar functions like any standard scroll bar. Click the arrows or 
drag the scroll bar to scroll left or right.

Displaying More or Less Detail

The scale bar expands and contracts the Timeline area centered around the 
blue position bar, allowing you either to zoom in to focus on a specific area 
of your sequence, or zoom out to see your whole sequence. This is 
especially useful when you have a lengthy sequence with many edits.

The Timeline always expands or contracts proportionally on both sides of 
the position indicator.

• To see more detail, click the scale bar and drag it to the right.

As the Timeline expands, a second “shadow” position indicator 
appears next to the blue position indicator showing the end of a single 
frame, and the two continue to move apart as you expand the Timeline.

The position indicator and its shadow mark the beginning and end of 
each frame. The solid bar is the mark or edit point. You can click to the 
left of the bar or to the right of the shadow to move exactly one frame 
forward or backward.

When the Timeline is one-third or less of the screen, it will scroll off 
the screen. If you expand the Timeline to fill half of the screen, it will 
split in half (or thirds) as it wraps through the sequence for you to see 
all the clips.

Scroll bar

Scale bar

As the Timeline 
expands, a shadow 
position indicator 
appears.
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n You can prevent the Timeline from wrapping by deselecting Wrap Around 
from the Timeline Fast menu. If you turn off wrapping, the Timeline will 
scroll off the screen.

• To contract an expanded Timeline to see less detail but more of the 
sequence, click the scale bar and drag it to the left.

Focusing the Timeline

Another alternative to the scroll and scale functions is the Focus 
button.

The Focus button allows you to center the position indicator quickly and 
expand the Timeline. Unlike the scroll and scale functions, the Focus 
button expands the Timeline. The position indicator is centered in the 
window. When you click the Focus button a second time, it always returns 
the Timeline to its previous size.

Displaying Source Material in the Timeline

The Toggle Source/Record button in the Timeline allows you to view a 
Timeline of the clips in the Source or pop-up monitor. This is especially 
useful if you are editing multitrack effects.

Focus button
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By default, the Timeline displays only the source material’s tracks.

When you click the button to display the source material, both the button 
and the position indicator change to green to indicate you are viewing 
source material.

This feature is particularly useful when you are editing a sequence or a 
subclip created from a sequence. You can also use it to look at the contents 
of any source clip in a Timeline window.

Toggle Source/Record button

Source Track
buttons

Button and position indicator
change to green
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Using the Track Selector Panel

The Track Selector panel provides numerous controls for working 
effectively with multiple tracks. With this one panel, you can select, delete, 
monitor, enlarge, reduce, lock, patch, and move any video or audio track.

The Track Selector panel also provides a quick display of track 
information. You can see which tracks (on the source or record side) are 
available, active, patched, monitored, or locked. The following 
configuration shows one example. The Track Selector panel might look 
very different depending on the nature of the source material or the work 
under way in the sequence.

The source side (left side) of the panel displays only those tracks available 
for the clip currently loaded and displayed in the Source or pop-up 
monitor. For instance, a clip that has audio digitized for track A1 only, 
does not display an A2 track in the Track Selector panel.

The record side of the panel displays only those tracks currently in use for 
the sequence. However, if you edit source material with a track selected 
that does not yet exist on the record side (A3 in the previous example), by 
default the track appears on the record side after the edit takes place.

A clip (or sequence) needs to be loaded in the Source and Record monitors 
to display both track panels.

Source Track Monitor buttons
Source Track buttons
Sync Lock and Lock buttons
Record Track buttons
Record Track Monitor buttons

Timecode button
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Selecting Tracks

You can select tracks on either the record side or the source side as 
follows:

• You can edit selected tracks on the source side directly into the 
sequence, assuming you have selected parallel tracks on the record 
side.

• You cannot edit deselected tracks on the source side into the sequence, 
regardless of record track selections.

• You cannot edit deselected tracks on the record side, regardless of 
source track selections.

There are four methods for selecting tracks:

• Click any deactivated Track Selector button to select it. Click any 
activated Track Selector button to deselect it.

• Drag a lasso around multiple Track Selector buttons to select them all 
at once.

• With the Timeline window active, select Edit > Select All Tracks to 
select all tracks on the record and source side.

• Use the Cycle Picture/Sound button on the Edit tab of the Command 
palette to cycle among selection of the video tracks, the audio tracks, 
and all tracks.

For example, you might select the source and record tracks for V1, A1, and 
A2 to edit video and audio from the source clip into the sequence. Select 
only V1 source and record tracks to edit the video without the sound. Or, 
select only A1 and A2 source and record tracks to edit the sound without 
the video.

n Selected tracks change color.

n There are also keyboard equivalents for selecting tracks. Check your 
keyboard or the Keyboard settings in the Project window Settings scroll 
list.
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Monitoring Tracks

You determine the monitoring of tracks by clicking a Track Monitor 
button of either the source-side or record-side tracks to activate or 
deactivate the track for monitoring. Video Track Monitor buttons and 
Audio Track Monitor buttons behave differently in some circumstances, as 
described in this section.

Monitoring Video

The Video Track Monitor button determines whether you see video during 
playback. The Video Track Monitor button displays a Monitor icon when 
the track is monitored for playback and output. You can turn it off at any 
time to monitor only audio during editing. When there are multiple video 
tracks, all tracks below the monitored track are active during playback.

When you edit with multiple tracks, you can activate the Video Track 
Monitor button on a lower track to monitor only the video on that track. 
This is especially useful when you have multiple layers of video effects 
and need to see one track without the additional layers.

n If you activate the Video Monitor Track button on a lower track, be sure to 
activate the topmost track to view, render, or record all the tracks 
together. Unmonitored tracks are not included in playback.

Video Track Monitor buttons

Audio Track
Monitor

Audio Track
Monitor

buttons buttons
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Auto-Monitoring

When you delete a video track with the Video Track Monitor button 
activated, auto-monitoring automatically activates the Video Track 
Monitor button for the next available track.

For example, if V2’s Video Track Monitor button is activated and you 
delete the V2 track, then the V1 Video Track Monitor button is 
automatically activated. Auto-monitoring activated is the system default. 
You can deactivate auto-monitoring from the Timeline Settings dialog 
box.
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Tutorial: Rough Cut

In this tutorial, you begin editing the Boat Shop sequence.

n If you need more information, be sure to read the preceding overview 
sections of this chapter before you start this tutorial.

1. If your Avid system is not already running, start it by double-clicking 
the Avid application icon.

2. Select your user name and your Boat Shop NTSC or Boat Shop PAL 
project and click OK.

3. From the Project window, double-click the Source Clips bin.

The clips are displayed in the bin.

Making the First Edit

In this section, you lay down the audio clip, which contains the sequence’s 
music and narration. You learn how to mark exactly 1 minute of the clip, 
which will be the duration of your finished sequence. First, you play the 
clip.

1. Double-click the Audio Track clip and play the clip in the pop-up 
monitor.

The clip opens as black because it’s audio only.

2. Go to the head of the clip by pressing the Home key on your 
keyboard.

Using Digital Audio Scrub to Locate a Specific Frame of Audio

Use digital audio scrub to locate a specific frame of audio. Use it now to 
locate the first frame of music in the audio clip.

1. Press the Caps Lock key to activate digital audio scrub.

2. Play the clip again and click the Play button to stop at the approximate 
place where the music begins.
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3. Press the Step (jog) keys (1, 2, 3, 4 on the keyboard) to locate the first 
frame of the music and click the Mark IN button.

When you use the Step keys, a frame of music or speech sounds 
scratchy or buzzlike. You might want to increase the volume of your 
speakers to hear the first frame of music.

4. Press the End key on the keyboard.

5. Press the Step Backward key to find the last frame of music. 

6. Mark that frame as the OUT point.

7. Press the Caps Lock key again to close digital audio scrub.

Splicing an Audio Clip

Click the yellow Splice-in button between the Source monitor and Record 
monitor to copy the audio clip into the Record monitor.

If no IN or OUT points 
are selected, the entire 
clip is edited into the 
Timeline.

The audio clip is edited onto track A1 of the Timeline. The first frame is 
the IN point you marked in the clip; the last frame is the OUT point you 
marked in the clip.

The audio track appears in the Timeline. The sequence also opens in the 
Record monitor (the audio track appears black).

Playing a Sequence

The Source Clips bin contains your newly created sequence. By default, 
the system names it Untitled Sequence.01. Let’s change this name.

1. Click the name Untitled Sequence.01 to select it; do not click the 
Sequence icon.
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The name is highlighted.

2. Type Boat Shop Cut and press the Enter key (Windows) or the 
Return key (Macintosh).

3. Click the position bar under the Record monitor or anywhere near the 
left side of the Timeline, then click the Play button to play the audio.

This audio track should run the length of the sequence, and its duration 
should be approximately 1 minute.

Confirming the Duration

To confirm the duration of your sequence, you can display the master 
timecode, which is the timecode of your sequence.

1. If the master timecode is not displayed, click and pull down the 
Timecode display from the gray area above the Record monitor and 
select Mas (Master) timecode.

The master timecode displays the location of the position indicator in 
your sequence.

2. Move the position indicator in the Timeline or the Record monitor to 
the last frame of the sequence.

The master timecode should read approximately 01:01:00:00.

Audio
Track
Monitor
buttons

The Audio Track Monitor 
button appears gold when 
an audio track is selected.
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Splicing Video into the Sequence

Now we’ll start laying some video over the audio. For the opening clip in 
the sequence, use the bridge clip.

1. From the Source Clips bin, double-click the bridge clip to open it in 
the Source monitor.

Play the whole clip 
through once first to 
get a sense of the 
material.

2. Mark an IN point midway through the clip, about 2 seconds after the 
camera begins to pan left. Watch the timecode at the top of the Source 
monitor to determine 2 seconds after the camera pans left.

3. Mark an OUT point 3 seconds and 6 frames (5 frames PAL) later, at 
approximately 01:13:43:23.

n If you do not mark an IN point and OUT point, the entire clip will be edited 
into the sequence.

4. Move the position indicator in the Timeline or Record monitor to the 
head of the sequence. 

5. Deselect the A1 Record Track button.

The track is highlighted when it is selected; it appears dimmed when it 
is deselected.

6. Press the Splice-in (V) key on the keyboard or click the yellow 
Splice-in button under the Source monitor.

The bridge clip is edited into the V1 track in the Timeline and is 
displayed in the Record monitor. The position indicator rests on the 
first frame of black following the splice.

To activate an open bin 
or monitor, click 
anywhere in it or select 
Windows > name.

7. Click anywhere in the Record monitor to activate it.

8. Do one of the following to move to the head of the sequence:

t Press the Home key.

t Click the beginning of the Timeline.

9. Click the Play button to play the clip in the sequence.

Deselect
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10. Above the Source monitor, click the Clip Name pop-up menu, and 
select Clear Monitor to close the clip.

Splicing a Clip in a Pop-up Monitor

The default setting is to open a clip in the Source or Record monitor. If you 
want, you can change the default setting to open clips in a pop-up monitor.

1. From the Project window, click the Settings tab.

Bin selection

Settings tab
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2. Double-click the Bin selection (you might have to scroll to locate the 
Bin selection).

The Bin Settings dialog box opens.

3. Click the pop-up menu, and select New Pop-up Monitor, and then 
click OK.

By default, this loads the clip into a pop-up monitor when you double-
click the clip.

4. From the bin, double-click the ducks clip.

This opens a pop-up monitor. Previously, you entered IN and OUT 
points, but we need to create different ones. It’s not necessary to clear 
the IN and OUT points. When you create a new IN point and OUT 
point, the system automatically clears previously set points.

5. Locate a frame in the pop-up monitor just after the clip’s midway point 
where the duck that has been sitting in the water is about to take off. 
Using the Step Backward key, mark an IN point five frames before the 
duck begins to move its wings to fly.

6. Mark an OUT point in the first frame after the duck leaves the monitor 
to the left.

Select to open pop-up monitors.
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Playing IN to OUT

Now you can take a look at the marked portion of the clip to make sure it is 
what you want.

1. Click the Play IN to OUT button or press the 6 key on the 
keyboard.

The clip plays from the IN point to the OUT point.

If possible, it would be nice to provide a little “breathing space” before 
the next clip. 

2. Play the rest of the clip to see if there are several frames of water after 
the duck leaves the clip. 

Using the Go to OUT Button

The Avid system provides a number of methods for snapping the position 
indicator to an IN or OUT point.

1. Click the Go to OUT button or press the W key on the keyboard.

The position indicator moves to the OUT point.

2. Type +6 on the numeric keypad and press the Enter key on the 
numeric keypad to add 7 frames to the clip.

Whenever you use the 
numeric keypad, you 
must press the Enter 
key on the numeric 
keypad after typing the 
number.

3. Mark that frame as the OUT point.

The OUT point automatically moves to the new position.
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Moving to the Head and Tail of a Clip

Before splicing in the next clip, make sure the position indicator is on the 
first frame of black after the bridge edit. To do this:

To snap the position 
indicator to the last 
frame of a clip, press 
Alt+Ctrl (Windows) or 
Option+k
(Macintosh), and click 
the mouse between the 
ending transition and 
the position indicator.

1. Move the position indicator anywhere to the right of the bridge clip in 
the Timeline.

2. Press and hold the Ctrl key (Windows) or the k key (Macintosh) and 
click the mouse between the transition and the position indicator. The 
position indicator snaps to the first frame of the clip.

3. Click the V1 Source and Record Track buttons in the Timeline.

The selected tracks appear highlighted, not dimmed (gray).

Using the Splice-in Button

To splice a clip:

1. With the position indicator at the end of the bridge clip, click the 
yellow Splice-in button under the Source monitor.

The second clip is now edited into the sequence.

2. Go to the head of the sequence and play through the first two clips.

Splicing a Clip into the Middle of a Sequence

With nonlinear editing, you can splice a clip anywhere in your sequence.

1. To open the clip in the Source monitor, click the Settings tab in the 
Project window. 

2. Double-click the Bin selection.

The Bin Settings dialog box opens.
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3. Click the “Loads clip into Source or Record monitor” option (to 
deselect it) and click OK.

By default, this loads the clip into the Source monitor when you 
double-click the clip.

4. From the Source Clips bin, open the kids rowing clip in the Source 
monitor.

5. Mark IN and OUT points to mark 4 seconds of the camera panning 
from the girl to the boy.

Let’s see what this clip looks like between the first and second clips.

6. Turn on the V1 and turn off the A1 record tracks.

7. Click in the middle of the ducks clip, between the position indicator 
and the bridge clip.

8. Press and hold the Ctrl key (Windows) or the k key (Macintosh), and 
click the mouse within the ducks clip in the Timeline to place the 
position indicator on the first frame of the ducks clip.

9. Press the Splice-in (V) key on the keyboard.

Wherever you splice a clip into the middle of a sequence, the rest of 
the sequence moves down. Splicing lengthens the material on the 
track.

10. Play the sequence so far to see what you have done.

Undoing an Edit

The kids rowing clip doesn’t seem to fit here. Let’s undo the last step.

Select Edit > Undo Splice-in or press Ctrl+Z (Windows) or 
k+Z (Macintosh).

Use the Undo feature whenever you feel you have made a mistake or want 
to go back a step. You can undo or redo up to 32 previous actions listed in 
the Edit menu.



Splicing Video into the Sequence

131

Using the I/O (IN Point / OUT Point) Tracking Display

Now you will add two more clips to the sequence. 

1. Open the kids in shadow clip. 

2. Click the Clear Both Marks button.

3. Mark an IN point in the first half of the clip, one frame before the 
second boat enters screen left.

4. Mark an OUT point 3 seconds and 17 frames later (PAL: 3 seconds 
and 14 frames) by following this procedure:

a. In the gray area above the Source monitor, click the Timecode 
Display pop-up menu (under the timecode), and select I/O.

The I/O option displays the duration from the IN to OUT points. If 
you only mark the IN point, the I/O displays the duration from the 
IN point to the position indicator.

b. Step forward until the I/O display reaches 3:17, and mark the OUT 
point.

5. Deselect the A1 Record Track button.

6. Move the position indicator to the first black frame.

7. Press the V key on the keyboard to splice the clip into the Timeline as 
the third clip. 

8. Open the rowing forward clip and mark an IN point a little less than 
halfway through the clip, when the dory is evenly centered between 
the right and left edges of the frame.

9. Mark an OUT point 5 seconds later.

10. Select File > Save.

11. Splice the clip into the Timeline as the fourth clip.

12. Select File > Save All Bins.

You’ve finished this tutorial. You can go on to “Tutorial: Refining Edits” 
on page 144, or quit the Avid system.
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Chapter 7

Refining the Edit

Refining edits tightens and improves the relationship between pictures and 
sound. 

Refining edits is described in the following sections:

• Using Segment Mode to Edit in the Timeline

• Basic Trim Procedures

• Using the Command Palette

• Audio Editing

Tutorial: Refining Edits contains the following sections:

• Overwriting Clips into a Sequence

• Storyboarding

• Rearranging Clips

• Removing Footage from a Sequence

• Trimming

• Working with Audio
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Using Segment Mode to Edit in the Timeline

Segment mode provides editing controls for moving, deleting, marking, 
and editing entire segments in the Timeline. A segment is a portion of the 
sequence that includes two or more transitions. There are two modes for 
editing segments or adding clips: Extract/Splice-in (indicated by a yellow 
arrow) and Lift/Overwrite (indicated by a red arrow).

Unlike traditional tape editing, Segment mode allows you to instantly 
reposition entire segments using visual controls as though you were 
physically “dragging” portions of your sequence around on a tape. You can 
move clips separately or together, on one track or across tracks.

Editing in Segment Mode

Observe the following guidelines when editing in Segment mode:

• Transition effects on either side of a moved selection are deleted. 
Transition effects inside the selection are preserved.

• You can track the audio while moving segments by pressing the Caps 
Lock key to enable audio scrub.

• When you are finished, Segment mode continues to affect your editing 
in Source/Record mode or Trim mode unless you click the active 
Segment Mode button to deactivate it.

Distinguishing Between Two Types of Editing Buttons

In Chapter 6, you used the Splice-in button. The Splice-in button and the 
Overwrite button (see “Overwriting Clips into a Sequence” on page 144) 
take clips from the Source pop-up monitor and place them into the 
Timeline. The Segment Mode buttons, Extract/Splice-in and 
Lift/Overwrite, move segments around within the Timeline. The names are 
similar but you use them for different purposes.
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Basic Trim Procedures

You can enter Trim mode in several different ways, depending on the type 
of trim you expect to perform. Once in Trim mode you can:

• Select additional tracks.

• Switch between Big and Small Trim mode.

• Switch between trim sides.

• Perform and play back the trim.

Entering Trim Mode

There are four alternative methods for entering Trim mode. They are:

• Clicking the Trim Mode button. By default, the system enters Trim 
mode and selects the tracks nearest the position indicator for dual-
roller trimming. This method is useful for selecting straight-cut 
transitions on one track or across video and audio tracks.

When you deselect one or more tracks in the Track Selector panel, by 
default, only the transitions in the highlighted tracks are selected for 
trimming. If the transitions are not straight cuts (overlap cuts or 
L-edits), the system highlights the topmost track nearest the position 
indicator.

Transition selected
for trimming
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• Lassoing the transitions in the Timeline. Draw the lasso by clicking 
at a point above the top track in the Timeline and dragging to surround 
the transitions. This method is useful when you need to select multiple 
transitions staggered across parallel tracks (overlap cuts) for 
simultaneous trimming.

You can drag from right to left, or left to right, and you can lasso single 
transitions across several contiguous tracks. However, avoid lassoing 
more than one transition from left to right on a single track because 
this activates Segment mode.

n To select transitions located below several track layers, draw a lasso 
within the Timeline by pressing and holding the Alt key (Windows) or the 
Option key (Macintosh) while you drag.

• Using the Go to Previous/Next Edit buttons. By default, the system 
selects the nearest transition in either direction of the selected track for 
dual-roller trimming. 

If the transition is a straight cut, the system selects all edited tracks. If 
the transition is an overlap edit with staggered transition points, the 
system selects the topmost track.

• Using the Play Loop button. This is useful if you like to trim quickly 
as you edit, going back and forth between Source and Trim mode. 

n The Play Loop button does not appear in Source/Record mode by default. 
You must map it to the keyboard or a palette in advance. For information 
on button mapping, see “User-selectable buttons:mapping” in the Help 
index.

Transitions are selected for dual-roller trim.

Lasso drawn across three tracks.
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Exiting Trim Mode

You can exit Trim mode at any time in one of several ways:

• Click the Trim Mode button at the bottom of the Timeline.

• Press the Esc (Escape) key on the keyboard to enter Source/Record 
mode by default.

• Click a specific location in the Timecode (TC1) track at the bottom of 
the Timeline to exit Trim mode. The position indicator moves to that 
location.

Switching Between Big and Small Trim Mode

When you click the Trim Mode button, by default, the system enters Big 
Trim mode. If you click the Trim Mode button again, the interface 
switches between Big and Small Trim mode. This feature has the 
following uses:

• If you prefer the display of Small Trim mode, but need quick access to 
the Playback Duration controls from time to time, you can perform 
most of your work in Small Trim mode. Whenever you need the 
controls, click the Trim Mode button. This saves you the extra step of 
opening the Trim Settings dialog box each time.

• If you prefer the larger monitors and controls of Big Trim mode, select 
this as the default. When you need to use the Monitor menus to switch 
between sequences, or have occasion to edit source material into the 
sequence, you can click the Trim Mode button to enable Small Trim 
mode, which includes the Source monitor controls.

Click in the TC track at a 
selected location.

The system exits Trim mode and 
relocates the position indicator.
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Selecting Between Trim Sides

There are three ways to select sides of a transition to trim:

• In Big or Small Trim mode, click the outgoing (A-side) or incoming 
(B-side) monitor to define which side of the transition to trim. The 
pointer changes to a single-roller A-side, single-roller B-side, or 
double-roller icon depending on position.

• You can also use the Trim-side keys on the default keyboard (or map 
them onto one of the monitor palettes while in Trim mode) to select the 
A-side, B-side, or both.

• You can use the Cycle Trim Sides button to cycle between selection of 
the A-side, B-side, or both.

The selected parts of the transition are highlighted, and the 
corresponding rollers appear in the Timeline. Also, one or both of the 
frame-counter indicators under the monitors are highlighted to reflect 
the active trim sides: A-side, B-side, or both. The number indicates 
how many frames have been added or subtracted (–) from the 
transition.

Performing a Basic Trim

With your transitions and trim sides selected, you can perform a basic trim 
using one of the following procedures:

t Use the Trim buttons to trim forward or backward by 1-frame or 
10-frame increments.

t Use the numeric keypad at the right side of the keyboard, as follows:

- To move the transition a specific number of frames, type a plus 
sign (+) or minus sign (–) and the number of frames (from 1 to 99) 
you want to move forward or backward. Then press the Enter key. 
If the number of frames is larger than 99, type an F after the 
number to indicate frame count. For example, to enter 200 frames, 
type 200F and press the Enter key.

A-side B-side A and B

A-side

A and B

B-side

Green light indicates

A-side B-side

play side.

1 frame 10 frames
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- To move the transition to an exact timecode, type a timecode 
number larger than 99, including frames. For example, type 102 to 
enter 1 second and 2 frames. 

t Use controls in the Timeline by clicking a roller at the selected 
transition and dragging it forward or backward in the sequence.

t For greater control:

- Press and hold the Alt key (Windows) or the Option key 
(Macintosh) as you drag the roller to move one frame at a time.

- Press and hold the Ctrl key (Windows) or the k key (Macintosh) 
to snap to other transition points.

As you trim, all selected transitions in the Timeline move in unison. The 
Frame counter displays the frame count backward or forward for one or 
both trim sides, and the monitors display the new incoming or outgoing 
frames.

Using the Command Palette

The Command palette provides a central location for all user-selectable 
buttons (USBs) that you can map to various locations for ease of use. User-
selectable buttons allow you to perform a wide range of commands with a 
single click.

Click a transition and drag it in the Timeline.
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The Command palette groups buttons by editing function. Tabs are 
displayed for each function and the buttons that perform those functions 
are displayed within each tab. The functions are: Move, Play, Edit, Trim, 
FX, 3D, Color Correction (CC), MCam, Other, and Workspace and 
Locator. See Figure 1 for Command palette tabs.

All buttons are displayed in the Command palette. If you cannot find a 
particular button, select Tools > Command palette and search for it there. 
For procedures on mapping user-selectable buttons and menu commands, 
see “User-selectable buttons:mapping” in the Help index.

Select To

‘Button to Button’ 
Reassignment

Map buttons to the Tool palette or any Command 
palette in a pop-up, Source, or Record monitor, and 
to reconfigure the keyboard.

‘Menu to Button’
Reassignment

Map menu commands to various buttons and keys.

Active Palette Use buttons directly from the Command palette 
without mapping them.
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Figure 1 Command Palette Tabs 

Move buttons

Play buttons

Edit buttons

Trim buttons

Effects (FX) buttons
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Figure 1 Command Palette Tabs (Continued)

3D buttons

MCam buttons

Other buttons

Workspace and
Locator buttons

Color Correction buttons
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Audio Editing

The Avid system provides audio scrub features and waveform plots 
specifically designed for frame-accurate cueing, marking, and editing of 
audio. You can use these features at any time during editing or while 
making adjustments with the audio tools.

Adjusting Volume

You can use the Audio Mix tool to adjust volume (level) and balance 
(pan).

Pan adjustment
Level adjustment
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Tutorial: Refining Edits

In this tutorial, you refine and trim edits and adjust audio levels. 

n If you need more information, be sure to read the preceding overview 
sections of this chapter before you start this tutorial.

1. If your Avid system is not already running, start it by double-clicking 
the Avid application icon.

2. Select your user name and your Boat Shop NTSC or Boat Shop PAL 
project and click OK.

3. From the Project window, double-click the Source Clips bin.

The clips are displayed in the bin.

Overwriting Clips into a Sequence

In addition to splicing, you can overwrite clips into a sequence. An 
overwrite edit replaces a section of a sequence with other source footage. 
An overwrite edit does not affect the length of the sequence.

The rowing forward clip is too long. In this section, you will edit the next 
clip into the sequence before the end of the rowing forward clip.

1. Make sure the Record monitor is active.

2. Place the position indicator in the Timeline on the first frame of 
rowing forward.

3. Advance 3 seconds by typing +229 (+224 PAL) on the numeric 
keypad and pressing the Enter key on the numeric keypad.

4. Mark an IN point.

 Mark IN point
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5. Open the dories passing clip. 

6. Mark an IN point in the first half of the clip, 18 frames (4 frames PAL) 
after the tips of the two boats seem to touch in the middle of the screen. 

7. Mark an OUT point a few frames less than 7 seconds later, when the 
girl’s oars are both out of the water, and her left oar just catches the 
light.

8. Click the red Overwrite button or press the B key on the keyboard.

The clip overwrites the end of the rowing forward clip and extends 
beyond it, thus lengthening the video portion of the sequence.

You should now be at about 19:20 into the sequence, with five video clips 
in it.

Storyboarding

Storyboarding allows you to set up a group of clips in a sequence of events 
and then load them into the Record monitor all at once.

In this section, you will mark a group of clips using the instructions in 
Table 1. The table provides a timecode to set the IN point, and based on the 
duration, you can use the numeric keypad to determine the OUT point. 

Marking Clips for Storyboarding

Use the following procedure to set your IN and OUT points for each clip in 
the table:

1. Load a clip listed in Table 1 into the Source monitor.
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2. Above the Source monitor, click the Timecode Display pop-up menu, 
and select V1.

You use the V1 numbers to go to the IN point.

3. Mark your IN point based on the Mark IN timecode in Table 1.

You might have set the IN and OUT points for these clips in the 
previous tutorial. Check them to see whether or not they need to be 
reset.

4. To set the OUT point, type the duration (from Table 1) on the numeric 
keypad and press the Enter key on the numeric keypad.

5. Mark the OUT point.

6. Continue marking IN and OUT points for the remaining clips — but 
do not edit the clips into the sequence yet.

Table 1 Mark Points for Tutorial Clips

Clip Name Mark IN Point Duration

draw knife cu 05:02:08:09 1:16 (NTSC)

1:13 (PAL)

chiseling 04:11:34:22 (NTSC)

04:11:36:21 (PAL)

00:16 (NTSC)

00:13 (PAL)
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hammering 04:05:10:08 1:00

drilling 04:04:47:25 (NTSC)

04:04:48:21 (PAL)

1:00

planing cu 04:10:05:17 (NTSC)

04:10:07:04 (PAL)

2:00

planing ms 04:09:24:00 (NTSC)

04:09:25:14 (PAL)

3:19 (NTSC)

3:16 (PAL)

sanding 04:06:52:03 3:12 (NTSC)

3:10 (PAL)

wood burning 04:14:24:02 6:15 (NTSC)

6:12 (PAL)

two dories 01:11:03:03 (NTSC)

01:11:04:10 (PAL)

1:22 (NTSC)

1:18 (PAL)

rowing in mist 01:02:38:29 1:22 (NTSC)

1:18 (PAL)

dories ws 01:06:38:26 4:00 

dories to models 04:25:22:28 3:23 (NTSC)

3:19 (PAL)

sign 05:06:52:01 (NTSC)

05:06:44:07 (PAL)

10:00 (NTSC)

10:00 (PAL)

Table 1 Mark Points for Tutorial Clips (Continued)

Clip Name Mark IN Point Duration
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Storyboard Editing the Clips

To add multiple clips into your sequence all at once:

1. Display the Source Clips bin in Frame view and click the 
Maximize button (Windows) or the Zoom button (Macintosh) so the 
bin fills the screen, or click the lower right corner of the bin and drag it 
to enlarge the window.

2. Select Bin > Fill Window to arrange the clips in the bin.

3. Click the draw knife cu clip and drag it to a clear space in the lower 
left area of the bin.

4. Arrange the following clips (after draw knife cu) in two or three rows, 
from left to right, and top to bottom, to form the storyboard. Make sure 
you maintain the order of clips:

- chiseling

- hammering

- drilling

- planing cu

- planing ms

- sanding

- wood burning

- two dories

- rowing in mist

- dories ws

- dories to models

- sign

Frame View
tab
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Now you’re ready to load the marked clips into the sequence.

5. Press and hold the Ctrl key (Windows) or the k key (Macintosh) 
while clicking in the Timeline near the end of the dories passing clip.

6. Click the V1 Record Track button and deselect the A1 Record Track 
button in the Timeline.

7. Select the storyboarded clips all at once:

a. Position the mouse pointer in the bin in the blank area just to the 
left of the draw knife cu clip. 

b. Lasso the clips by dragging the pointer to the right and down, 
making sure to select all of the storyboarded clips.

A box forms as you move the mouse, starting next to the draw 
knife cu clip and ending at the last pointer position. All the names 
are highlighted in pink.

8. Press and hold the Alt key (Windows) or the Option key (Macintosh), 
click one of the clips (on the image, not the name), and drag the group 
into the Record monitor. Release the mouse when a yellow arrow 
appears in the Record monitor. 

The clips are spliced into the sequence in the order you specified. 

9. To play the sequence: 

a. Move the position indicator to the head of the sequence. 

b. Activate the Speaker icons for tracks A1 and A2 by clicking the 
A1 and A2 Record Track Monitor buttons (only one Record Track 
Monitor button can be activated at a time).

Track A2 contains sound for several clips.

c. Click the Play button under the Record monitor.

b

Audio
Track
Monitor
buttons
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Rearranging Clips

You can rearrange clips by overwriting material, lifting material, or 
removing material. Overwriting material doesn’t change the length of the 
sequence. Lifting material leaves filler and doesn’t affect the length of the 
sequence. Removing material shortens the length of the sequence.

Overwriting with the Three-Point Edit

The three-point edit is an excellent way to replace a clip in a sequence. Use 
the Mark Clip button to select the clip in the sequence (or mark an IN and 
OUT point for a segment that’s not a single clip), and mark either the IN or 
OUT point in the source clip. The system calculates the exact duration of 
the source clip to insert.

Let’s replace the chiseling clip with draw knife ms to create a smoother 
movement across the cut.

1. To enlarge this area, in the Timeline:

a. Press the Home key.

b. Click the scale bar and drag it to enlarge the Timeline.

The Timeline wraps onto another line, displaying multiple 
Timelines.

c. Click the scroll bar and drag it to the right until you see the entire 
chiseling clip.

The Timeline splits in half (or thirds) as it wraps through the 
sequence.

2. Move the position indicator to the chiseling clip.

3. Select only record tracks V1 and A2.

4. Click the Mark Clip button in the row of buttons under the Record 
monitor, or press the T key on the keyboard.

The IN and OUT points appear at the head and tail of the clip in the 
TC1 track of the Timeline; the marked segment changes to 
purple. 
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The IN and OUT points also appear in the Record monitor’s position 
bar.

5. Open the draw knife ms clip in the Source monitor and mark an IN 
point around 2.5 seconds (7.5 seconds for PAL) into the clip, when the 
boatbuilder’s motions become smooth.

6. Clear any OUT marks.

7. Click the red Overwrite button or press the B key on the keyboard to 
make the three-point edit.

The clip draw knife ms replaces the chiseling clip.

8. Return to the previous Timeline view by doing the following:

a. Click the scale bar and drag it to the left.

b. Move the position indicator in the Record monitor to the head of 
the sequence.

Changing the Order of Clips in a Sequence

Extract/Splice-in is a great tool for changing the order of clips in a 
sequence. Let’s see what it looks like if we reverse the position of two clips 
in the sequence, rowing in mist and two dories.

1. Expand the Timeline again, using the scale bar. Click the scale bar and 
drag it toward the end of the sequence until you reach the rowing in 
mist clip.

2. Click the yellow Segment Mode (Extract/Splice-in) button under the 
Timeline.

When the button is activated, its background changes to light gray.

c Don’t confuse the Extract/Splice-in and Splice-in buttons. The 
Extract/Splice-in button is located under the Timeline; the Splice-in 
button is located on the keyboard and between the Source and Record 
monitors (see “Distinguishing Between Two Types of Editing Buttons” 
on page 134).

3. Select only track V1. Deselect all audio tracks.
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4. Press and hold the Alt key (Windows) or the k key (Macintosh), click 
the rowing in mist clip, drag it to the left (so it is completely over the 
two dories clip), and release the mouse. 

Two dories should now follow rowing in mist.

5. Click the Extract/Splice-in button again to deselect it.

6. Click the Timeline in front of the two clips and play the clips. 

The edit works.

Removing Footage from a Sequence

You can remove footage from your sequence, and either close or retain the 
gap that results. Extract/Splice-in closes the gap, and Lift retains the gap.

Removing Footage and Closing the Resulting Gap

The planing ms clip breaks up the feeling of being close to the action. 
Let’s remove it from the sequence and close the gap that results.

1. Use the scroll bar to locate the planing ms clip.

2. Click the yellow Segment Mode (Extract/Splice-in) button under the 
Timeline.

To eliminate footage 
that does not start and 
end at a transition, use 
IN and OUT points to 
delimit the segment 
that you want to 
extract. 

3. Click anywhere in the planing ms clip on V1, then Shift+click the 
audio portion of the clip in track A2.

The clip is highlighted in both tracks.

4. Press the Delete key on the keyboard.

The selected clip is eliminated and the surrounding clips close the gap.

5. Click the Extract/Splice-in button again to deselect it.
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Removing Footage and Retaining the Resulting Gap

Lift retains the gap after lifting footage from the sequence. Use Lift if you 
want to maintain the rhythm of a sequence or the synchronization of the 
video and audio tracks.

The dories passing clip plays for too long, but we want the next clip, draw 
knife cu, to remain in sync with the audio. We will use Lift to shorten 
dories passing, but will maintain the same entrance point for the next clip. 
Later, we’ll determine what to put in its place.

1. Display the master timecode in the Record monitor’s timecode display 
by clicking the Timecode pop-up menu, and selecting Mas.

2. Deselect the A2 Record Track button.

3. Mark an IN point in the sequence at master timecode 01:00:17:29 
(01:00:17:24 PAL) by using the Mark IN button below the Record 
monitor. 

4. Go to the last frame of the dories passing segment by placing the 
position indicator in the next clip beyond dories passing. Press and 
hold Ctrl+Alt (Windows) or k+Option (Macintosh) and click the 
mouse.

5. Mark an OUT point.

You must mark an IN and OUT point in the sequence.

6. Click the Lift button or press the Lift key (Z) on the keyboard to 
remove the segment.

The selected segment lifts out and leaves black filler in its place.

7. Play the entire sequence in the Record monitor.
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Trimming

Trimming allows you to adjust incoming and outgoing frames of your clip. 
There are two types of trims: dual-roller and single-roller.

Adjusting Both Sides of a Transition (Dual-Roller Trimming)

Use a dual-roller trim to adjust both sides of a transition simultaneously, 
adding frames to one clip while subtracting frames from the adjacent clip. 
The total duration of the sequence does not change.

Let’s cut the kids in shadow clip right on the beat of the music. 

1. Click the V1 Record Track button and deselect the Audio Tracks 
buttons. Make sure the A1 Audio Track Monitor button is 
activated.

2. Place the position indicator near the ducks/kids in shadow transition, 
and click the Trim Mode button under the Timeline.

The position indicator snaps to the transition.

The Record monitor shows the last (tail) frame of the ducks clip on the 
left, and the Source monitor shows the first (head) frame of the kids in 
shadow clip on the right.

 

Trim
transition
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New buttons appear below the trim windows. During dual-roller trim 
mode, both frame counters are purple.

n To see the second row of buttons, click the Settings tab in the Project 
window, then select Composer. In the Composer Settings dialog box, click 
the Second Row of Buttons option, and then click OK.

3. Play the transition by clicking the Play Loop button.

If this button does not appear:

a. Select Tools > Command palette.

b. Click the Play tab.

c. Select Active Palette at the bottom of the tab.

d. Click the Play Loop button.

The transition plays repeatedly.

4. To stop the playback loop, click the Play Loop button again.

Transition Effect
palette

Outgoing video Incoming video

Frame
counters

Trim Frame 

buttonPlay Loop

buttons
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5. Press the Caps Lock key on the keyboard so you can hear the audio as 
you trim. 

To use digital audio scrub, make sure the Speaker icon on the Audio 
Track Monitor button is gold. Also, increase the speaker volume, if 
necessary. 

If the Speaker icon is not gold, press and hold the Alt key (Windows) 
or the Option key (Macintosh), and click the A1 Audio Track Monitor 
button.

6. Click the Trim Right 1 Frame button under the Source monitor until 
you hear a change in loudness around the seventh frame (third frame 
PAL).

This adds frames to the tail of the outgoing clip and removes them 
from the head of the incoming one. The duration of the video track 
remains unchanged.

7. Play the transition again using the Play Loop button.

8. Do one of the following to exit Trim mode:

t Click the Trim Mode button in the Tool palette.

t Press the Left Arrow key on the keyboard.

Using Dual Rollers to Trim the Outgoing Clip

Let’s insert a clip to take the place of the filler we left in the sequence. You 
replace the filler with pan lumber because this clip provides continuity of 
movement from the previous clip. Once you overwrite the clip into the 
sequence, you trim it.

1. Place the position indicator within the filler between the dories 
passing and the draw knife cu clips.

2. Select record tracks V1 and A2 in the Timeline, and deselect A1.

Gold 
Speaker 
icon

Trim Right
10 Frames

Trim Right
1 Frame

Trim Left
1 Frame

Trim Left 
10 Frames
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3. Click the Mark Clip button under the Record monitor or press the 
T key on the keyboard.

4. Open the pan lumber clip and mark an OUT point where the lumber is 
in sunlight and the camera stops panning. Do not mark an IN point.

5. Select record tracks V1 and A2.

6. Click the red Overwrite button between the Record monitor and 
Source monitor.

c Don’t confuse the Lift/Overwrite and Overwrite buttons. The 
Lift/Overwrite button is located under the Timeline; the Overwrite 
button is located on the keyboard and between the Source and Record 
monitors.

Trimming the pan lumber Clip

In the next steps, you will trim the pan lumber clip so it enters a little 
earlier.

1. Enter Trim mode by lassoing the Timeline tracks: 

a. Click the pointer above all the Timeline tracks just to the left of the 
dories passing/pan lumber transition. 

b. Drag the mouse down and to the right to surround the
transition.

The trim rollers appear.

2. Move the transition 74 frames earlier by clicking the Trim
Left 10 Frames button 7 times and the Trim Left 1 Frame button 
4 times.

You see the numbers change in the purple frame counters.

Trim rollers
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Single-Roller Trimming

In the trims you made so far, you trimmed both the head and the tail clips 
an equal number of frames, adding to one side and subtracting from the 
other. Now let’s trim the tail of the pan lumber clip without affecting the 
head of the draw knife cu clip.

1. While still in Trim mode, advance to the pan lumber / draw knife cu 
transition by pressing the S key on the keyboard.

2. Click the A2 Record Track button in addition to the V1 Record Track 
button because you will trim both the audio and video of the clip.

3. Click the left frame counter (A-Side Trim counter).

Your trim will only affect the outgoing clip, which is in the left Trim 
monitor. The left frame counter remains purple, while the right one is 
deselected.

4. Type –10 and press the Enter key on the numeric keypad to subtract 
10 frames from the outgoing clip.

This moves the transition 10 frames to the left.

5. Exit Trim mode by pressing the Left Arrow key on the keyboard or by 
clicking the Source/Record Mode button under the Timeline.

Adding Synced Audio

Now we’ll add some synced audio to the sequence.

1. Open the intervu: Lowell’s Boat Shop clip.

Be sure the volume on the speakers is turned up.

2. Mark the IN point at the start of the first phrase, “Lowell’s Boat Shop 
isn’t quite the same as it always has been...” and mark the OUT point 
at the end of the last phrase, “...a great symbol of New England.”

3. Press the Play IN to OUT (6) key on the keyboard to play the clip from 
the IN to OUT points. 

The audio is on track A1 in the source clip, but we want to add it to the 
end of track A2 in the Timeline. 

First we’ll patch from source track A1 to record track A2.

Left frame
counter
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4. To patch the track, quickly drag the pointer from the A1 Source Track 
button to the A2 Record Track button.

 

5. Display the master timecode (Mas) in the timecode display above the 
Record monitor.

6. In the sequence, place the Mark IN point at master timecode 
01:00:41:00 (01:00:40:25 PAL), in the middle of the dories ws clip. 

7. Make sure the A1 Source Track button and V1 and A2 Record Track 
buttons are selected. 

8. Click the yellow Splice-in button between the Source and Record 
monitors.

The audio is patched into the sequence.

Working with Audio

In this section, you adjust audio levels to the already placed intervu: 
Lowell’s Boat Shop clip.

Adjusting Audio Level

The volume in the intervu: Lowell’s Boat Shop clip is noticeably lower 
than in the rest of the sequence. Let’s make this clip louder.

1. Click the A2 Record Track button and deselect the A1 Record Track 
button.

2. Place the position indicator anywhere within the intervu: Lowell’s 
Boat Shop clip.

3. Select Tools > Audio Mix.

Patching A1 source
to A2 record.
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4. In the A2 area, move the A2 Audio Level slider to level +6 by doing 
one of the following:

t Click the slider and drag it to level +6.

t Type 6.

t Press the Up Arrow or Down Arrow key on the keyboard to reach 
level +6.

5. Play a portion of the clip.

The volume is still too low.

6. Activate the Audio Mix tool by clicking in it, and move the slider to 
level +10.

Adjusting Audio Pan (Balance)

Most of the audio for the sequence plays only out of the left speaker; the 
intervu: Lowell’s Boat Shop clip plays only out of the right speaker. You 
can adjust the audio pan (balance) so the sound plays equally from both 
speakers.

1. Clear any IN or OUT points from the sequence by pressing the G key 
on the keyboard.

2. Select record tracks A1 and A2.

Level slider

 
Type a number.
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3. Activate the Audio Mix tool by clicking anywhere in it.

4. Click the Timeline’s position indicator at a point that has audio on 
track A1.

5. From the Audio Mix tool in the first Pan Adjustment window, click the 
Track Selection pop-up menu, and select A1.

6. Open the Pan Adjustment window for track A1.

The Pan slider appears.

7. Drag the Pan slider to the middle of the scale until it reads MID.

To snap the slider to 
MID, press and hold 
the Alt key (Windows) 
or the Option key 
(Macintosh), and click 
the Pan slider.

8. Open the Pan Adjustment window for track A2 and click the Pan slider 
and drag it until it reads MID.

9. Play a portion of the sequence to check the speaker balance.

10. Click the Close button to close the Audio Mix tool.

11. Play your sequence through and save it.

You’ve finished this tutorial. You can go on to “Tutorial: Adding Effects” 
on page 169, or quit the Avid system.

Drag the Pan slider.

Click here
to open the

Pan Adjustment
window.

Select A1.

Close button
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Chapter 8

Adding Effects

Adding effects to a clip enhances your sequence by fading in or out of a 
scene or adding video or a graphic on top of a clip. 

Adding effects is described in the following sections:

• Effects Editing

• Displaying the Effect Palette

• Effect Categories

• Effect Types

• Applying Effects to a Sequence

• Working in Effect Mode

• Rendering an Effect

Tutorial: Adding Effects contains the following sections:

• Adding Transition Effects

• Adding a Picture-in-Picture Effect

• Screening the Sequence
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Effects Editing

The Avid system offers many effects you can apply to your sequences. 
You can also use third-party plug-in effects that are compatible with Adobe 
Photoshop®. The effects that are available on your Avid system depend on 
the model and options you purchased. For the list of effects available for 
your model, see the appropriate release notes.

This chapter explains how to apply effects to transitions or segments (clips) 
in your sequence. After you have selected the effect and have applied it to a 
transition or segment, you can adjust the effect parameters to meet your 
requirements.

Many effects are real time, which means you do not have to render them 
before you play them. You can preview effects that are not real time before 
rendering. Rendering an effect creates a media file that plays with the 
sequence.

After you create an effect, you can save it as an effect template and reapply 
the template to other transitions or segments in your sequence. Some 
effects can be applied only to transitions, other effects can be applied only 
to segments, and some effects can be applied to both transitions and 
segments. In addition, some effects can be applied to a single video layer, 
and others to multiple video layers.

For an explanation of particular effects and the effect parameters, see the 
appropriate effects guide.
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Displaying the Effect Palette

You select most effects from Tools > Effect Palette. The exceptions are 
motion effects that you access from the Fast menu above the Source 
monitor, the Freeze Frame effect that you access from the Clip menu, and 
titles that you create with the Title tool.

Effect Categories

The effects available through the Effect Palette are grouped by effect 
category:

• Blend

• Box Wipe

• Conceal

• Edge Wipe

• Film

• Image

• Key

• L-Conceal

• Matrix Wipe

• Peel

• Push
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• Sawtooth Wipe

• Shape Wipe

• Spin

• Squeeze

Each of these effect categories contains multiple effects.

Effect Types

There are two primary effect types that are defined by where you use them 
in a sequence:

• Transition effects

• Segment effects (single-layer and multilayer)

Transition Effects

A transition is the point where two clips meet. You apply a transition effect 
to the cut point between two clips on the same video track. After you apply 
a transition effect, you can adjust its relative position and duration. 
Depending on the specific effect, other effect parameters might apply.

Transition effects are included in all effect categories on the Effect 
Palette, except the Image effect category.

For an explanation of the transition effects in each effect category, see the 
appropriate effects guide.
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Segment Effects

You apply a segment effect to an entire clip or a group of clips. There are 
two types of segment effects:

• A single-layer segment effect, such as a mask, is applied to a segment 
on one video track.

• A multilayer segment effect, such as a Picture-in-Picture effect, is 
applied to the top layer of segments that contain two or more video 
tracks that will be played simultaneously.

All of the Avid effects and their effect types are listed in the appropriate 
effects guide.

Applying Effects to a Sequence

This section explains how to apply an effect to a sequence in the Record 
monitor. You can apply an effect:

• To one transition or segment on a single video layer

• To multiple transitions or segments on a single video layer

• To multiple transitions or segments on multiple video layers

The effect type (transition or segment) determines where you can place the 
effect in the sequence. For an explanation of the effect types, see 
“Effects:types of” in the Help index.

After you apply an effect, the next step is to adjust the effect’s parameters. 
To understand how to adjust the effect’s parameters, see “Effect 
Mode:adjusting parameters in” in the Help index.
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Working in Effect Mode

After you have created an effect and have applied it to a transition or 
segment in your sequence, you can adjust its appearance and operation by 
changing its effect parameters in Effect mode. 

Not all effect parameters apply to all effects. Parameters that do not apply 
to an effect are disabled in the Effect Editor window. To determine which 
parameters pertain to an effect, see the effect’s description in the 
appropriate effects guide.

Rendering an Effect

You must render a non-real-time effect before it can be played. When an 
effect is rendered, the system stores the effect and its media file as a 
precomputed master clip (often referred to as a precompute). The system 
uses the precompute to play the effect at its normal speed.
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Tutorial: Adding Effects

In this tutorial, you add dissolves and a Picture-in-Picture effect. 

n If you need more information, be sure to read the preceding overview 
sections of this chapter before you start this tutorial.

1. If your Avid system is not already running, start it by double-clicking 
the Avid application icon.

2. Select your user name and your Boat Shop NTSC or Boat Shop PAL 
project and click OK.

3. From the Project window, double-click the Source Clips bin.

The clips are displayed in the bin.

Adding Transition Effects

Transition effects are added in between two clips. Effects you can use 
include: Blend, Box Wipe, Conceal, Edge Wipe, Film, Image, Key, 
L-Conceal, Matrix Wipe, Peel, Push, Sawtooth Wipe, Shape Wipe, Spin, 
and Squeeze.

Displaying Editing Buttons

Before you add effects to the tutorial sequence, you need access to some 
effects editing buttons.

1. Click the Settings tab in the Project window.

2. Double-click Composer Settings.

The Composer Settings dialog box opens.

3. Click the Window tab.
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4. Make sure the Second Row of Buttons option is selected.

5. Click OK.

A second row of buttons appears under the Source and Record 
monitors. 

Adding a Dissolve Effect (Fade-In)

Now we’ll add a Dissolve effect (fade-in) to a transition.

1. If you don’t see any video in the Record monitor, click the box to the 
right of V1 so a square (tiny monitor) appears. 

The video appears in the Record monitor.

2. Click the V1 Record Track button and then click the head of the 
sequence.

3. Click the Quick Transition button in the Tool palette.

Second Row of
Buttons option
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The Quick Transition dialog box opens.

4. Create a 20-frame dissolve (fade-in), starting at the cut, by doing the 
following:

a. Click the Add pop-up menu, and select Dissolve.

b. Type 20 in the Duration text box.

c. Click the Position pop-up menu, and select Starting at Cut.

5. Click the Target Drive pop-up menu, and select the drive on which the 
effect media file should be stored.

The default drive is Effect Source Drive.

n Make sure the Skip Real-Time Effects check box is not selected.

6. Click the Add and Render button to render the effect.

The system creates the media file of the video effect during the 
rendering process. It also places a Rendered icon in the Timeline 
where you added the effect.

7. Play the effect. Press the space bar to stop playback.
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Dissolving Between Clips

You can create a nice effect by adding a dissolve between the first two 
clips of the sequence.

1. Click the V1 Record Track button and then click the first frame of the 
ducks clip.

2. Click the Quick Transition button in the Tool palette. 

The Quick Transition dialog box opens.

3. Create a 20-frame dissolve, centered on the cut, by doing the 
following:

a. Click the Add pop-up menu, and select Dissolve.

b. Type 20 in the Duration text box.

c. Click the Position pop-up menu, and select Centered on Cut.

4. Click the Target Drive pop-up menu, and select the drive on which the 
effect media file should be stored.

The default drive is Effect Source Drive.

5. Click the Add and Render button to render the effect.

6. Play the effect. Press the space bar to stop playback.

Creating a Series of Dissolves

After you create one dissolve, you can quickly add it to other transitions in 
a sequence. In this section, you add a series of dissolves in the middle of 
the sequence to smooth the transition between several short clips.

1. Place the position indicator at the transition between dories 
passing and pan lumber.

2. Create a 10-frame dissolve, centered on the cut.

3. Repeat steps 1 and 2 for all transitions through sanding/wood 
burning.

If you can’t see the clips in the Timeline, use the scale bar to expand 
the Timeline.
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n You do not have to change any dissolve parameters when you make these 
dissolves.

4. Play the sequence through to see your work.

Creating Audio Dissolves

It’s just as easy to add audio dissolves, and the procedure is the same as 
adding video dissolves.

As an exercise, create audio dissolves for every audio transition on track 
A2 up through sanding/wood burning, except the beginning and the end 
of the sequence.

Use 10-frame dissolves, centered on the cut. Be sure to click the A2 
Record Track button and deselect the other Track buttons.

Adding a Fade-to-Black Effect Within the Sequence

Now we’ll create a fade-to-black effect within the sequence after the 
dories passing clip, to cut more forcefully on the words, “wooden boat 
building.” The transition already has a 10-frame dissolve.

1. Place the position indicator on the last frame of the dories passing 
clip.

2. Click the V1 Record Track button only.

3. Click the Remove Effect button in the Fast menu.

The dissolve is removed from the transition.

4. Without moving the position indicator, mark both an IN and an OUT 
point on that frame.

n Use the Mark IN and Mark OUT buttons, not the Mark Clip button.

5. Click the red Segment Mode (Lift/Overwrite) button under the 
Timeline.
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6. Press Ctrl+X (Windows) or k+X (Macintosh).

A single frame is lifted from the sequence, leaving one frame of black 
filler.

7. Click the Lift/Overwrite button again to deselect it.

8. Add a 20-frame dissolve, ending at the cut.

9. Click the Target Drive pop-up menu, and select the drive on which the 
effect media file should be stored.

10. Click the Add and Render button to add and render the dissolve.

Adding a Picture-in-Picture Effect

We’ll make one final change to increase the impact of the last part of the 
sequence. Using a Picture-in-Picture effect, you’ll squeeze the image of 
the boat shop owner into the lower left corner of the screen, and lay some 
other images behind him.

Using the Second Video Track 

This effect takes up two video tracks: V1 for the clips of boats and boating 
and V2 for the interview. First, you have to move the interview clip from 
track V1 to V2.

1. Click the V1 Record Track button only.

2. On the V1 track, place the position indicator within the intervu: 
Lowell’s Boat Shop clip in the Timeline and click the Mark Clip 
button under the Record monitor.

The intervu: Lowell’s Boat Shop clip is highlighted.

3. To add a new video track, select Clip > New Video Track.

4. Click the red Segment Mode (Lift/Overwrite) button under the 
Timeline.

5. Press and hold the Ctrl key, click the intervu: Lowell’s Boat Shop 
clip, and drag it to the track above (V2). 

The clip opens on track V2.
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6. Click the Lift/Overwrite button again to deselect it.

7. Click the V2 Record Track button and the V2 Video Track Monitor 
button.

Creating the Picture-in-Picture Effect

To create the Picture-in-Picture effect:

1. Click the V2 Record Track button and the V2 Video Track Monitor 
button.

2. Select Tools > Effect Palette.

The Blend effects, including the Picture-in-Picture effect, are 
displayed in the right window.

3. Place the position indicator anywhere in the intervu: Lowell’s Boat 
Shop clip on track V2.

4. Click the Picture-In-Picture Effect icon from the Effect Palette and 
drag it to the intervu: Lowell’s Boat Shop clip on track V2.

The Effect icon appears in the Timeline.
Effect icon

Effect icon
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The boat shop owner appears in a box midscreen.

Repositioning the Image

Let’s move the image to the lower left corner of the screen.

1. In the Timeline, move the position indicator directly over the Effect 
icon.

2. Click the Effect Mode button in the Tool palette to enter Effect mode.

Parameters for the Picture-in-Picture effect appear in the Effect Editor.

3. Click the image of the boat shop owner. Drag handles (the dots at the 
edges and in the middle of the box) appear, and a white hand appears 
when the pointer is over a handle.

4. Click the drag handle in the middle of the picture and drag the image to 
the lower left corner of the screen.

Foreground Background
filler (V1)image (V2)
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Adjusting a Parameter

Now let’s use one of the Picture-in-Picture effect parameters to soften the 
edge of the image.

1. Click the Soft slider in the Effect Editor.

You can also type 30 
on the numeric keypad.

2. Drag the Soft slider to the right to a value of 30.

3. Click the Play Preview button in the Effect Editor to view an outline of 
the effect.

You can click the mouse button or press the space bar at any time to 
stop the preview.

Adding Keyframes

To add dissolves within the Picture-in-Picture effect, you need to add 
keyframes. These let the system know this is the location in the 
Picture-in-Picture effect where you want to start the dissolve.

To add keyframes:

1. Click the V1 Record Track button.

2. Click the first keyframe in the Record monitor.

3. Click the Level slider and drag it all the way to the left to display 0.

Soft slider

Add Keyframe
button

Play Preview button
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4. Click in the Record monitor, then type +1:00 on the numeric keypad. 
Press Enter on the numeric keypad to move the position indicator 1 
second after the first keyframe.

5. Click the Add Keyframe button in the Effect Editor.

6. Click the Level slider and drag it all the way to the right to display 100.

7. Click the mouse button on the last keyframe.

8. Click the Level slider and drag it all the way to the left to display 0.

9. Click in the Record monitor, then type –15 on the numeric keypad. 
Press Enter on the numeric keypad to move the position indicator 15 
frames before the last keyframe.

10. Click the Add Keyframe button.

11. Click the Level slider and drag it all the way to the right to display 100.

12. Click the Close button to close the Effect Editor.

Adding Background Images

In this section you add a background image on track V1, below the 
intervu: Lowell’s Boat Shop clip.

1. Click the V1 Record Track button and the V1 Video Track Monitor 
button. Deselect the V2 Record Track button.

2. Place the position indicator in the filler just above and below the 
intervu: Lowell’s Boat Shop clip in the V1 track.

3. Click the yellow Segment Mode (Extract/Splice-in) button under the 
Timeline.

4. Press Ctrl+X (Windows) or k+X (Macintosh).

This removes the filler and adds the three clips at the end of the 
sequence as your background for the Picture-in-Picture effect.

5. Click the V2 Record Track button.

Last keyframeFirst keyframe
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6. Click the dories to model and Shift+click the sign clips on the A2 
audio track.

7. Press Ctrl+X (Windows) or k+X (Macintosh) to delete the excess 
audio.

8. Click the Extract/Splice-in button again to deselect it.

9. Play your sequence.

Rendering the Effect

You must render the Picture-in-Picture effect to play it at full speed.

1. Place the position indicator on the Effect icon in the 
intervu: Lowell’s Boat Shop clip.

2. Click the V2 Record Track button.

3. Click the Render Effect button in the Fast menu under the Record 
monitor.

The Render Effect dialog box opens.

4. Click the Drive pop-up menu, and select a target drive for the rendered 
media. 

The Effect Source Drive is the default drive for storing the rendered 
effect.

5. Click OK.

6. After the effect is rendered, close the Effect Palette.

7. To save your work, select File > Save All Bins.
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n You can have the system notify you when rendering is complete. This is 
helpful when rendering multiple effects. You have two Render Completion 
Sounds to select from: Avid Sound or System Beep. Enable the Render 
Completion Sound option in the Render Settings window.

Screening the Sequence

You’ve done a lot of work. Now take a look at the sequence.

1. Move the position indicator to the beginning of the sequence.

2. Click the V2 Video Track Monitor button.

3. Click the Play button. 

You’ve finished this tutorial. You can go on to “Tutorial: Creating Titles” 
on page 189, or quit the Avid system.
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Creating Titles

You can create a new title with the Title tool and save the title in a bin, or 
add a new video track to the Timeline if you want the title to appear over 
video. 

Creating titles is described in the following sections:

• Creating New Titles

• Understanding the Title Tool

• Working with Text

• Text Formatting Tools

• Selecting Colors and Setting Transparency

• Editing a Title into a Sequence

Tutorial: Creating Titles contains the following sections:

• Adding a Title

• Saving a Title

• Editing the Title into the Sequence

• Adding Rolling Credits

• Closing the Title Tool
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Creating New Titles

You can create a new title with or without a sequence in the Timeline. 
However, if you want to create a title with a video background, you can 
load a video clip into the Record monitor to use as a video reference frame 
while you create the title. The video reference frame you select appears in 
the background of the Title tool while you create the title. The video 
reference frame makes it easier to position text and objects exactly where 
you want them and to select colors from the frame to use in the text and 
objects.

Because the Avid system automatically loads the new title into the Source 
monitor, you can immediately use the standard editing procedures to edit 
the title into your sequence. If you create multiple titles in the same Title 
tool session, the system loads the last title you create into the Source 
monitor.

n After you create a title with a particular video format (PAL or NTSC), if 
you want to create a title for a project that uses the other video format, you 
must shut down and restart the Avid system.

The Avid system saves into a bin each title you create. You can load a title 
into the Source monitor at any time or click the Title Effect icon and drag it 
from the bin to a segment in the Timeline. You can also click a title and 
drag it from the bin onto an existing title in the Timeline; this causes the 
existing title to be replaced. 

n The procedures described in this section use a video reference frame to 
create a title.
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Understanding the Title Tool

The Title tool has several major components: 

• The toolbar at the bottom of the screen

• A video or color background

• The title that you create

For more information, 
see “Safe Title/Action 
Area” in the Help 
index.

• The safe title and safe action area guidelines. 

The following illustration shows a title over a video background.

Toolbar

Safe action
area

Safe title
area

Title

Video
background
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Working with Text

By default, the Text tool is active when you open the Title tool. Click in 
the window at the position where you want to begin entering text.

To use the Text tool at any other time, click the Text Tool icon, click 
anywhere within the title frame, and begin typing. A blinking vertical bar 
indicates your cursor position in the frame.

The Text tool remains selected until you select another tool.

Text Formatting Tools

The text formatting tools control the appearance of text. If a text object is 
selected when you change an attribute, the Avid system automatically 
applies the attribute to the object.

Text tool

Text formatting tools
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The text formatting tools allow you to change the following text 
characteristics: 

• Current font

• Bold and italic

• Point size 

• Justification 

• Kerning

• Leading

This section describes how to change these characteristics on a text-string 
basis. You can also change these attributes on a character-by-character 
basis by editing the text string. 

For more information, 
see “Title tool:working 
with” in the Help 
index.

You can also modify the following text attributes on a text-string basis:

• Color

• Transparency

• Drop and depth shadows

• Outlines surrounding text

While you type text, only the text color is apparent. Shadows, outlines, and 
other color attributes appear when you finish typing the text and click the 
Selection tool.

n If you have multiple text elements in a title, and you want to give each 
element a different appearance, create separate text strings.
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Selecting Colors and Setting Transparency

You can select the color and transparency for objects, shadows, and 
borders.

The following illustration shows the boxes associated with color and 
transparency:

• The Color selection boxes control the fill (Fill), shadow (Shad), and 
border (Bord) color selection.

• The Transparency selection boxes control the fill, shadow, and border 
transparency selection.

• The Blend and Transparency preview windows open when you select 
the fill, border color, or border transparency selection box.

If you select a Color selection box, the top windows show the two 
colors that are used to create the blend. The bottom window shows the 
blended color and allows you to control the direction of the blend.

If you select a Transparency selection box, the top windows show the 
two transparency values that are used to create the blend. The bottom 
window allows you to control the direction of the transparency blend.

Blend and Transparency preview

Transparency selectionColor selection
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Adjusting the Color

To select a color for the title, use an eyedropper to select a color from any 
running application on your computer, or use the Windows Color dialog 
box or the Macintosh Color Picker to select a color. All of these features 
are available through the Title Tool Color Picker.

The Title Tool Color Picker allows you to select object, shadow, or outline 
color. The box you use controls whether the color applies to an object, 
creates a colored shadow, or places a colored outline around the selected 
object.

Color selection bar

Shade selection palette

Original Color window

New Color window

Grayscale
selection bar

Eyedropper

Click to open the 
Windows Color dialog box.

Windows

Color selection bar

Shade selection palette

Original Color window

New Color window

Grayscale
selection bar

Eyedropper

Click to open the 
Macintosh Color 
Picker.

Macintosh
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Editing a Title into a Sequence

After you have created a title with the Title tool, you can use one of the 
following two methods to edit the title into your sequence:

t Method 1: Add a new video track, load the title into the Source 
monitor, mark an IN point and an OUT point, and splice or overwrite 
the title into the sequence.

t Method 2: In Segment mode, click the Title Effect clip and drag it from 
the bin to an existing segment in the Timeline between the edit points.

You edit titles into a sequence using the same editing procedures you use 
for video. The only difference is that if you want to key the title over video, 
you must add a new video track.
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Tutorial: Creating Titles

In this tutorial, you create a title, and edit and add a rolling credit to the end 
of the sequence. 

n If you need more information, be sure to read the preceding overview 
sections of this chapter before you start this tutorial.

1. If your Avid system is not already running, start it by double-clicking 
the Avid application icon.

2. Select your user name and your Boat Shop NTSC or Boat Shop PAL 
project and click OK.

3. From the Project window, double-click the Source Clips bin.

The clips are displayed in the bin.

Adding a Title

Once you create and add a title to your sequence, you can reposition it, 
change the text color, adjust the font and point size, add a shadow or 
border, adjust levels and kerning, and make it bold or italicize it. 

Creating a New Title

To create a new title:

1. In the Timeline, place the blue position indicator on the bridge clip in 
the sequence.

2. Select Clip > New Title.

The Title tool opens.

3. Click the Text Tool button. If it is already selected on the toolbar, the 
pointer changes to an I-beam when you click in the Title tool.

4. Click in the water below the bridge.

A blinking insertion point appears.
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5. Type The Dory.

6. Click the Selection Tool button on the toolbar.

Object selection handles surround the title.

7. Click the Point Size pop-up menu, and select 72.

8. Click the Font pop-up menu, and select Palatino.

9. Click the B button for bold if it’s not already selected.

n You might want to click the right side of the text selection box and drag it 
to eliminate any unused space, especially if you want to use the Alignment 
menu commands. To drag the right side, click the middle handle on the 
right side of the text selection box, and drag it to the left until it is closer to 
the text.

Selection
tool

Font
Point size

Fill box Shadow Depth text boxBold
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Repositioning Text
Alt+click (Windows) 
or Option+click 
(Macintosh) anywhere 
in the Title tool to 
switch between the 
Selection tool and the 
Text tool.

To reposition the title text:

1. With the Selection tool selected, click the title and drag it so it appears 
across the water.

2. Use the arrow keys to move the title more precisely.

Changing Color
To change the color of the title text:

1. Click and hold the Fill box. 

The Title Tool Color Picker opens.

2. Click a blue color.

The color is applied to the title.

Adding a Shadow
To add a shadow to the title text, do one of the following:

t Type a value in the Shadow Depth text box.

t Click the Shadow icon and drag it in the direction you want the 
shadow to fall.

Saving a Title

To save your title:

1. Select File > Save Title.

The Save Title dialog box opens.

2. Type The Dory in the Title Name text box.

3. Select the Source Clips bin and a target drive to store your title.

4. Click Save.

The title appears in the Source Clips bin.

5. Click the Close button to close the Title tool. 
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Editing the Title into the Sequence

To add your title to your sequence:

1. Double-click the title in the bin.

The title opens in a Source pop-up monitor.

2. Click the V2 Video Track Monitor button to activate it and deselect the 
V1, A1, and A2 Track Monitor buttons.

3. Click the V1 Source Track button and drag it to the V2 Record Track 
button.

4. With the title clip loaded in the Source monitor, set an IN point at the 
beginning of the clip and an OUT point at 1:00:02:15.

5. In the Timeline, move the position indicator to 1:00:00:06.

6. Click the red Overwrite button.

This adds the title to the V2 video track.

7. Play the sequence to see your title.

Adding Rolling Credits

You can create a title in the Title tool and then make it scroll vertically; 
this is known as a rolling title.
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Editing an Existing Title

To edit the existing title:

1. In the bin, press and hold the Ctrl key, and double-click the 
Rolling Title: Credits clip to open it in the Title tool.

2. Click the pointer and drag it over the entire Your Name text to select 
it.

3. Type in your name.

4. Click the Close button.

A dialog box opens.

5. Click Save.

Two titles appear in the bin (the old title and the new title you just 
edited).

Adding a Video Background

To add video background to your title:

1. Double-click the rowing in mist clip to load it into the Source 
monitor.

2. Clear any IN and OUT points.

3. Click the V1 Record Track button and deselect all other Record Track 
buttons.

4. Click the V1 Source Track button and drag it to the V1 Record Track 
button.

5. In the Timeline, move the position indicator to the end of the sign clip.
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6. Click the yellow Splice-in button.

The rowing in mist clip is added to the sequence.

Viewing the Creation Date

Your edited title has the same name as the version originally in the bin. To 
distinguish the two, you can look at the creation date.

To view the creation date:

1. Click the Source Clips bin to select it.

2. Select Bin > Headings.

3. Select creation date and click OK.

The clips now appear with their creation dates. The new credits clip 
you created has the later creation date.

Splicing the Title into a Sequence

To splice the title into your sequence:

1. Double-click the new Rolling Title: Credits title clip to load it into 
the Source monitor. The new credits clip (you created) will have a new 
creation date.

2. From the Source monitor, click the Play button to play through the 
rolling credit.

The screen shows black at first, then eventually the credits appear.

3. Set an IN point at 00:00:02:12 (NTSC) or at the beginning of the clip 
(PAL).

4. From the numeric keypad type +33:09 and press the Enter key on the 
numeric keypad, and then click the Mark OUT button.

5. In the Timeline, click the position indicator and drag it to the end of 
the intervu: Lowell’s Boat Shop clip on the V2 record track.

6. Click the V2 Record Track button and deselect all other Record Track 
buttons.
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7. Click the V1 Source Track button and drag it to the V2 Record Track 
button.

8. Click the yellow Splice-in button.

The Rolling Title: Credits clip appears over the rowing in mist clip.

9. Click the Play button to view the rolling title over video.

Deleting Excess Footage

There is excess footage continuing beyond the rolling title. To delete the 
excess:

1. Click the V1 Record Track button.

2. In the Timeline, move the position indicator to the end of the Credits 
clip.

3. Press the Add Edit key (P) on the keyboard.

This creates a transition.

4. Click the red Segment Mode (Lift/Overwrite) button under the 
Timeline.

5. On the V1 track, click the last clip (the second rowing in mist clip) in 
the Timeline to select it.

6. Press the Delete key.

The clip is deleted.

7. Save your project and bins and play the sequence.

Closing the Title Tool

To close the Title tool after creating a new title, click the Close button. The 
title appears in the Source monitor and in the bin where you chose to save 
it.

You’ve finished this tutorial. You can go on to “Tutorial: Finishing Mode” 
on page 202 (Symphony only), or “Tutorial: Output” on page 212, or quit 
the Avid system.
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Chapter 10

Finishing Your Sequence 
(Symphony Only)

Correcting color and adding a blurred effect are special effects you can add 
to finish a sequence. 

Finishing is described in the following sections:

• Finishing Mode

• Selecting and Correcting Color

• About the Paint and AniMatte Effect

• About the 3D Effects Option

• About Nesting Effects

Tutorial: Finishing Mode contains the following sections:

• Removing Red from a Clip

• Adding a Blurred Effect
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Finishing Mode

Avid Symphony allows you to add the features you would normally add in 
an offline suite. These include: audio finishing, color correction, keying, 
scratch removal, and matte creation.

Using Finishing Mode

Finishing mode lets you view a sequence in a large window called the 
Playback monitor. When you first open Symphony, the Source and Record 
monitors appear.

To display the Playback monitor in Finishing mode, click the 
Alt+Source/Record Mode button (Windows) or the
Option+Source/Record Mode button (Macintosh).

To go back to Source/Record mode, click the
Alt+Source/Record Mode button (Windows) or the
Option+Source/Record Mode button (Macintosh) again.

Real-Time Effects

A real-time effect is an effect you can apply to a sequence and play 
without rendering, which takes time and disk space. A real-time effect has 
a small orange dot within the Effect icon in the Timeline. Effects that must 
be rendered have a small green or blue dot within the Effect icon in the 
Timeline. The effects you will be adding in this chapter will be real-time 
effects. See the Avid Symphony Effects Guide for more information on 
rendering.

Selecting and Correcting Color

You can select and correct color and the transparency for objects, shadows, 
and borders. The option in the Effect Palette to make changes to color is 
the Color Effect feature.
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Color Effect

The Color Effect is a segment effect you can use to modify the luminance, 
chroma, style (posterized or solarized), and color gain of the segment. You 
can adjust the following parameters:

n For an explanation of these parameters, see “Color Effect” in the Avid 
Symphony Effects Guide.

• Luma Adjust: Brightness, contrast, and invert

• Luma Range: White point, black point, and gamma

• Luma Clip: High and low

• Chroma Adjust: Hue, saturation, and invert

• Color Style: Posterization and solarization

• Color Gain: Red, green, and blue

About the Paint and AniMatte Effect

The Paint Effect enhances the creative and corrective powers of Avid 
Symphony by providing the following features:

• Customizable paint brushes with preset templates and parameters for 
adjustable softness and rotation

• Creation of vector-based objects you can animate and edit

• A variety of paint modes including Erase, Clone, Colorize, Darken, 
Lighten, Blur, Unsharp Mask, Emboss, and more

• Object selection with rescale, lock/unlock, and group/ungroup 
capabilities

• Z-rotation of painted objects

• Outline feathering with bias control

• Magic Mask™ for quick and easy colorization
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The AniMatte™ effect enables you to generate custom matte effects you 
can apply to a segment or transition in a sequence. You can use a variety of 
brushes and painting tools to create matte effects that you can animate. The 
AniMatte effect includes the following features:

• Modes for keying in and keying out images

• Keyframeable animation of matte effects

• Creation of mattes as vector-based objects that allow you to move, 
rescale, and reshape the mattes during a segment or transition

• Freehand painting ability to create organic matte wipes

• Magic Mask, brush shapes, Z-rotation, and feathering

• Export of mattes to create keys in third-party applications

For more information on these effects and how to use them, see the Avid 
Symphony Effects Guide.

About the 3D Effects Option

The 3D effects option delivers a wide range of digital video effects, 
including the following:

• Image effects such as blur (defocus) and resize with rotation and 
perspective

• Two-channel segment effects including smooth motion 
picture-in-picture 

• Shapes, including 3D spheres and four-way page curls

• Positioning, scaling, skewing, and rotation, with perspective

• Source cropping

• Internal borders including beveled and rounded edges

• Soft borders

• Trails and drop shadows with varying opacity

• Highlights, wipe generator, chroma keys, and luma keys
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About Nesting Effects

You can use the Avid Symphony system to place effect tracks inside one 
another to better combine multiple images and digital video effects. This 
involves a process known as nesting, which allows you to use the Timeline 
to step into a track’s edit, perform a series of editing operations, and then 
step out to view and render the effect as one segment on the track. For 
more information on nesting effects, see the Avid Symphony Effects Guide.
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Tutorial: Finishing Mode

In this tutorial, you finish the sequence with some special effects.

n If you need more information, be sure to read the preceding overview 
sections of this chapter before you start this tutorial.

1. If your Avid system is not already running, start it by double-clicking 
the Avid application icon.

2. Select your user name and your Boat Shop NTSC or Boat Shop PAL 
project and click OK.

3. From the Project window, double-click the Source Clips bin.

The clips are displayed in the bin.

Removing Red from a Clip

There seems to be too much red in the intervu: Lowell’s Boat Shop clip. 
Let’s try to remove some of the red.

1. In Finishing mode, double-click the Boat Shop sequence to open it in 
the Playback monitor.

2. Select the V2 track.

3. Move the position indicator over the intervu: Lowell’s Boat Shop 
clip.

4. Click the Step In button at the bottom of the Timeline to step into the 
nested Picture-In-Picture effect.

The Timeline displays the Picture-In-Picture effect only.

5. Select Tools > Effect Palette.

The Effect Palette opens.

6. Click Image from the Effect Categories list.

7. Click the Color Effect icon and drag it to the intervu: Lowell’s Boat 
Shop clip in the Timeline.

Step In
button
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The V2 track becomes highlighted and the Color Effect icon appears 
on the clip.

8. Move the position indicator over the Color Effect icon in the 
Timeline.

9. Click the Effect Mode button.

The Effect Editor opens.

10. Click the Color Gain button to expand it.

11. Click the Red slider and drag it, or press the Left Arrow key on the 
keyboard, until you display 95.

12. Click the Step Out button at the bottom of the Timeline.

13. Click the Source/Record Mode button to exit Effect mode.

14. Play the sequence through.

Color Effect icon

Color Gain button

Step Out
button
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Adding a Blurred Effect

To add a blurred effect:

1. With the Boat Shop sequence loaded into the Playback monitor, turn 
on the V1 track. 

2. Select Tools > Effect Palette.

The Effect Palette opens.

3. Click Image from the Effect Categories list.

4. Click the Paint Effect icon and drag it to the bridge clip in the 
Timeline.

5. Move the position indicator over the Paint Effect icon in the 
Timeline.

6. Click the Effect Mode button.

The Effect Editor opens.

7. Click the Reduce button from the Effect Editor to reduce the image in 
the Playback monitor.

8. Click the Curve Tool button. 

Curve Tool button
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n For more information on using the Curve tool, see the Avid Symphony 
Effects Guide.

9. In the Playback monitor, click and drag to trace a freehand outline 
under the bridge (around the water and sky).

10. Release the mouse button when you are finished with the outline.

A wire-frame outline appears around the area you have selected.

11. From the Effect Editor, click the Mode button to expand it.

12. Within the Mode options, click the Fast Menu button and select Blur.

Fast Menu button
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13. Click the Opacity slider and drag it to 62.

14. Click the Source/Record Mode button to exit Effect mode.

15. Play the sequence through.

You’ve finished this tutorial. You can go on to “Tutorial: Output” on 
page 212, or quit the Avid system.

Move Opacity slider to 62.



Chapter 11

Generating Output

The Avid system provides tools for generating output for individual tracks 
or entire sequences to various videotape or audiotape formats. In addition, 
you can generate an edit decision list (EDL) to be used by editors in a 
videotape suite for preparing a master tape. 

Preparing for output and export is described in the following sections:

• Output Options

• Preparing for Output

• Digital Cut

• About Exporting Files

• Preparing to Export a Sequence

Tutorial: Output contains the following section:

• Recording a Digital Cut to Tape

Output Options

The Avid system provides tools for generating output for individual tracks 
or entire sequences to various videotape or audiotape formats. 



 Chapter 11 Generating Output

208

Preparing for Output
For more information 
on calibrating and 
adjusting video and 
audio output levels, see 
“Video:calibrating 
(advanced) output” and 
“Audio 
output:calibration tone” 
in the Help index.

Preparing for video output involves the following procedures:

• Render all non-real-time effects, as described in the appropriate effects 
guide.

• Establish a sync source for output, as described in the appropriate 
input and output guide.

• Calibrate and adjust video output levels.

• Calibrate and adjust audio output levels.

For more information 
on mixing down audio 
tracks, see “Audio 
tracks:mixing down” in 
the Help index.

• Decide whether you want to generate stereo or mono audio.

• Mix down multiple audio tracks if necessary. Systems equipped with 
an eight-channel audio board can generate a maximum of eight 
channels. Systems equipped with the Digidesign® audio interface can 
generate a maximum of four channels.

• Prepare the record tapes, as described in the appropriate input and 
output guide.

• (Option) Record reference bars and tone to tape.

Digital Cut

The Digital Cut tool provides frame-accurate control when recording a 
sequence to tape. You can also use the Digital Cut tool to preview the 
sequence with a computer-generated countdown.

The Digital Cut tool provides several options for managing the recording 
of your sequence. For example, you can:

• Record using either assemble or insert edits.

• Record a selected portion of the sequence or selected tracks.

• Record an entire sequence.

• Record according to different timecode parameters.

• Select the sequence video and audio tracks to record.
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• Select the tracks to record to on the tape.

• Add black at the end of a digital cut.

The Digital Cut tool has the following operating modes:

• Remote mode allows you to control the decks using the deck controller 
in the Digital Cut tool. This mode provides frame-accurate control 
when you record a sequence to tape.

• Local mode allows you to manually control the decks using the 
controls on the decks. This mode is useful when you need to use non-
Avid-controlled decks, such as consumer-grade VHS or Hi8™. Local 
mode also allows you to preview the output of a digital cut before 
recording it to tape.

You can manually record a digital cut including countdown, but the 
recording will not be frame-accurate. 

About Exporting Files

You can export material directly from your Avid system to many supported 
file types. You can export an individual frame, a selected region of footage, 
or an entire clip or sequence.

There are several reasons why you might want to export video, audio, or 
both from your Avid system: 

• You can export files to be viewed as an AVI or QuickTime® movie.

• You can export files in RealMedia™, ASF, and MPEG-2 formats.

• You can export audio files for audio sweetening in a digital audio 
workstation (DAW), such as a Pro Tools® system.

• You can export video files for touching up or creating special effects in 
third-party applications or other Avid applications.

• You can export files compatible with CD-ROM for use in multimedia 
projects.

• You can use the export process to convert audio media files from one 
supported audio format to another. Your Avid system supports the 
AIFF-C, SD2 (Macintosh only), and WAVE formats.
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n If you plan to transfer the exported files to another Avid system or third-
party application, see the appropriate section in this chapter.

The following sections describe general procedures for preparing to export 
a sequence and for exporting frames, clips, and sequences.

Preparing to Export a Sequence

If you are exporting part or all of a sequence — to create an OMFI file, an 
AAF file, a QuickTime file, an AVI, or a graphic sequence, for example — 
you can speed the export process by preparing the sequence in advance, as 
follows:

• Make sure all media for the sequence is online.

• If you want to archive the source sequence before making any 
alterations you must duplicate the sequence, place the duplicate in 
another bin, and prepare the duplicate for export. The original 
sequence will be unaffected.

• Consider rendering all effects in advance. Although any unrendered 
effects are rendered on export (except for an OMFI export), rendering 
effects in advance saves time during the export process.

• Always render fast-saved titles before using OMFI to export a 
sequence, or before creating an EDL from the sequence. In addition, 
make sure all rolling titles are rendered before using OMFI to export a 
sequence.

• If your sequence contains numerous video tracks, consider mixing 
down the tracks in advance for faster export, unless you need to 
preserve the multiple-track information. 

• If your sequence contains numerous audio tracks with various audio 
effects and level adjustments, consider mixing down the tracks in 
advance for faster export, unless you need to preserve the multiple-
track information.

• Check and adjust all pan and audio levels in advance. All current pan 
and level settings in the sequence are carried to the exported media.

• For OMFI files, consider consolidating the sequence to create smaller 
source clips, thereby saving time and disk space.
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• OMFI files with very complex sequences can fail during import into 
some applications due to memory limitations. Try one of the following 
solutions:

t Break the sequence into smaller sequences and export the new 
sequences. 

t Add more physical memory.

• To export multiple clips in a single OMFI file, create a sequence from 
them. For example, you can select all the clips, Alt+drag (Windows) or 
Option+drag (Macintosh) them into the Timeline to create an instant 
sequence, and then export it.
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Tutorial: Output

In this tutorial, you create a digital cut. 

n If you need more information, be sure to read the preceding overview 
sections of this chapter before you start this tutorial.

1. If your Avid system is not already running, start it by double-clicking 
the Avid application icon.

2. Select your user name and your Boat Shop NTSC or Boat Shop PAL 
project and click OK.

3. From the Project window, double-click the Source Clips bin.

The clips are displayed in the bin.

Recording a Digital Cut to Tape

To record a digital cut to tape:

1. Select Tools > New Deck Controller. Use the deck controller to cue 
and record tape during Digital Cut recording.

2. Load the Boat Shop sequence into the Record monitor. (You cannot 
access digital cut options without a sequence loaded.)

3. Select Output > Digital Cut.
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The Digital Cut tool opens.

4. Select or deselect the Entire Sequence option based upon the 
following:

t Select the Entire Sequence option if you want the system to ignore 
any IN or OUT points and play the entire sequence from start to 
finish.

t Deselect the Entire Sequence option if you have established 
IN points, OUT points, or both for recording a portion of the 
sequence.

5. (Option) Select the Add Black at Tail option and enter a timecode 
duration to add black at the end of the digital cut.

6. Select Remote in the Deck Control option area.



 Chapter 11 Generating Output

214

7. Click the pop-up menu, and select an option from the Deck Control 
option area to indicate where to start recording on the tape:

t Click the pop-up menu, and select Sequence Time to start the 
recording at a timecode existing on tape that matches the start 
timecode of the sequence. If you intend to record several 
sequences to tape one after another, this option requires resetting 
the start timecode on each sequence to match the appropriate IN 
points on the tape.

t Click the pop-up menu, and select Record Deck Time to ignore the 
timecode of the sequence and start the recording wherever the 
record deck is currently cued.

t Click the pop-up menu, and Select Mark In Time to ignore the 
sequence timecode. Establish a specific IN point on the record tape 
by cueing and marking with the deck controls.

8. (Option) Click the pop-up menu, and select the Custom Preroll option 
and select the number of seconds to indicate how many seconds the 
tape rolls before the digital cut starts. This option overrides the preroll 
setting in the Deck Settings dialog box.

9. Select the audio and video tracks you want represented in the digital 
cut from the Sequence Track buttons. Only those tracks beside and 
beneath the selected Audio Track Monitor button and the Video Track 
Monitor button are included in the digital cut.

The display of tracks in the Digital Cut tool varies according to the 
tracks existing in the sequence.

10. Select the video and audio tracks to record to on the tape using the 
Enable Track buttons.
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11. Click the Play Digital Cut button.

The system cues the record deck, and then plays and records the 
sequence. The playback appears in the Record monitor and in the 
Client monitor.

n Depending on the system configuration, you might need to use the Deck 
controls on the Digitize tool to review a digital cut.

12. To stop the recording at any time, press the space bar.

n After assemble-edit recording, a freeze frame is usually added after the 
OUT point for 1 second or more, depending upon the record deck model. 
This provides several frames of overlap for the next IN point before control 
track and timecode break up.

You’ve finished this tutorial. You can go on to “Tutorial: Backing Up” on 
page 225, or quit the Avid system.
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Chapter 12

Backing Up

When you digitize footage, the system creates digital media files for the 
video and audio tracks on the media drives attached to your system. The 
Avid system provides useful tools and features for directly managing 
media files for storage, for playback, for backup, and for transfer between 
systems. 

Backing up is described in the following sections:

• About Media Files

• Basic Media Tool Features

• Freeing Storage Space

• Consolidating Media

• Backing Up Media Files

• Backing Up Project Folders

Tutorial: Backing Up contains the following sections:

• Consolidating the Boat Shop Sequence

• Saving Your Work on a Drive or Floppy Disk

• Restoring from a Backup

• Quitting and Shutting Down
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About Media Files

The system stores the media files created during digitizing in folders on 
your media drives labeled OMFI MediaFiles.

Media files are created in the following circumstances:

• During digitizing, a media file is created for each selected track (for 
example; V1, A1, A2), and they all are linked to the master clip.

• When you render effects, the system creates effect media files, 
otherwise known as precomputes, that are linked to the effect clip.

• When you create subclips and sequences, you do not create new media 
files. These refer to the media files for the source master clips.

• When you import graphics or audio files.

To manage media files, the system also creates a Database file that is 
stored in each MediaFiles folder. The system updates the Database file 
each time you make a change to a media file.

The following illustration shows the links among media files (stored on the 
media drives), the various clips (stored in the bin files in the Avid Projects 
folders on the internal hard drive [Windows] or the Macintosh HD drive 
[Macintosh]), and an edited sequence (shown in the Timeline and stored in 
the bin).
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Media Objects and Files

Drives

Desktop files

Media drive files Internal drive files

OMFI MediaFiles Avid Projects

Bin
Media Database

Precompute media file

Windows Macintosh
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Media Relationships

Table 2 displays the Media File icons and a description of each icon.

Table 2 Media Objects and Files 

Object Icon Object Description

Source clip A clip that references the original videotape source 
footage for master clips.

Master clip A clip that references audio and video media files 
formed from digitized footage or imported files.

Subclip A clip that references a selected portion of a master clip.

Sequence A clip that represents an edited program, partial or 
complete, you create from other clips.

Group clip A file in the bin that combines two or more clips based 
on marks or tracking information synchronization 
points.

Motion effect A file in the bin that references effect media files 
generated when you create motion effects.

Rendered effect
(precompute)

A clip that references an effect media file generated 
when you render an effect.

Effect and Title A clip that references an unrendered effect you create.

Multigroup clip (For multicamera editing) A clip containing two or 
more grouped clips, strung together sequentially 
according to common timecodes.

Media file A file on the media drive containing digital audio or 
video material. Media files are formed when you 
digitize footage or import files, mix down audio or 
video tracks, create an effect (precompute media file), 
or render an effect.
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Basic Media Tool Features

The Media tool provides many of the same controls for viewing and 
managing information you use with bins, including the following:

• Four views in the Media Tool function like those in bins: Brief view, 
Text view, Script view, and Frame view.

• The Media Tool Fast menu gives you quick access to all the same 
commands available in the Bin Fast menu.

• You can highlight, move, copy, duplicate, delete, and sift clips. You 
can also select media relatives, sources, and unreferenced clips.

• You can use Text view headings and display options for columns of 
clip and media file data. You can also use procedures such as 
customizing the display of columns, moving within columns, and 
sorting information as described in “Media Tool:using” in the Help 
index.

• You can use the same Frame view options described in “Using Frame 
View (Windows)” on page 98 or “Using Frame View (Macintosh)” on 
page 98.

• You can use the same Script view options described in “About Bin 
Views” on page 82.

• Media Tool database and display options are saved as user settings. 
When you close the Media tool, the view you are in (Frame, Script, 
Text, or Brief) is saved and any customization of columns are saved. 

• You can print Media Tool data using the same procedures for printing 
bins, described in “Bins:printing” in the Help index.
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The Media tool also has a number of unique functions:

• Unlike bins, the Media tool displays all the tracks digitized for each 
clip as separate media files. Therefore, when you view, delete, and 
manipulate files, you have the added option of specifying individual 
video and audio tracks.

• Unlike a bin, the Media tool does not display sequences and subclips. 
Only master clips, precompute (rendered effect) clips, and associated 
media files are available for display.

• The following menu commands do not apply to the Media tool—Batch 
Digitize, Batch Import, Relink, Modify, AutoSync, and AutoSequence. 
You must perform these functions from the bin.

Freeing Storage Space

Unlike the bin files stored in project folders on the internal hard drive 
(Windows) or the Macintosh HD drive (Macintosh), media files require 
considerable storage space. To maximize your use of storage during larger 
projects, delete unreferenced media files for a finished sequence. This 
procedure is performed on clips selected in bins only.

Consolidating Media

When you consolidate media files, the system finds the media files or 
portions of media files associated with selected clips, subclips, or 
sequences. It then makes copies of them, and saves the copies on a target 
drive you specify. Because the Media tool displays only master clips, you 
cannot consolidate subclips or sequences with the Media tool. You can 
consolidate master clips, subclips, and sequences in the bin.
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About the Consolidate Feature

The Consolidate feature operates differently depending upon whether you 
are consolidating master clips, subclips, or sequences. There are also 
different advantages in each case, as follows:

• Master clips: When you consolidate a master clip, the system creates 
exact copies of the media files. If you link the original master clip to 
the new files, the system creates a master clip with the file name 
extension .old that remains linked to the old files. If you choose to 
maintain the link between the original master clip and the old media 
files, the system creates a new master clip with the file name extension 
.new that is linked to the new files. The new clips are also numbered 
incrementally beginning with .01. Consolidating master clips does not 
save storage space because the system copies the same amount of 
media for each clip.

• Subclips: When you consolidate a subclip or group of subclips, the 
system copies only the portion of the media files represented in the 
subclip, and creates a copy of both the master clips and the 
subclips. The file name extension .new is attached, along with 
incremental numbering beginning with .01.

• Sequences: When you consolidate a sequence, the system copies only 
the portions of media files edited into the sequence, and creates new 
master clips for each clip in the sequence. The file name extension 
.new is attached to the master clips, along with incremental 
numbering beginning with .01. The sequence is not renamed, but is 
automatically relinked to the new media files.

n Because a consolidated sequence is linked to the new files by default, 
consider duplicating the sequence each time you consolidate if you need to 
maintain links to the original files.



 Chapter 12 Backing Up

224

Backing Up Media Files

The MediaFiles folders on your external media drives contain the 
individual media files created when you digitize source material. Unlike 
the smaller Avid Projects and Avid Users folders, these folders are too 
large to back up onto floppy disks.

The following are the options for backing up media files:

• You can use the Consolidate feature, described in “Consolidating 
Media” on page 222, to make copies of selected media files on a target 
hard drive connected to the system.

• You can consolidate or make copies of media files for transfer to 
another system. For more information, see “Consolidating:media” in 
the Help index.

Backing Up Project Folders
To back up the larger 
media files that are 
created when you 
digitize footage, you 
must use a mass-
storage device.

Although the Avid system automatically saves your bins, projects, and 
settings, you should back up these items frequently to avoid losing any of 
your work in case of a hard drive crash or corruption of the files. Because 
the storage requirements are minimal, you can back up these files easily to 
a variety of storage devices, such as:

• Floppy disk

• Network storage device (such as a file server)

• Mass-storage device
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Tutorial: Backing Up

In this tutorial, you learn to back up and free up space on your media drive. 

n If you need more information, be sure to read the preceding overview 
sections of this chapter before you start this tutorial.

1. If your Avid system is not already running, start it by double-clicking 
the Avid application icon.

2. Select your user name and your Boat Shop NTSC or Boat Shop PAL 
project and click OK.

3. From the Project window, double-click the Source Clips bin.

The clips are displayed in the bin.

Consolidating the Boat Shop Sequence

To consolidate the Boat Shop sequence:

For more information 
on rendering effects, 
see the appropriate 
effects guide.

1. Select the Boat Shop sequence.

2. Select Edit > Duplicate.

This allows you to maintain links to the original files, if necessary, and 
render any unrendered effects.

3. Select Clip > Consolidate. 
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The Consolidate dialog box opens.

4. Select one of the following:

t “Delete original media files when done” to delete original media 
files automatically.

t “Skip media files already on the target disk” if some related media 
files are already located on the target drive.

t “Relink selected clips to target disk before skipping” to ensure 
that all selected clips are linked to media on the target drive. This 
option appears when you select “Skip media files already on the 
target disk.”

5. Select a target drive from the Target Drive(s) list. To select additional 
target drives, Ctrl+click (Windows) or Shift+click (Macintosh) the 
drive name in the list.

Make sure you select a target drive with enough storage space for all 
the consolidated media files.

6. Enter a handle length for the new clips in the Handle length text box, 
or leave it at 60 frames to accept the default.

7. Click OK.
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Another way to back up media files is to copy them directly onto another 
hard drive using the Windows or Macintosh desktop. You cannot, 
however, take advantage of the storage-saving features of the Consolidate 
command, and it is more difficult to identify particular media files when 
searching directly through folders

c Do not make copies of media files from the Windows or Macintosh 
desktop while the Avid application is running. Also, do not keep 
duplicate copies of media files online; either delete the originals, take 
the backups offline, or store the backups in a folder with a different 
name.

Saving Your Work on a Drive or Floppy Disk

To save your project on a drive or floppy disk:

1. Mount the drive or insert the floppy disk as appropriate.

2. Double-click the icon for the targeted storage drive or floppy disk to 
open it. Double-click any additional folders to target the appropriate 
storage location.

3. (Macintosh only) Double-click the Macintosh HD drive to open it.

4. Click a project folder, user folder, or settings file and drag it to the 
targeted storage location.

5. When the system finishes copying the files, remove the floppy disk or 
drive and store it.
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Restoring from a Backup

To restore a project, user profile, or settings from a backup storage device: 

If you are restoring an 
individual bin or bins, 
you must relink them to 
the project from within 
the Project window. 
For more information, 
see “Media 
files:relinking” in the 
Help index.

1. Mount the drive or insert the floppy disk as appropriate.

2. Open the drive or floppy disk and the internal hard drive (Windows) or 
the Macintosh HD drive (Macintosh).

3. Click the copies from the storage device and drag them to the 
appropriate folder on the internal hard drive (Windows) or the 
Macintosh HD drive (Macintosh).

4. Start the Symphony or Media Composer application. The restored 
project/user profile/settings appear in the Select User and Project 
dialog box.

Quitting and Shutting Down

To quit and shut down:

1. Click Quit in the Select User and Project dialog box.

2. Select Leave when the system prompts you.

3. (Windows) Press and hold Ctrl+Alt+Delete and click Shut Down to 
shut down your system.

(Macintosh) Select Apple P menu > Shut Down. 

4. After a few seconds, turn off the rest of your hardware.

Folder Contains

Avid Projects Project folders and settings files

Avid Users User folders and settings files

Symphony or Media 
Composer

Site settings
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Summary

Congratulations on completing the Avid Tutorial! We hope you’ve 
enjoyed this introduction to the Avid editing process. After mastering these 
skills, you can proceed to learn more advanced techniques for inputting 
media, adding other effects and titles, and outputting work for digital cuts 
or EDLs.

For further information about any Avid system techniques or features, see 
the Help system or the appropriate editing guide.

Avid also recommends you consult the latest Avid Training Catalog for 
complete descriptions and schedules of Avid’s course offerings. All 
classes are led by trained, experienced professionals. A variety of hands-on 
student activities encourage participant learning. For more information, 
call 800-867-2843 or check the www.avid.com/education Web site.

www.avid.com/education


 Chapter 12 Backing Up

230



Glossary

This Glossary defines terms used in Avid documentation. Some entries 
might not apply to your particular system.

24p 24-fps progressive media. The Avid system creates 24p media by 
combining (deinterlacing) two video fields into a single full, reconstructed 
frame. For NTSC film-to-tape transfers, the system creates 24p media by 
undoing the 2:3 pulldown inserted by the telecine process, removing the 
extra fields, and creating progressive frames.

25p 25-fps progressive media. The Avid system creates 25p media by 
combining (deinterlacing) two video fields into a single full, reconstructed 
progressive frame.

1394 See IEEE Standard 1394.

2:3 pulldown See pulldown.

3/4-inch U-matic One of the first composite videocassette formats, in which the composite 
signal is recorded onto 3/4-inch tape. Used for many years, particularly in 
field recording, the U-matic format is slowly being replaced by more 
advanced and lightweight systems.

4:2:2 digital video A digital video system defined by the ITU-R 601 (CCIR-601) technical 
documentation. 4:2:2 refers to the comparative ratio of sampling of the 
three components of the video signal: luminance and two color channels.
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A-roll A method of conforming that requires the compositing of all multilayer 
effects into a single layer (including laboratory-standard dissolves and 
fades) before assembly. Also called single-strand editing.

A/B-roll 1. A method of conforming that limits the amount of optical work by 
managing most standard dissolves and fades using two strands of film. 
Also called double-strand editing.

2. Alternating scenes, recorded on separate source tapes or film rolls, to 
perform dissolves, wipes, or other types of transitions.

A/D converter Analog-to-digital converter. A device that transforms a continuously 
variable (analog) signal to discrete binary bits that represent digital 
samples of the original signal.

academy Pertaining to specifications that meet the Academy of Motion Picture Arts 
and Sciences standards, such as academy leader, academy format (for film 
stock), academy countdown, and so forth.

add edit An edit added between consecutive frames in a sequence segment within 
the Timeline. An add edit separates segment sections so the user can 
modify or add effects to a subsection of the segment.

ADR 1. Automatic display replacement. The process of looping playback of a 
selected region in a sequence and automatically recording multiple 
replacement takes. 

2. Automatic dialog replacement in film. Also called dubbing.

AES Audio Engineering Society. The primary international organization of 
users and producers of professional audio. The AES maintains a standards 
committee that supervises the work of several subcommittees and working 
groups covering various fields of sound reinforcements.

AES/EBU Audio Engineering Society/European Broadcasting Union. A 
standards-setting organization that defined a digital signal format for 
professional audio input to the Avid video-based editing systems using the 
SA 4 board. This signal format is typically used when you input sound 
directly to Avid video-based editing systems with a digital audiotape 
(DAT) machine, thereby bypassing the videotape recording or digitizing 
process.
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AIFF-C Audio Interchange File Format-Condensed. A sampled-sound file format 
that allows for the storage of audio data. This format is primarily used as 
data interchange format but can be used as a storage format as well. 
OMF Interchange includes AIFF-C as a common interchange format for 
uncompressed audio data.

alpha channel An 8-bit, grayscale representation of an image used to create a mask for 
keying images.

A-mode A linear method of assembling edited footage. In A-mode, the editing 
system performs edits in the order in which they will appear on the master, 
stopping whenever the edit decision list (EDL) calls for a tape that is not 
presently in the deck.

See also B-mode, C-mode, D-mode, E-mode, source mode.

analog recording The common form of magnetic recording where the recorded waveform 
signal maintains the shape of the original waveform signal. All videotape 
source footage is analog. When recorded or digitized (via telecine 
transfer), footage is converted from the analog format to a digital format.

answer print A print made of the final cut for review before the final release print is 
created.

See also work print.

anti-aliasing A computerized process of digitally smoothing the jagged lines around 
graphic objects or titles.

ASCII American Standard Code for Information Interchange. The standard that 
governs the recording of characters by a sequence of binary digits. Most 
computers use ASCII code to represent text, which makes it possible to 
transfer data from one computer to another.

aspect ratio The numerical ratio of a viewing area’s width to its height. In video and 
television, the standard aspect ratio is 4:3, which can be reduced to 1.33:1 
or simply 1.33. HDTV video format has an aspect ratio of 16:9. In film, 
some aspect ratios include: 1.33:1, 1.85:1, and 2.35:1.
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assemble edit An edit where all existing signals on a tape (if any) are replaced with new 
signals. Assemble editing sequentially adds new information to a tape and 
a control track might be created during the edit. The edit is made linearly 
and is added to the end of previously recorded material.

See also overwrite.

ATM Asynchronous transfer mode. A network technology based on transferring 
data in packets of a fixed size. The packet used with ATM is relatively 
small compared to units used with older technologies. The small, constant 
packet size allows ATM equipment to transmit video, audio, and computer 
data over the same network and ensures that no single type of data ties up 
the line.

Current implementations of ATM support data transfer rates of 25 to 
622 Mb/s (megabits per second). This compares to a maximum of 
100 Mb/s for Ethernet, the current technology used for most local area 
networks (LANs).

ATR Audiotape recorder. A device for recording and reproducing sound on 
magnetic recording tape.

Attic folder See Avid Attic folder.

attribute clip A mechanism that applications can use to store supplemental information 
in a special track that is synchronized to the other tracks in a track group. 

audio scrub See scrubbing.

audio sweetening The mixing of sound effects, music, and announcer audio tracks with the 
audio track of the edited master tape, usually during the mixing stages of a 
production. Also called audio postproduction for video.

audio timecode Longitudinal timecode (LTC) recorded on an audio track.

AudioVision A registered trademark of Avid Technology, Inc. A digital, nonlinear audio 
editing system that locks digital video in sync with audio for audio editing 
and sweetening.

AutoSave A feature that saves your work at intervals you specify. Backups are placed 
in the Avid Attic folder.
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AUX Auxiliary track. In a video editing system, a channel reserved for 
connecting an external audio device, a video device, or both.

Avid Attic folder The folder containing backups of your files or bins. Every time you save or 
the system automatically saves your work, copies of your files or bins are 
placed in the Avid Attic folder, until the folder reaches the specified 
maximum. The Avid Attic folder copies have the file name extension .bak 
and a number added to the file name. The number of backup files for one 
project can be changed (increased or decreased) in the Bin Settings dialog 
box.

Avid Projects 
folder

The folder containing your projects.

AVR Avid Video Resolution. The compression level at which visual media is 
stored by the Avid system. The system creates media in a particular AVR 
using proprietary conversion algorithms to convert analog video to digital 
form.

backtiming A method of calculating the IN point by subtracting the duration from a 
known OUT point so that, for example, music and video or film end on the 
same note.

backup A duplicate copy of a file or disk in another location if the original file or 
disk becomes corrupted.

See also Avid Attic folder.

bandwidth The difference between the upper and lower frequency limits of an audio 
sample component.

bar code A pattern of vertical stripes of varying width and spacing that encodes 
information. Bar codes can be used to encode timecode on film.

batch digitize The automated process in which groups of clips, sequences, or both are 
digitized (recorded digitally).

batch record The automated process in which groups of clips, sequences, or both are 
recorded (recorded digitally).
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baud The number of electrical oscillations that occur each second. Baud was the 
prevalent measure for bandwidth or data transmission capacity, but bps 
(bits per second) is used most often now and is more accurate.

Bento A registered trademark of Apple Computer, Inc. A general container 
format and software API (application programming interface). Bento is 
used by OMF Interchange as a storage and access system for the 
information in an OMF Interchange file.

best light A telecine transfer performed with optimum settings of the color grade 
controls but without precise scene-by-scene color correction.

Betacam, 
Betacam SP

Trademarks of Sony Electronics, Inc. Two component videotape and video 
recording standards. Sony Betacam was the first high-end cassette-based 
system, recording video onto 1/2-inch magnetic tape. The SP version 
arrived 3 years after the first Betacam, improving on signal-to-noise ratios, 
frequency responses, the number of audio channels, and the amount of tape 
available on cassettes. SP is now the only type sold.

Bézier A type of curve that you can use for curve segments on Intraframe shapes 
or in some kinds of graphs such as keyframe graphs. A Bézier point on a 
curve allows you to control the smoothness or sharpness of the curve at the 
point.

bin A database in which master clips, subclips, effects, and sequences are 
organized for a project. Bins provide database functions to simplify 
organizing and manipulating material for recording, digitizing, and editing.

black and code Video black, timecode, and control track that are prerecorded onto 
videotape stock. Tapes with black and code are referred to as striped or 
blacked tapes.

black burst A video signal that has no luminance or chrominance components (except 
burst) but contains all the other elements of a video signal. Black burst is 
the reference signal commonly used for timing audio and video samples.

black burst 
generator

An electronic device that emits a signal that registers as pure black when 
recorded on videotape.

blacked tapes See black and code.
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black edits 1. A video source with no image. 

2. A special source you can fade into, out of, or use for other effects.

black level See setup.

black point The luminance value in a video image that you set to be equal to reference 
black when making a color adjustment.

Compare with white point.

blue screen A special effects procedure in which a subject is photographed in front of a 
uniformly illuminated blue or green background. A new background image 
can be substituted for the blue or green during the shoot or in 
postproduction through the use of chroma key.

B-mode A “checkerboard” or nonsequential method of assembly. In B-mode, the 
edit decision list (EDL) is arranged by source tape number. The edit system 
performs all edits from the tapes currently assigned to decks, leaving gaps 
that will be filled by material from subsequent reels.

See also A-mode, C-mode, D-mode, E-mode, source mode.

bps Bits per second. The standard measure of data transmission speeds.

B-roll An exact copy of the A-roll original material, or new original material on a 
separate reel, for use in A/B-roll editing.

brightness See luminance.

bumping up The transfer of a program recorded on a lower quality videotape to a higher 
quality videotape (such as from 3/4-inch to 1-inch videotape, or from 
S-VHS to MII).

burn-in A visible timecode permanently superimposed (burned in) on footage, 
usually in the form of white numbers in a black rectangle. Burned-in 
timecode is normally used for tracking timecode during previews or offline 
editing. A videotape with burn-in is also called a burn-in dub or a window 
dub.
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BVB Black-Video-Black. A preview mode that displays black, newly inserted 
video, and then black again.

B–Y One of the color difference signals in the component color system of the 
NTSC video standard. The signal formula is: 

B–Y = 0.299R (red) – 0.587G (green) + 0.886B (blue) 

See also R–Y, Y.

calibrate To fine-tune video levels for maximum clarity during recording or 
digitizing (from videotape).

Capture Mask 
effect

An effect that converts the format of source data during playback. For 
example, it could convert video frame data between PAL (25 fps) and 
NTSC (29.97 fps) formats.

CCIR Comité Consultatif International des Radio Communications. A mainly 
European organization similar to SMPTE (Society of Motion Picture and 
Television Engineers) in the United States that includes user and vendor 
representatives. Now called ITU (International Telecommunication 
Union).

See also ITU-R 601.

CCIR-601 See ITU-R 601.

change list A list of instructions produced by Film Composer that is used to track and 
compare the differences between two versions of a digital sequence. A 
change list is used to update a work print cutting with specified new edits 
and revisions.

channel 1. A physical audio input or output.

2. One of several color components that combine to define a color image. 
An RGB image is made up of red, green, and blue color channels. In 
color correction, you can redefine color channels by blending color 
components in different proportions.

3. See track.
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character 
generator

An electronic device, or a computer device and software combination, that 
creates letters and numbers that can be superimposed on video footage as 
titles.

chassis The housing for removable disk modules. The chassis contains a power 
supply, drives, and connectors for each module.

chroma Video color.

See also chrominance.

ChromaCurve A trademark of Avid Technology, Inc. ChromaCurve graphs appear in the 
Color Correction tool and are used to adjust the color values in a sequence. 
The graphs plot input values on the horizontal axis and output values on 
the vertical axis. The background color in the graph represents the color 
adjustment in the corrected sequence, and the curve on the graph (created 
by the user) increases or decreases the amount of that color in the corrected 
sequence.

chroma key A method of combining images or parts of images from two different 
sources by replacing a solid color in one source with a picture from the 
second source.

ChromaWheel A trademark of Avid Technology, Inc. ChromaWheel controls appear in 
the Color Correction tool and are used to adjust hue and saturation in a 
sequence. ChromaWheel controls provide an adjustment method that is 
similar to the physical controllers on traditional color correction 
equipment, with the addition of a color background that graphically 
represents the hue and saturation values being adjusted.

chrominance The saturation and hue characteristics of a composite video signal; the 
portion of the video signal that contains color information. Adjust 
chrominance and other video levels before recording or digitizing.

See also chroma.

chunking The transfer of media files in segments so other workgroup users can 
access and use the media before complete files have been sent.

cinching Videotape damage due to creasing or folding.
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circle take A take from a film shoot that has been marked for use or printing by a 
circled number on the camera report.

clip 1. A segment of source material recorded or digitized into your system at 
selected IN and OUT points and referenced in a project bin. The clip 
contains pointers to the media files in which the actual digital video 
and audio data is stored.

2. In a record in a log, which stands for one shot, the clip includes 
information about the start and end timecode for the shot, the source 
tape name, and the tracks selected for editing.

3. In OMFI, a general class of objects in the OMF Interchange class 
hierarchy representing shared properties of source clips, filler clips, 
attribute clips, track references, timecode clips, and edge code clips. A 
clip is a subclass of a component.

See also master clip, media files, subclip.

clock timecode See drop-frame timecode.

C-mode A nonsequential method of assembly in which the edit decision list (EDL) 
is arranged by source tape number and ascending source timecode.

See also A-mode, B-mode, D-mode, E-mode, source mode.

codec Compressor/decompressor. Any technology for compressing and 
decompressing data. Codecs can be implemented in both software and 
hardware. Some examples of codecs are: Cinepak, MPEG, and QuickTime.

color balance The adjustment of the relative levels of color signals to produce the best 
quality image or effect.

color bars A standard color test signal, displayed as a video pattern of eight equal 
width columns (that is, “bars”) of colors. SMPTE color bars are a common 
standard. You adjust video levels against the color bars on your source 
videotape before recording or digitizing.
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color correction The process of adjusting the color characteristics of video material to 
achieve an accurate representation of color and consistency of color from 
one clip in a sequence to another. The term generally refers to adjustments 
made across all the video in a program rather than to individual color 
changes made as part of a single effect.

color frame A sequence of video fields required to produce a complete pattern of both 
field and frame synchronization and color subcarrier synchronization. The 
NTSC system requires four fields; PAL requires eight.

color reference 
burst

The color synchronizing signal included as part of the overall composite 
video signal. When compared with the color subcarrier signal, the color 
reference burst determines the hue of the video image.

color timing The process of selecting color and density values for a film before film 
printing. 

color wheel A circular graph that maps hue values around the circumference and 
saturation values along the radius. Used in the Color Correction tool as a 
control for making hue offset and secondary color correction adjustments.

component video The structuring of the video signal whereby color and luminance signals 
are kept separate from one another using the color-subtraction method Y 
(luminance), B–Y (blue minus luminance) and R–Y (red minus 
luminance), with green derived from a combination. Two other component 
formats are RGB and YUV.

composite print A film print containing both picture and sound.

composite sound 
track

A sound track containing all required sound elements — usually dialog, 
music, and effects mixed in correct proportions.

composite video A video signal in which the luminance and chrominance components have 
been combined (encoded) as in standard PAL, NTSC, or SECAM formats.

compositing The process of layering two or more images on top of one another. 
Examples include titles, keys, and picture-in-pictures.

composition The standard term used by OMF Interchange to refer to an edited sequence 
made up of a number of clips. The OMF equivalent of a sequence in an 
Avid system.
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compression 1. In audio, the process of reducing the dynamic range of the audio 
signal.

2. In video, a lack of detail in either the black or the white areas of the 
video picture due to improper separation of the signal level.

3. A reduction of audio signal detail, video signal detail, or both to reduce 
storage requirements during transformation from analog to Avid 
digital format. In JPEG compression, for example, algorithms for 
variable frame length analyze the information in each frame and 
perform reductions that maximize the information retained. 
Compression does not remove any frames from the original material.

See also lossless compression, lossy compression.

confidence value A measurement, expressed as a percentage, of the probability that the 
pattern the system finds during a motion tracking operation is identical to 
the pattern for which the system is searching. During a motion tracking 
operation, Avid Symphony calculates a confidence value for each tracking 
data point it creates.

conform To prepare a complete version of your project for viewing. The version 
produced might be an intermediate working version or the final cut.

conforming a film 
negative

The mathematical process that the editing system uses to ensure that the 
edits made on a videotape version of a film project (30 fps) are frame 
accurate when they are made to the final film version (24 fps).

Console window A display that lists the current system information and chronicles recently 
performed functions. It also contains information about particular items 
you are editing, such as the shots in your sequence or clips selected from 
bins.

consolidate To make copies of media files or portions of media files, and then save 
them on a drive. The Consolidate feature operates differently for master 
clips, subclips, and sequences.

contrast The range of light-to-dark values present in a film or a video image.

control point A location on a Bézier curve that controls its direction. Each control point 
has two direction handles that can extend from it.
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control track The portion of the video recording used to control longitudinal motion of 
the tape during playback. Control track can be thought of as electronic 
sprocket holes on the videotape.

CPU Central processing unit. The main computational section of a computer 
that interprets and executes instructions. 

crash edit An edit that is electronically unstable, such as one made using the pause 
control on a deck, or using a noncapstan served deck.

crash recording See hard recording.

crawling text Text that moves horizontally over time. Examples include stock and sports 
score tickers that appear along the bottom of a television screen.

cropping The redefining of image boundaries, usually by electronically removing 
the top, bottom, left, or right sides of the image.

crossfade An audio transition in which the outgoing sound gradually becomes less 
audible as the incoming sound becomes more distinct. Also called an audio 
dissolve.

See also dissolve, fade.

crushing the 
blacks

The reduction of detail in the black regions of a film or a video image by 
compressing the lower end of the contrast range.

CU Close-up.

See also ECU.

cue To shuttle a videotape to a predetermined location.

Curves graph An X, Y graph that plots input color values on the horizontal axis and 
output color values on the vertical axis. Used in the Color Correction tool 
as a control for changing the relationship between input and output color 
values.

cut 1. An instantaneous transition from one video source to another. 

2. A section of source or record tape.
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cut list A series of output lists containing specifications used to conform the film 
work print or negative. 

See also dupe list.

D1, D5 Two digital videotape recording formats that conform to the ITU-R 601 
(CCIR-601) standard for uncompressed 4:2:2 digital component video. D5 
is very similar to D1 in that it is a component digital recorder. However, D1 
records with 8-bit accuracy; D5 records with 10-bit accuracy.

See also D2, D3.

D2, D3 Two digital videotape recording formats for composite video. The main 
difference between D2 and D3 is that D2 uses 3/4-inch digital videotape, 
and D3 uses 1/2-inch digital videotape.

See also D1, D5.

DAE,
Digidesign Audio 
Engine

Trademarks of Avid Technology, Inc. The application that manages the 
AudioSuite plug-ins.

dailies Film prints or video transfers of recently shot film material, prepared 
quickly so that production personnel can view and evaluate the previous 
day’s shooting before proceeding. Also called rushes, primarily in the 
United Kingdom.

DAT Digital audiotape. A digital audio recording format that uses 3.8mm-wide 
magnetic tape in a plastic cassette.

decibel (dB) A unit of measurement for audio volume level. 

deck controller A tool that allows the user to control a deck using standard functions such 
as shuttle, play, fast forward, rewind, stop, and eject.

decompose To create new, shorter master clips based on only the material you have 
edited and included in your sequence.

degauss To demagnetize (erase) all recorded material on a magnetic videotape, an 
audiotape, or the screen of a color monitor.
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delay edit See overlap edit.

depth shadow A shadow that extends solidly from the edges of a title or shape to make it 
appear three-dimensional.

See also drop shadow.

digital cut The output of a sequence, which is usually recorded to tape.

digital recording A method of recording in which the recorded signal is encoded on the tape 
in pulses and then is decoded during playback.

digitally record To convert analog video and audio signals to digital signals.

digitize To convert analog video and audio signals to an Avid compressed digital 
signal format.

dip An adjustment to an audio track in which the volume gain level decreases 
or “dips” to a lower level, rather than fading completely. 

direct digital 
interface

The interconnection of compatible pieces of digital audio or video 
equipment without conversion of the signal to an analog form.

direction handle A line extending from a control point that controls the direction of a Bézier 
curve. Each control point has two direction handles. These two handles 
together affect how the curve passes through the control point, with one 
handle controlling how the curve appears before the control point, and the 
other handle controlling how the curve appears after the control point.

disk The medium used to store data in computer-readable form.

dissolve A video or an audio transition in which an image from one source 
gradually becomes less distinct as an image from a second source replaces 
it. An audio dissolve is also called a segue.

See also crossfade, fade.

dithering The process of adjusting adjacent pixels of different colors to give the 
illusion of a third color, which simulates the display of colors that are not 
in the current Color palette.
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D-mode An A-mode edit decision list (EDL) in which all effects (dissolves, wipes, 
graphic overlays) are performed at the end.

See also A-mode, B-mode, C-mode, E-mode, source mode.

dongle A hardware device used as a key to control the use of licensed software. 
The software can be installed on any system but will run only on the 
system that has a dongle installed. The dongle connects to the Apple 
Desktop Bus on Macintosh systems or to the parallel (printer) port on PC 
systems.

double-perf film Film stock with perforations along both edges of the film.

double-strand 
editing

See A/B-roll.

double system Any film system in which picture and sound are recorded on separate 
media. A double system requires the resyncing of picture and sound during 
postproduction.

drop-frame 
timecode

A type of SMPTE timecode designed to match clock time exactly. Two 
frames of code are dropped every minute on the minute except the tenth 
minute, to correct for the fact that color frames occur at a rate of 29.97 fps, 
rather than an exact 30 fps. Drop-frame timecode is recorded with 
semicolons between the digits; for example, 1;00;10;02.

Compare with non-drop-frame timecode.

drop shadow A shadow that is offset from a title or shape to give the feeling of spatial 
dimension.

See also depth shadow.

DTV Digital television. The technology enabling the terrestrial transmission of 
television programs as data.

See also HDTV.
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dubbing 1. In videotape production, the process of copying video or audio from 
one tape to another.

2. In film production, the process of replacing dialog on a sound track.

See also ADR, foley.

dubmaster A second-generation copy of a program master used for making additional 
preview or distribution copies, thereby protecting the master from overuse.

dupe Duplicate. A section of film or video source footage that has been repeated 
(duplicated) one or more times in an edited program.

dupe list A sublist of duplicated clips of film requiring additional prints or copies of 
negative for film finishing. 

See also cut list.

dupe reel A reel designated for the recording and playback of dupes (duplicate shots) 
during videotape editing.

duration The length of time (in hours, minutes, and seconds or in feet and frames) 
that a particular effect or section of audio or video material lasts.

DV Digital video that is transferred through equipment conforming to IEEE 
Standard 1394. This equipment is sometimes called FireWire or i.LINK.

DVE Digital video effect.

dynamic range An audio term that refers to the range between the softest and loudest 
levels a source can produce without distortion.

EBU European Broadcasting Union. A standards-setting organization in which 
only users (not vendors) have a voice. 

See also AES/EBU.

ECU Extreme close-up.

edgecode See edge numbers, key numbers.
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edge filter A filter that applies anti-aliasing to graphics created in the Title tool.

See also anti-aliasing.

edge numbers Sequential numbers mechanically printed or optically exposed along the 
edge of a strip of film to assist in matching negatives to work prints.

edit To assemble film or video, audio, effects, titles, and graphics to create a 
sequence.

edit controller An electronic device, often computer-based, that allows an editor to 
precisely control, play, and record to various videotape machines.

edit rate In compositions, a measure of the number of editable units per second in a 
piece of media data (for example, 30 fps for NTSC, 25 fps for PAL, and 
24 fps for film).

EDL Edit decision list. A list of edits made during offline editing and used to 
direct the online editing of the master.

See also cut list.

effects The manipulation of an audio or a video signal. Types of film or video 
effects include special effects (F/X) such as morphing; simple effects such 
as dissolves, fades, superimpositions, and wipes; complex effects such as 
keys and DVEs; motion effects such as freeze frame and slow motion; and 
title and character generation. Effects usually have to be rendered because 
most systems cannot accommodate multiple video streams in real time.

See also rendering.

EIA Electronic Industries Association. The largest trade organization that 
covers the television and audio fields. EIA publishes a catalog of 
standards; the most important standards to the television and audio 
industries are the ones developed by its Parts Division and its Consumer 
Electronics Group.

electronic editing The assembly of a finished video program in which scenes are joined 
without physically splicing the tape. Electronic editing requires at least two 
decks: one for playback and the other for recording.
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E-mode A C-mode edit decision list (EDL) in which all effects (dissolves, wipes, 
and graphic overlays) are performed at the end.

See also A-mode, B-mode, C-mode, D-mode, source mode.

encoding 1. The addition of technical data such as timecode, cues, or 
closed-captioned information to a video recording.

2. The conversion of RGB S-Video to composite video.

energy plot The display of audio waveforms as a graph of the relative loudness of an 
audio signal.

equalization The balancing of various frequencies to create a pleasing sound by 
attenuating or boosting specific frequencies within the sound.

event A number assigned by the editing system to each performed edit. In most 
computer editing systems, an event defines an action or a sequence of 
actions performed by the computer in a single pass of the record tape.

extract To remove a selected area from an edited sequence and to close the 
resulting gap in the sequence.

eyedropper A tool for taking a color from a screen image and using that color for text 
or graphics.

fade A dissolve from full video to black video or from full audio to no audio, or 
vice versa.

FAT File Allocation Table. A file system used on MS-DOS and Windows 
computers. 

FCC Federal Communications Commission. The United States governing body 
for radio and television broadcasting.

feedback A loud squeal or howl caused when the sound from a loudspeaker is picked 
up by a nearby microphone and reamplified. Also caused when the output 
of a tape recorder is fed back into the record circuit.
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field One-half of the scan lines in an interlaced video frame. In most systems, 
the odd-numbered lines form one field, and the even-numbered lines form 
the second. NTSC video contains approximately 60 fields (30 frames) per 
second, and PAL video contains 50 fields (25 frames) per second.

file system A way of organizing directories and files on a disk drive, such as FAT or 
NTFS for Windows computers. 

See also format.

filler clip A segment of a sequence that contains no audio or video information. 
Filler can be added to the Source monitor (or pop-up monitor) and edited 
into a sequence.

See also filler proxy.

filler proxy The result of a composition specifying media to be played for the filler 
clips in each track.

film timecode Timecode added to the film negative during the film shoot via a film 
timecode generator. Film timecode numbers are synced to the film key 
numbers on the dailies during the telecine transfer process. A special key 
link reader is required for viewing the film timecode. 

flash frame After a long, complex piece is edited, small bits of video might be 
accidentally left in a sequence. When the Timeline is zoomed to 
100 percent, these small, unwanted pieces might not be visible. An editor 
can use the Find Flash Frame command to find these bits.

foley The background sounds added during audio sweetening to increase 
realism.

format To prepare a disk drive or floppy disk for use. For Windows computers, 
you format a disk drive by copying a file system (either FAT or NTFS) to 
the drive.

formatting The transfer and editing of material to form a complete program, including 
any of the following: countdown, test patterns, bars and tone, titles, credits, 
logos, space for commercial, and so forth.
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fps Frames per second. A measure of the film or video display rates 
(NTSC = 30 fps; PAL = 25 fps; SECAM = 25 fps; Film = 24 fps).

frame One complete video picture. A frame contains two video fields, scanned at 
the NTSC rate of approximately 30 fps or the PAL rate of 25 fps.

frame offset A way of indicating a particular frame within the group of frames 
identified by the edge number on a piece of film. For example, a frame 
offset of +12 indicates the twelfth frame from the frame marked by the 
edgecode.

frame pulse A pulse superimposed on the control track signal. Frame pulses are used to 
identify video track locations containing vertical sync pulses.

frame 
synchronizer

A device that allows a nonsynchronous video source, such as a satellite or 
microwave feed, to be used in a timed-video environment by capturing 
entire frames.

freeze frame A video effect that appears to stop the action. Freeze frames can be created 
during recording, digitizing, or during an editing session. Compositions 
can create this effect using a track repeat object that can specify the display 
of a single frame for a period of time.

front porch The portion of the composite video signal that starts at the trailing of the 
picture information and ends at the leading edge of the horizontal sync.

gain 1. A measurement of the amount of white in a video picture.

2. Audio levels or loudness.

See also waveform, white point.

gamma A measurement of the midpoint in the luminance range of an image. Used 
in color adjustments to control the proportions of brighter and darker areas 
in an image. Also called the gray point.

gang Any combination of multiple tracks that are grouped. An edit that is 
performed on one track is also performed on tracks that are ganged 
together.
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generation The number of times material has been rerecorded. The original 
videotaped material is the first generation. A copy of the original is a 
second-generation tape, and so on. Each generation shows a gradual loss of 
image quality. With digital copies, there is little or no loss in quality.

genlock In Broadcast, a system whereby the internal sync generator in a device 
(such as a camera) locks onto and synchronizes itself with an incoming 
signal.

gigabyte (GB) Approximately one billion bytes (1,073,741,824 bytes) of information.

GPI General-purpose interface. In computerized editing systems, GPIs allow 
the computer to control various remote components.

gray point See gamma.

green screen See blue screen.

GUI Graphical user interface. The graphic image on the screen containing 
representations of buttons, sliders, and dials; used to control the editing 
process.

handles Material outside the IN and OUT points of a clip in a sequence. The Avid 
system creates handles when you decompose or consolidate material. The 
Decompose and Consolidate features can create new master clips that are 
shorter versions of the original master clip. The handles are used for 
dissolves and trims with the new, shorter master clips.

hard disk A magnetic data recording disk that is permanently mounted within a disk 
drive.

hard recording The immediate recording of all audio, video, timecode, and control tracks 
on a magnetic recorder. Because hard recording creates breaks in any 
existing timecode or control track on the tape, this procedure is often 
performed on blank tape when an edit is not required or in emergency 
circumstances. Also called crash recording.

HDTV High-definition television. A digital video image having at least two times 
the resolution of standard NTSC or PAL video. The HDTV aspect ratio is 
16:9. (Analog TV has a ratio of 4:3.)
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head frame The first frame in a clip of film or in a segment of video.

headroom 1. In video, the room that should be left between the top of a person’s 
head and the top of the frame when composing a clip.

2. In audio, the amount of available gain boost remaining before 
distortion is encountered.

heads out Film or tape wound on a reel with the tail on the inside next to the hub and 
the head end on the outside.

hertz (Hz) The SI unit of frequency equal to one cycle per second. 

See also kilohertz (kHz), megahertz (MHz).

Hi Con A high-contrast image used for creating matte keys.

HIIP Host Image Independence Protocol. A registered trademark of Avid 
Technology, Inc. HIIP allows the Avid system to import and export files in 
various standard formats. Also called Image Independence.

HIIP folder The folder containing files that support the Host Image Independence 
Protocol.

See also HIIP.

histogram In color correction, a graph that plots the distribution of pixels in an image 
based on their brightness. Provides a visual guide to the makeup of a video 
image in terms of relative luminance.

H phase Horizontal phase. The horizontal blanking interval used to synchronize the 
timing of two or more video signals.

hue An attribute of color perception. Red, green, blue form the color model 
used, in varying proportions, to produce all the colors displayed in video 
and on computer screens. Also called a color phase.

See also vectorscope.

IEEE Standard 
1394

The international hardware and software standard for transporting data at 
100, 200, or 300 megabits per second (Mb/s). 
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Image 
Independence

A registered trademark of Avid Technology, Inc. 

See also HIIP.

I/O device Input/output equipment used to send information or data signals to and 
from an editing computer.

initializing The setting of the computer edit program to proper operating conditions at 
the start of the editing session.

ink numbers The frame identification numbers used to conform a film work print. 
Film Composer cut lists and change lists reference ink numbers.

IN point The starting point of an edit. Also called a mark IN.

See also mark IN/OUT, OUT point.

insert edit An electronic edit in which the control track is not replaced during the 
editing process. The new segment is inserted in program material already 
recorded on the videotape.

See also overwrite.

interface 1. The computer software or hardware used to connect two functions or 
devices.

2. The program access level at which a user makes selections and 
navigates a given system. 

See also GUI.

IRE A unit of measurement of the video waveform scale for the measurement 
of video levels, originally established by the Institute of Radio Engineers. 
The scale is divided into 140 IRE units, 100 above the blanking reference 
line and 40 below it.

ISO 1. Isolation reel. In multicamera production, the source reel for the 
separate (isolated) recording of a single camera, alongside 
simultaneous recordings of the other cameras and a switched line feed.

2. International Organization for Standardization.
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ITU-R 601 The standard for standard-definition component digital video, published by 
the International Telecommunication Union as ITU-R BT.601-5 (formerly 
CCIR-601). This standard defines digital component video as it is derived 
from NTSC and PAL. It forms the basis for HDTV formats as well.

jaggies The rough edges around computer-generated graphic objects and titles.

jam syncing The process of synchronizing a secondary timecode generator with a 
selected master timecode.

JFIF JPEG File Interchange Format. A file format that contains JPEG-encoded 
image data, which can be shared among various applications. JFIF 
resolutions store data at a constant rate; for example, JFIF 300 uses 
300 KB for each frame it stores. JFIF resolutions comply with the 
ISO-JPEG interchange format and the ITU-R 601 standard.

jogging See stepping.

JPEG  Joint Photographic Experts Group. Also, a form of compression developed 
by Avid Technology, Inc.

KEM roll The roll of film used on a KEM flatbed editing system. A KEM roll 
combines multiple takes onto a single roll (a work print, not a negative). 
The maximum length of a KEM roll is 1000 feet (35mm).

kerning The spacing between text characters in print media, such as titles.

key To combine a selected image from one source with an image from another 
source.

See also chroma key.

key color The solid color used to key.

keyframes Points in time where you have set effect parameter values (or, in Marquee, 
object property values). The system uses the values set at keyframes to 
interpolate changes to effects and animated titles.
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Keykode A trademark of Eastman Kodak Company. A film-marking system that 
applies optical information identifying the film stock and footage at the 
edge of the film during manufacture.

key numbers The original frame identification numbers applied by the film 
manufacturers to the film stock. Key numbers are used by the negative 
cutter to conform the film negative. Film Composer cut lists and change 
lists reference key numbers.

kilobyte (KB) Approximately one thousand bytes (1024 bytes) of information.

kilohertz (kHz) One thousand cycles per second. 

See also hertz (Hz), megahertz (MHz).

layback The process of transferring a finished audio track back to the master 
videotape.

See also audio sweetening.

layered tracks The elements of an effect created by combining two or more tracks in a 
specified way, such as nesting one track as a layer within another.

L-cut See overlap edit. 

leader A length of film, tape, or a digital clip placed at the beginning of a roll, 
reel, or sequence to facilitate the cueing and syncing of material.

level A quantitative measure of a video or an audio signal. A low level indicates 
the darker portions in video and the soft or quieter portions in audio; 
conversely, a high level indicates a brighter video image or a louder audio 
signal. The level of audio signal correlates directly with the volume of 
reproduced sound.

lift To remove selected frames from a sequence and to leave black or silence in 
the place of the frames.
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linear editing A type of tape editing in which you assemble the program from beginning 
to end. If you require changes, you must rerecord everything downstream 
of the change. The physical nature of the medium (for example, analog 
videotape) dictates how you place material on the medium.

See also nonlinear editing.

line feed A recording or live feed of a program that switches between multiple 
cameras and image sources. Also known in sitcom production as the 
director’s cut. 

load 1. A roll of film stock ready to be placed in the camera for photography. 
A 1000-foot load is a common standard.

2. A group of multicamera reels shot at the same time, sharing the same 
timecode, and numbered accordingly.

locator A mark added to a selected frame to qualify a particular location within a 
sequence. User-defined comments can be added to locators.

log 1. To enter information about your media into bins at the beginning of the 
editing process. Logging can be done automatically or manually.

2. See shot log.

looping The recording of multiple takes of dialog or sound effects.

lossless 
compression

A compression scheme in which no data is lost. In video compression, 
lossless data files are usually very large.

lossy 
compression

A compression scheme in which data is thrown away, resulting in loss of 
image quality. The degree of loss depends on the specific compression 
algorithm used.

LS Long shot.

LTC Longitudinal timecode. A type of SMPTE timecode that is recorded on the 
audio track of a videotape.

Compare with VITC. See also timecode.
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luminance The measure of the intensity of the combined color (white) portion of a 
video signal.

M & E track The common designation for a single sound track containing music and 
sound effects but not dialog.

magnetic track A sound track recorded on magnetic sound recording film.

mark IN/OUT 1. The process of entering the start and end timecodes for a clip to be 
edited into a sequence.

2. The process of marking or logging timecode numbers to define clips 
during a logging, recording, or digitizing session.

See also IN point, OUT point.

mask 1. In film, a border placed over an image with a 3:4 aspect ratio to create 
the look of an another aspect ratio, such as wide-screen.

2. See alpha channel.

master The tape resulting from editing. The finished program.

master clip In the bin, the media object that refers to the media files recorded or 
digitized from tape or other sources.

See also clip, subclip.

master shot The shot that serves as the basic scene, and into which all cutaways and 
close-ups will be inserted during editing. A master shot is often a wide shot 
showing all characters and action in the scene.

master/slave A video-editing process in which one or more decks (the slaves) are set to 
imitate the actions of another deck (the master).

matchback The process allowing you to generate a film cut list from a 30-fps video 
project that uses film as the source material.

matchback 
conversion

The conversion from film to video frame rates.
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match-frame edit An edit in which the last frame of the outgoing clip is in sync with the first 
frame of the incoming clip, such that the incoming clip is an extension of 
the outgoing clip.

matte key A video effect comprised of three components: the background video, the 
foreground video, and the matte or alpha channel (black and white or 
grayscale silhouette) that allows one portion of the image to be 
superimposed on the other.

media The video, audio, graphics, and rendered effects that can be combined to 
form a sequence or presentation.

media data Data from a media source. Media data can be:

1. Analog data: film frames, Nagra tape audio, or videotape video and 
audio. 

2. Digital data: either data that was recorded or digitized such as video 
frame data and audio samples, or data created in digital form such as 
title graphics, DAT recordings, or animation frames.

media files Files containing the compressed digital audio and video data needed to 
play Avid clips and sequences.

See also clip, compression.

media sample 
data

See safe color limiting.

megahertz (MHz) One million cycles per second. 

See also hertz (Hz), kilohertz (kHz).

MIDI Musical Instrument Digital Interface. A standard protocol that allows a 
user to control electronic music equipment from a PC.

MII format A component videotape format created by Panasonic in an effort to 
compete with Sony Betacam. MII is an extension of the VHS consumer 
format as Sony Betacam is an extension of the Betamax home video 
technology.
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mix 1. A transition from one video source to another in a switcher.

2. The product of a recording session in which several separate sound 
tracks are combined through a mixing console in mono or stereo.

mixdown audio The process that allows the user to combine several tracks of audio onto a 
single track.

monitor 1. In video, a picture tube and associated circuitry without tuner or audio 
sections. The monitor includes the display of source media, clips, and 
sequences. 

In Avid products, virtual monitors are displayed on the screen in which 
source media, clips, and sequences can be edited.

2. In audio, to monitor specific audio tracks and channels, or another 
name for the speakers through which sound is heard.

MOS The term used for silent shooting. From the pseudo-German, “Mit Out 
Sprechen”— without talking.

motion effect An effect that speeds up or slows down the presentation of media in a 
track.

motion tracking The process of generating position information that describes motion in a 
clip, for example, the changing position of a moving vehicle. You use 
motion tracking data to control the movement of effects.

See also stabilization.

MU/FX or MUFX See M & E track.

multicamera A production or scene that is shot and recorded from more than one camera 
simultaneously.

multiple B-roll A duplicate of the original source tape, created so that overlays can be 
merged onto one source tape.

multitrack A magnetic tape or film recorder capable of recording more than one track 
at a time.

NAB National Association of Broadcasters.
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Nagra A brand of audiotape recorder widely used in the film production and 
postproduction industries.

negative 1. A film element in which the light and dark areas are reversed 
compared to the original scene; the opposite of a positive.

2. A film stock designed to capture an image in the form of a negative.

noise 1. In video, an aberration that appears as very fine white specks (snow) 
and that increases over multiple generations. 

2. In audio, a sound that is usually heard as a hiss.

noncomposite 
video

A video signal that does not contain horizontal and vertical sync pulses.

non-drop-frame 
timecode

An SMPTE timecode format that continuously tracks NTSC video at a rate 
of 30 fps without dropping frames to compensate for the actual 29.97-fps 
rate of NTSC video. As a result, non-drop-frame timecode does not 
coincide with real time. Non-drop-frame timecode is recorded with colons 
between the digits; for example, 1:00:10:02.

Compare with drop-frame timecode.

nonlinear Pertaining to instantaneous random access and manipulation of any frame 
of material on any track and on any layer of an edit sequence.

nonlinear editing A type of editing in which you do not need to assemble the program from 
beginning to end. The nature of the medium and the technical process of 
manipulating that medium do not dictate how the material must be 
physically ordered. You can use nonlinear editing for traditional film 
cutting and splicing, and for recorded or digitized video images. You can 
make changes at the beginning, middle, or end of the sequence.

See also linear editing.

NTFS New Technology File System. A file system used on Windows computers. 
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NTSC National Television Standards Committee. The group that established the 
color television transmission system used in the United States, using 525 
lines of information scanned at a rate of approximately 30 fps.

See also PAL, SECAM.

offline Pertaining to items that are unavailable to the computer, such as offline 
disks or media files.

offline edit The preliminary or rough-cut editing that produces an EDL (edit decision 
list).

OMFI Open Media Framework Interchange. A standard format for the 
interchange of digital media data among heterogeneous platforms. The 
format is designed to encapsulate all the information required to 
interchange a variety of digital media, such as audio, video, graphics, and 
still images as well as the rules for combining and presenting the media. 
The format includes rules for identifying the original sources of the digital 
media, and it can encapsulate both compressed and uncompressed digital 
media data.

one light A telecine transfer or film print produced with a single setting of color 
correction values. One light is the simplest, fastest, and least costly type of 
transfer.

online edit The final edit using the master tapes and an edit decision list (EDL) to 
produce a finished program ready for distribution; usually associated with 
high-quality computer editing and digital effects.

opticals The effects created in a film lab through a process called A-roll and B-roll 
printing. This process involves a specified manipulation of the film 
negative to create a new negative containing an effect. The most common 
opticals used in film editing are fades, dissolves, and superimpositions.

origin A reference point for measuring sections of recorded or digitized sample 
data. A file mob value for the start position in the media is expressed in 
relation to the origin. Although the same sample data can be rerecorded or 
redigitized, and more sample data might be added, the origin remains the 
same so that composition source clips referencing it remain valid.
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original negative The actual film stock used in the camera to photograph a scene. 

OUT point The end point of an edit, or a mark on a clip indicating a transition point. 
Also called a mark OUT.

See also IN point, mark IN/OUT.

outtake A take that is not selected for inclusion in the finished product.

overlap edit An edit in which the audio and video signals are given separate IN points 
or OUT points, so the edit takes place with one signal preceding the other. 
This does not affect the audio and video synchronization. Also called 
L-cut, delay edit, or split edit.

overwrite An edit in which existing video, audio, or both is replaced by new material.

See also splice.

oxide A metallic coating on videotape or magnetic film that is magnetized during 
the recording process.

PAL Phase Alternating Line. A color television standard used in many 
countries. PAL consists of 625 lines of information scanned at a rate of 
25 fps.

See also NTSC, SECAM.

palette A central location for user-selectable buttons, which you can map to 
various functions for ease of use. The Command palette houses all the 
user-selectable buttons that allow you to perform a wide range of 
commands with a single click of the mouse.

partition A method of assigning disk space that creates two or more virtual disks 
from a single physical disk (similar to creating a directory).

patching The routing of audio or video from one channel or track in the sequence to 
another.

pedestal See setup. 

points The mark IN and mark OUT entered in the Timeline.
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pop-up monitor An ancillary monitor used to view and mark clips and sequences.

position bar The horizontal rectangular area beneath the Source monitor, Record 
monitor, Playback monitor, Composer monitor, and Source pop-up 
monitor that contains the position indicator.

position indicator A vertical blue line that moves in the position bar and in the Timeline to 
indicate the location of the frame displayed in the monitor.

postroll A preset period of time during a preview when a clip will continue to play 
past the OUT point before stopping or rewinding.

precomputed 
media

A computed effect stored in a file and referenced by a composition or 
sequence. Applications can precompute effects that they cannot create 
during playback.

prelay The phase of audio postproduction during which music, sound effects, 
dialog replacement, and announce tracks are added to the master 
multitrack before the final mix.

preroll The process of rewinding videotapes to a predetermined cue point (for 
example, 6 seconds) so the tapes are stabilized and up to speed when they 
reach the selected edit point (during recording or digitizing of source 
material from a video deck).

preview To rehearse an edit without actually performing (recording) it.

preview code An additional reference numbering system, like key numbers, supported 
by Film Composer for comparing digital sequences with evolving work 
print versions using change lists.

primary color 
correction

Color correction that applies to every part of a video image, or to every 
part of a video image that falls within a defined luminance range.

See also secondary color correction.

print A positive copy of the film negative produced in the laboratory. 

See also answer print, release print, work print.

process shot A shot photographed specifically to be part of a special effects composite.
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Program side In color correction, the second of two available levels of color adjustment. 
Corrections made on the Program side typically apply a final look to a 
finished sequence, for example, by fine-tuning the color values to enhance 
the mood of a dramatic program.

See also Source side.

progressive 
media

Media composed of single frames, each of which is vertically scanned as 
one pass. 

project A data device used to organize the work done on a program or series of 
programs. Bins, rundowns, and settings are organized in the Project 
window. The project bins contain all your clips, sequences, effects, and 
media file pointers.

Protection master A copy (dub) of a master tape, usually made immediately after the master 
has been recorded. It is used as a backup if the master is damaged.

pulldown A process in which extra fields are added or “pulled down” during the 
conversion of 24-fps material to 30-fps NTSC or 25-fps PAL videotape. 
This conversion can be a telecine film-to-tape transfer or a 24p 
high-definition (HD) downconversion. Special procedures are required 
when recording or digitizing to eliminate the extra pulldown fields and to 
achieve true 24-fps editing. (PAL video with pulldown is not currently 
supported in Avid editing systems.)

pulldown phase In a project based on an NTSC 24-fps to 30-fps transfer, the video frame at 
which a master clip starts: A, B, X, C, or D. The pulldown phase represents 
the pulldown-to-timecode relationship. Also called pullin frame.

pullin An Avid term that combines two words — pulldown and IN point. The 
pullin is the column where the user logs the pulldown phase of the start 
timecode as either A, B, X, C, or D. The user can modify this field before 
or after recording or digitizing.

pullout An Avid term that combines two words — pulldown and OUT point. The 
pullout is the column where the user logs the pulldown relationship at the 
sync point of the OUT point (end timecode) as either A, B, C, or D. This 
field cannot be modified by the user and is calculated by the system based 
on the pullin and the duration of the clip.
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radio frequency 
(RF)

The high-frequency portion of the electromagnetic spectrum used for 
transmitting television and radio signals.

See also UHF, VHF. 

RAID Redundant Array of Independent Disks. The storage device standards that 
provide fault tolerance, which helps to recover a system if a drive 
malfunctions. RAID is also used to enhance throughput of stored data.

RAM Random-access memory. Computer memory that is volatile and
unsaved — information in RAM clears when the computer is turned off.

random access The ability to move to a video point instantly, without having to shuttle.

real time The actual clock time in which events occur.

record To convert analog video and audio signals to an Avid compressed digital 
signal format.

reel A spool with a center hub and flat sides on which magnetic tape is wound. 
Generally, a spool of tape is referred to as a reel, and a spool of film is 
referred to as a roll.

region of interest The part of an image that the user identifies as the target for a motion 
tracking operation. Also called the search pattern.

rehearse To play a sequence in the Timeline from the preroll through the postroll.

rehearse postroll To play a sequence in the Timeline from the current position to the 
postroll.

rehearse preroll To play a sequence in the Timeline from the preroll to the current position.

release print A film print ready for presentation to an audience. Release prints generally 
include both picture and sound tracks. 

See also answer print, work print, YUV.

rendering The merging of effect layers to create one stream of digital video for 
playback in real time. 
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repeat effect A type of effect for repeating a frame so that it appears to “freeze” or stop 
the frame, or for repeating a series of frames, such as a series of animation 
frames.

replace edit An edit in which a segment in the sequence is overwritten or replaced with 
source material of matching duration.

resolution The amount and degree of detail in the video image, measured along both 
the horizontal and vertical axes. Usually, the number of available dots or 
lines contained in the horizontal and vertical dimensions of a video image. 
Also, the number of color or grayscale values that can be added, usually 
stated in bits, such as 8-bit or 24-bit. Sometimes dots per inch (dpi) is 
referred to as the resolution, although it is more properly called the screen 
density.

RF See radio frequency (RF). 

RGB Red, green, and blue. In computer systems, the additive primary colors 
used to create all other colors on a computer monitor.

RIFF wave See WAVE.

ripple The process in edit decision list management of adjusting the times of all 
edits following a length-altered edit.

RMAG Removable magnetic disk. RMAGs are used in conjunction with chassis; 
each chassis can hold two of these removable disk modules.

roll A length of film wound on a spool or core. Generally, a spool of film is 
referred to as a roll, and a spool of tape is referred to as a reel.

rolling text Text that moves vertically across an area over time. The most common 
example of rolling text is credits at the end of feature films and television 
programs.

rough cut A preliminary edit of a program, usually the result of an offline edit.

See also work print.
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RS-170A The Electronic Industries Association timing specification for NTSC 
broadcast video equipment. RS-170A specifies the timing of scans and 
blanking required to decode color signals.

RS-232C The Electronic Industries Association standard interface for connecting 
serial devices. Usually referred to by the original standard name of 
RS-232. The standard supports two types of connectors: a 25-pin D-type 
connector and a 9-pin D-type connector. The maximum permissible line 
length under the specification is approximately 15 meters.

RS-422 The Electronic Industries Association standard interface for connecting 
serial devices. The RS-422 is an enhancement of the RS-232C standard. It 
allows for higher data rates and an extended line length to approximately 
1200 meters.

rushes See dailies.

R–Y One of the color difference signals in the component color system of the 
NTSC video standard. The signal formula is:

R–Y = 0.701R (red) – 0.587G (green) – 0.114B (blue)

See also B–Y, Y.

safe action area, 
safe title area

The regions of the video image considered safe from cropping for either 
the action or on-screen titles, taking into account variations in adjustments 
for video monitors or television receivers. Safe action is 90 percent of the 
screen measured from the center, and safe title is 80 percent.

safe color limiting The process of adjusting color values in a finished program so that they 
meet broadcast standards for luminance, composite signal, or RGB gamut.

sample data The media data created by recording or digitizing from a physical source. 
A sample is a unit of data that the recording or digitizing device can 
measure. Applications can play digital sample data from files on disk. 

sample plot The representation of audio as a sample waveform.

sample rate The frequency of the sample units.
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sample unit A unit of measure used in recording or digitizing media data from a 
physical source, such as a videotape. Media data contains its own sample 
rate and the size of each sample in bytes.

sampling The process of measuring the value of an analog signal at regular intervals 
during recording or digitizing. These measurements (“samples”) are used 
to construct a digital representation of the signal.

satellite mode Recording using LTC timecode of live events, multicamera shows, and 
video material coming in on routers. Allows you to record to the 
NewsCutter system from multiple external sources at the same time they 
are recording to tape.

saturation A measurement of chrominance. Saturation is the intensity of color in the 
video signal.

See also vectorscope.

scale bar A control in the Timeline window that allows you to expand and contract 
the Timeline area centered around the blue position indicator.

SC phase Subcarrier phase. The method used to calibrate the colorburst portion of a 
composite video signal.

SC/H phase Subcarrier to horizontal phase. The phase relationship between the burst 
and the horizontal blanking reference point for a video signal. Used to 
synchronize the timing of two or more video signals.

screening A showing of a film program, a video program, or raw footage.

scroll bar A rectangular bar located along the right side or the bottom of a window. 
Clicking or dragging in the scroll bar allows the user to move or pan 
through the file.

scrubbing The process of shuttling through audio at various speeds as the audio pitch 
changes.

search pattern See region of interest.
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SECAM Séquential Couleur à Memoire. A color television standard developed in 
France and used throughout Europe.

See also NTSC, PAL.

secondary color 
correction

Color correction that applies to specific parts of an image defined by hue 
and saturation values. A secondary color correction can change the green 
parts of an image to yellow without altering other colors in the image.

See also primary color correction.

SEG Special effects generator. A section of a switcher that provides the 
capability to perform wipes of various patterns.

segment A section of a track or clip within a sequence in the Timeline that can be 
edited.

sequence An edited composition that often includes audio and video clips and 
rendered effects connected by applied transitions. The Avid system 
contains a Timeline that graphically represents the edited sequence.

serial timecode See LTC.

setup A reference point in the video signal that is the blackest point in the visible 
picture. Also called black level or pedestal. 

See also waveform.

shared volume 
segmentation

See chunking.

shelf The effect produced by a shelving equalizer in which the response curve 
for a certain range of the frequency spectrum (high or low frequency, for 
example) flattens out or “shelves” at the limits of the audio spectrum. In 
audio equalization, adjustments to the shelf affect all frequencies within 
the range of the response curve.

shot log A listing of information about a roll of film or a reel of videotape, usually 
in chronological order.

shuttling The viewing of footage at speeds greater than real time.



Glossary

271

SI Système International d’Unites. The French version of the International 
System of Units. SI is roughly equivalent to the metric system.

sifting The displaying of clips that meet specific criteria in a bin.

signal-to-noise 
ratio

The ratio of a wanted signal to an unwanted signal.

silence Blank (black) space in the audio tracks in a Timeline that contains no audio 
material.

single-perf film Film stock that is perforated along one edge only.

single-strand 
editing

See A-roll.

slate An identification board held briefly in front of the camera at the beginning 
of a take that displays information about the take. A smart slate also 
includes a timecode display that is fed from the sound recorder for 
synchronization purposes.

slewing The synchronizing of decks in computerized editing systems.

slide trimming The outgoing (A-side) and incoming (B-side) frames change because the 
clip remains fixed while the footage before and after it is trimmed.

slip trimming The head and tail frames of the clip change because only the contents of 
the clip are adjusted. The frames that precede and follow the clip are not 
affected.

smart slate See slate.

SMPTE Society of Motion Picture and Television Engineers. One of the principal 
standards organizations for the film and video industry.

See also SMPTE timecode, timecode.
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SMPTE timecode A frame-numbering system developed by the Society of Motion Picture 
and Television Engineers that is used primarily for electronic editing and 
timing of video programs. It assigns a number to each frame of video, 
telling the elapsed number of hours, minutes, seconds, and frames; for 
example, 01:42:13:26.

See also time-of-day timecode.

soft wipe A wipe effect from one image to another that has a soft, diffused edge.

sorting The arranging of clips in a bin column in numerical or alphabetical order, 
depending on the column the user selects.

Sound Designer II A trademark of Avid Technology, Inc. An audio file format used for the 
import and export of digital audio tracks.

source clip One of the lowest level building blocks of a sequence composition.

See also clip, master clip, subclip.

source mode A method of assembly that determines in what order the edit controller 
reads the edit decision list (EDL) and assembles the final tape. There are 
five different types of source mode: A-mode, B-mode, C-mode, D-mode, 
and E-mode.

Source side In color correction, the first of two available levels of color adjustment. 
Corrections made on the Source side typically seek to restore the original 
color characteristics of a clip or to achieve basic clip-to-clip color 
consistency among the clips in a sequence.

See also Program side.

specular An intense highlight caused when light reflects off an object in an image. 
A specular is not used as the basis for determining the true white point for 
an image.

speed The point at which videotape playback reaches a stable speed, all servos 
are locked, and there is enough preroll time for editing, recording, or 
digitizing.
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splice An edit in which the material already on the video or audio track is 
lengthened by the addition of new material spliced in at any point in the 
sequence.

See also overwrite.

split edit See overlap edit.

split-screen The video special effect that displays two images separated by a horizontal 
or vertical wipe line.

spot color 
correction

A color adjustment made to a specific part of a video image that is 
identified using drawing tools.

See also secondary color correction.

stabilization A specialized form of motion tracking used to eliminate unwanted motion 
such as camera movement from a clip. Stabilization works by tracking an 
inherently unmoving object in the clip and by repositioning each frame or 
field of video to keep that object stationary.

startup disk The disk that contains the operating system files. The computer needs 
operating system information in order to run.

stepping The movement forward or backward one frame at a time. Also called 
jogging.

story The Avid term for an edited piece. A story is created by editing clips and 
sequences together.

storyboard A series of pictures (traditionally sketches) designed to show how a 
production will look. Comic books are essentially storyboards. 
Storyboards and subsequent sequences can be created by manipulating 
images from the recorded or digitized footage in a bin.

streaming A technology that allows users to watch a video clip or movie over the 
Internet while the video is being copied to their computers. 

See also video stream.
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striped stock 1. Film stock to which a narrow stripe of magnetic recording material has 
been applied for the recording of a sound track.

2. See black and code.

subcarrier (SC) The sine wave used as a color reference signal.

subclip 1. An edited part of a clip. In a sequence, a subclip can be bound by any 
variation of clip beginnings, endings, and mark points.

2. A subclip created by marking IN and OUT points in a clip and by 
saving the frames between the points. The subclip does not contain 
pointers to media files. The subclip references the master clip, which 
alone contains pointers to the media files.

Super 16 The 16mm film stock produced for a special format with an enlarged 
picture area. Super 16 is designed to be printed to 35mm film for release.

sweetening See audio sweetening.

sync 
(synchronization)

1. The pulses contained within a composite video signal to provide a 
synchronization reference for signal sampling. Also, a separate signal 
that can be fed to various pieces of equipment.

2. The sound recorded on a separate audiotape but synchronized with 
videotape or film shot simultaneously.

sync word The portion of SMPTE timecode that indicates the end of each frame and 
the direction of tape travel.

See also timecode, time-of-day timecode.

tail frame The last frame in a clip of film or a segment of video.

tail slate The slate information recorded at the end of the take instead of at the 
beginning; usually recorded upside down.

tails out Film or videotape wound on a reel with the head next to the hub and the 
tail on the outside of the reel.



Glossary

275

TBC Time-base corrector. An electronic device that improves video signal 
stability by correcting time-base errors inherent in mechanical videotape 
recorders.

telecine A device that transfers motion picture film images onto videotape.

text file See ASCII.

three-button play See value.

three-perf film Film stock generated via a modified camera gate that creates a frame size 
three perforations in height rather than the standard four perforations. 
Therefore, the same roll of film lasts 25 percent longer. Three-perf format 
is popular with multicamera film-based shows because the extra 25 percent 
of negative stock is similar to having a free camera.

three-point 
editing

The basic principle that an edit event requires only three marks between 
the source and record sides to automatically calculate the fourth mark and 
complete the edit.

three-stripe Magnetic film stock containing three rows of magnetic oxide coating.

TIFF Tag Image File Format. A tag-based system developed by Aldus 
Corporation for storing and interchanging raster images. The 
OMF Interchange standard includes TIFF as a common format for graphic 
interchange, and it includes TIFF with extensions as a common format for 
video frame data.

time-base error A variation in the stable relation of picture information, color information, 
and video sync pulse during the VTR playback process.

See also sync (synchronization).
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timecode An electronic indexing method used for editing and timing video 
programs. Timecode denotes hours, minutes, seconds, and frames 
(00:00:00:00) elapsed on a videotape. Address track timecode is recorded 
simultaneously with the video picture. Longitudinal timecode (LTC) is 
recorded on an audio track. Vertical interval timecode (VITC) is recorded 
in the vertical blanking interval of the video track. SMPTE timecode is the 
prevalent standard.

Other timecodes exist that include film timecode and audio timecode used 
during film projects. During editing, the Avid system can display and track 
several types of timecode.

See also SMPTE timecode, time-of-day timecode.

timecode window See burn-in.

Timeline The graphical representation of every macroscopic and microscopic edit 
made to a sequence, including all nested effects and layered tracks.

time-of-day 
timecode

The timecode that approximately matches the actual time of day (clock 
time).

See also SMPTE timecode.

title bar The name given to a project or bin, located at the top of a window.

tone A constant audio frequency signal recorded at the start of a tape at 0 VU 
(volume units) to provide a reference for later use. Usually recorded in 
conjunction with color bars.

track 1. The section of tape on which a signal is recorded. Also called a 
channel.

2. The sound portion of a video program.

3. A region of a clip or sequence on which audio or video is placed.

4. A playback channel represented in a sequence as either a video track or 
an audio track. Tracks are composed of one or more segments 
connected by transitions.
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tracker In motion tracking, a structure associated with a specific region of interest 
and containing one set of data points. You can use multiple trackers on the 
same clip to define complex motion.

tracking The positioning of video heads during playback of a tape so that the heads 
reproduce the strongest possible signal. Tracking is adjusted on the deck 
before recording or digitizing.

tracking edit A zero duration edit used as a reference during transition edits (dissolves, 
wipes, and so forth) on computerized editing systems.

track reference A way of making one track play another track’s data. The referencing track 
points to the source clip in the referenced track.

See also layered tracks.

track selector A method of selecting one of the tracks from a track group; only the 
selected track is to be played. For example, a track selector can indicate 
which of four alternate views of the same scene is to be played.

TransferManager An Avid application that allows you to transfer media from one workgroup 
to another. A Fibre Channel network connects the Avid systems and the 
TransferManager to the Avid Unity MediaNetwork environment.

transition A representation of what is to take place as one segment ends and the next 
one begins. The simplest transition is a cut, which occurs in video when 
the first frame of the starting segment directly follows the last frame of the 
segment that is ending.

transition effect A wipe, dissolve, or digital video effect (DVE) applied to an edit 
transition.

See also effects.

transition play 
loop

The loop that plays in Trim mode. You can use the Trim Settings dialog 
box to adjust the lengths of preroll, postroll, and intermission.

trim The process of adjusting transitions in a sequence from the Timeline.

turnover point In audio equalization, the point at which the parametric curve for a 
particular shelf starts to return to zero.
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UHF Ultrahigh frequency. One of the television signals for broadcasting in the 
United States per FCC standards. UHF is the frequency between very high 
frequency (VHF) and super high frequency (SHF).

U-matic See 3/4-inch U-matic.

uncompressed 
video

A recorded or digitized video stream that is not processed by a data 
compression scheme. The video signal remains uncompressed at all stages 
of the process: input, storage, and output. Uncompressed video conforms 
to the ITU-R 601 standard.

Undo/Redo The process that allows a return to the state of the edit immediately 
preceding the last edit or a repeat of an “undo” edit.

up cut In editing, to cut the end of the previous scene, often by mistake. In 
general, to cut short.

user bits The portion of the timecode data available for encoding data chosen by the 
user; for example, footage count or Keykode numbers.

U-type VTR A recorder format that uses 3/4-inch videotape.

value The actual data associated with a particular property in an 
OMF Interchange object.

variable-speed 
play

A process — or an editing-system feature that enables the process — of 
shifting easily between the playing, stepping (jogging), and shuttling of 
footage.

VBV Video-Black-Video. A preview mode that shows a previously recorded 
scene, a black segment, and then the previously recorded scene again.

VCR Videocassette recorder. A video recorder that uses consumer-grade 
videotape formats such as VHS, Betamax, and Hi8.

vector In color correction, a subdivision of the full color spectrum defined by hue 
and saturation values. Secondary color correction uses vectors to define 
specific areas of an image to receive color adjustments.
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vectorscope A visual display that shows the electronic pattern of the color portion of 
the video signal. It is used to adjust the color saturation and hue using a 
stable color reference such as color bars. The Avid Vectorscope monitor 
uses a single-line display.

See also waveform.

vertical blanking 
interval

The period during which the television picture goes blank as the electron 
beam returns (retraces) from scanning one field of video to begin scanning 
the next. The vertical blanking interval is sometimes used for inserting 
timecode, for automatic color tuning, or for captioning information into the 
video signal.

vertical sync Sync pulses that control the vertical field-by-field scanning of the video 
picture by the electron beam.

VHF Very high frequency. One of the television signals for broadcasting in the 
United States per FCC standards. VHF is the frequency between high 
frequency (HF) and ultrahigh frequency (UHF).

VHS Video Home System. The 1/2-inch videocassette format developed by JVC 
for consumer and industrial use.

video 1. The visual portion of a program or sequence.

2. All television other than broadcast television.

videocassette A plastic shell containing two reels and a length of videotape.

Video Slave 
Driver

A trademark of Avid Technology, Inc. A hardware component that 
synchronizes signal inputs, outputs, and conversions; selects audio frame 
rates; and selects pulldown of video frames.

video stream 1. In analog editing systems, also called a video playback source.

2. In digital editing systems, a stream of data making up a digital video 
image.

videotape Oxide-coated, plastic-based magnetic tape used for recording video and 
audio signals.
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VITC Vertical interval timecode. The timecode inserted in the vertical blanking 
interval.

Compare with LTC. See also timecode.

V-LAN A registered trademark of Videomedia, Inc. An industry-standard software 
protocol for video device control. The V-LAN network allows a computer 
application to control and synchronize all connected VTRs, switchers, 
DATs, mixers, and DVEs.

VLXi A registered trademark of Videomedia, Inc. A series of controllers that 
control and synchronize professional video equipment for animation, video 
editing, HDTV, and broadcast television production. 

VTR Videotape recorder.

VU meter Volume unit meter. An instrument used to measure audio levels.

VVV Video-Video-Video. A preview mode that shows a previously recorded 
scene, the new insert video, and then the previously recorded scene again.

WAVE RIFF Waveform Audio File Format. A widely used format for audio data. 
OMF Interchange includes it as a common interchange format for audio 
data.

waveform 1. In video, a visual display that shows the electronic pattern of the video 
signal. It is used to adjust the setup and gain using a stable reference 
such as color bars. The Avid waveform uses a single-line display.

See also vectorscope.

2. In audio, a visual representation of changing frequencies. 

See also energy plot, sample plot.

whip A horizontal picture disturbance at an edit point, usually caused by timing 
misadjustments in the edit system.

white point The luminance value in a video image that you set to be equal to reference 
white when making a color adjustment.

Compare with black point.
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wild sound, wild 
track

A recording of sound on either videotape or audiotape made without an 
accompanying picture.

window dub See burn-in.

wipe A shaped transition between video sources in which a margin or border 
moves across the screen, wiping out the image of one scene and replacing 
it with another.

work print A film print made from the original negative that is used during the editing 
process to produce a cut list or an edit decision list for final program 
assembly. Work prints are typically low-cost, one-light prints that receive 
heavy wear through repeated handling. 

See also answer print, print, release print.

X axis The horizontal axis in a three-dimensional system.

See also Y axis, Z axis.

Y The luminance signal of the component color system in the NTSC video 
standard. The signal is composed of the following proportions of red, 
green, and blue: 

0.299R + 0.587G + 0.114B

See also B–Y, R–Y.

Y axis The vertical axis in a three-dimensional system.

 See also X axis, Z axis.

Y, B–Y, R–Y The luminance and color difference signals of the component color system 
in the NTSC video standard. Also called YCrCb.

YCrCb See Y, B–Y, R–Y, YUV.

YUV The letter designations for luminance, luminance minus red, and 
luminance minus blue. YUV are the luminance and color difference 
signals of the component video standard for PAL. Also called YCrCb.
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Z axis The axis that is perpendicular to the X and Y axes in a three-dimensional 
system.

zero duration 
dissolve

The method of editing two scenes end-to-end simultaneously; also called a 
cut.
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in a digital cut 208

Creating
new user 68
subclips 95
titles 182

Custom view 83
Customer support 20
Customizing your workspace 64
Cut list 49
Cycle Picture/Sound button (Command palette) 

119
Cycle Trim Sides button (Command palette) 138

D
Deck Configuration settings 72
Deck controls (Digitize tool) 73
Deck Selection pop-up menu (Digitize tool) 73
Deck settings 72
Deleting digitized media 74
Desktop 28

Macintosh 29
Windows 28

Digidesign hardware
turning on 28

Digital audio scrub 122
Digital Cut tool 208
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Digital cuts
defined 49
previewing 208
record options 214
recording 208

Digital VU scale (Audio tool) 75
Digitize indicator (Digitize tool) 73
Digitize settings 72
Digitize tool 72
Digitize/Log Mode button (Digitize tool) 73
Digitizing 71–80

and logging at the same time 79
from a mark IN to a mark OUT 79
on-the-fly 79
preparations 78

Disk
saving work on 224

Displaying
digitizing status 73
Project settings 63

Dissolves
creating a series of 172

Drive
saving work on 227

Dual-roller trim 154–157

E
Edit decision list 53
Editing 53

a rough cut 111–131
basics 48
components 49
in Segment mode 134
nonlinear 48
overview 53
preparing for 52
titles 188

Editing buttons
displaying 169

Edits
undoing 130

Effect categories 165
Effect mode

defined 49
in workflow 53, 54
working in 168

Effect Mode button 176, 203
Effect Palette

displaying 165
Effect parameters

segment effects 166
transitions 166

Effect template 164
Effects

adding 163–180
rendering 168
types of 166

Electronic license 35
Enable Timecode button (Digitize tool) 73
Enabling cookies 36
End key 92, 100
Ending the session 109
Entering Trim mode 135
Equipment

turning on 27
Exiting Trim mode 137
Exporting files

preparing for 210
preparing for OMFI export 210
reasons for 209

Extract/Splice-in button 151, 152, 178
Extract/Splice-in tool 152

F
Fade-in effect

adding 170
Files

exporting 209
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Finding information with Help 39
Fixed-storage drive

turning on 28
Focus button (Timeline) 116
Focusing the Timeline 116
Footage

marking IN and OUT points in 94
rearranging 151
removing 152
viewing and playing 86–93

Frame offset 107
Frame tab (Bin window) 84
Frame view

Macintosh 98
Windows 98

Frame view (Bin window) 84
Frames

exporting 210
finding with timecode 105
locating with digital audio scrub 122
title background in 182
using frame offset 107

Freeing storage space 222
Freeze Frame effect

accessing 165

G
General settings

defined 64
Go to Next Edit button (Command palette) 136
Go to OUT button (Command palette) 128
Go to Previous Edit button (Command palette) 

136

H
Hardware

turning on 28

Help system
finding topics in 40
overview 36
printing a topic 42
using Help 39
using the Contents button 40
using the Index button 40
using the Search button 41
What’s This? Help 37

Help Topics
using 39

Home key 92, 100
Hue

adjusting 78

I
I/O Tracking display 131
IN and OUT points

clearing 108
defined 49
marking 94, 102–106

In/Out buttons (Audio tool) 75
Index button (Help system)

using 40
Input pop-up menu (Video Input tool) 77
Installing tutorial files

Macintosh 33
Windows 29

Interface settings
defined 64

Internal Waveform Monitor button (Video Input 
tool) 77

J
J-K-L keys (three-button play) 91, 100
Jogging See Stepping
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K
Keyboard

controlling playback with 89
Keyframes

adding 177

L
Left Arrow key 92
License agreement

accepting 35
Lift button 153
Lift/Overwrite button 173, 174, 195
Luminance

adjusting 77

M
Macintosh Color Picker 187
Macintosh computer

turning on 29
Macintosh desktop 29
Magic Mask

with Paint Effect 199
Make Subclip button (Command palette) 95
Mark Clip button 150, 157, 174
Mark In Time option (Digital Cut tool) 214
Marking clips

for storyboarding 145
using IN and OUT points 102
using timecode 105

Masks
effect types 167

Master clips
consolidating 223
defined 49

Master timecode
displaying 124

Media files
backing up 224
consolidating

defined 222
procedure 225

defined 49
Media Tool features 221
Menu commands

Consolidate (Clip menu) 226
Digital Cut (Output menu) 208
Select All Tracks (Edit menu) 119

Message bar (Digitize tool) 73
Meters (Audio tool) 76
Monitor icons 120
Monitoring audio/video tracks 120
Monitors

viewing in 112
Motion effects

accessing 165
Mouse

controlling playback with 92
Mouse Jog button (Command palette) 92
Mouse Shuttle button (Command palette) 93
Moving through clips 87
Multiple layer effects

defined 166

N
Navigating in the Timeline 114
New Title command (Clip menu) 189
Nonlinear editing

defined 48
Non-real-time effects 168
Numeric keypad 105, 107
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O
OMFI files

preparing to export 210
Online documentation

using 42
Online Help See Help system 36
Opening a project 68
Output 207–215

See also Digital cuts, Playback
options 207
overview 55
preparing for 208

Output button (Audio tool) 76
Overwrite button 145, 151, 157, 192
Overwriting clips

into a sequence 144
with three-point edit 150

P
Paint Effect

described 199
Peak/Hold button (Audio tool) 76
Peripheral hardware

turning on 28
Picture tracks

monitoring 120
Picture-in-Picture effect

applying 174
defined 167

Play button 101, 149
Play Digital Cut button 215
Play IN to OUT button (Command palette) 128
Play key 100
Play Loop button (Command palette) 136, 155
Playback

using buttons to control 87
using position bars and indicator to control 86
using the keyboard to control 89

using the mouse to control 92
Playing

a sequence 123
clips 88

Playing clips 128
Pop-up monitor

splicing a clip into 126
viewing in 113

Position bar 86
Position indicator

in the Timeline 114
moving with frame offset 107
positioning for title creation 189
snapping to IN or OUT points 129
using 86

Precompute 168
Preparing

sequences for export 210
to digitize 78
to edit 52

Preroll
custom for digital cut 214

Preset buttons (Video Input tool) 78
Previewing digital cuts 208
Printing

Help topics 42
Project

closing 109
saving 224
selecting 69
workflow for 50

Project settings
defined 63

Project window
Bins display 60
Settings display 63

Projects folder 58
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Q
Quick Transition button (Fast menu) 172
Quitting the application 228

R
Random access to footage

defined 48
Real-time effects 168
Rearranging clips 150
Record button (Digitize tool) 74
Record Deck Time option (Digital Cut tool) 214
Record monitor

viewing in 112
Recording

digital cuts 208
to the Timeline 74

Redigitizing 80
Reduce button 204
Remove Effect button (Fast menu) 173
Removing footage from a sequence 152
Render Effect button (Fast menu) 179
Rendering effects 168
Repositioning title text 191
Reset Peak button (Audio tool) 76
Resetting peak measurements 76
Resolution pop-up menu (Digitize tool) 73
Restoring files from backup 228
Reviewing basic settings 63
Right Arrow key 92
Rollers See Trim mode
Rolling title

adding 192
Rough cut editing 111–131

S
Saturation

adjusting 78
Saving

a title 191
bins 224
projects 224
settings for video input 78
work to floppy disk or drive 227

Scale bar in Timeline 115
Script tab (Bin window) 85
Script view (Bin window) 85
Scroll bar in Timeline 115
Search button (Help system)

using 41
Search feature

in Help 41
Second Row of Buttons

displaying 170
Segment effects

applying 166
multiple layer effects 166
single layer effects 167

Segment mode
defined 50
in workflow 53
using 134

Select All Tracks command (Edit menu) 119
Selecting

a project 69
Digitize settings 71
title colors 186
tracks in the Timeline 119
transitions for trimming 135
trim sides 138

Selection Tool button 190
Sequence Time option (Digital Cut tool) 214
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Sequences
adding clips to 129
applying effects to 167
changing name of 123
consolidating 223
defined 50
dissolving between clips 172
editing (overview) 53
editing a title into 188
exporting 209
output options for 207
playing 123
rearranging footage in 150
removing footage from 152
splicing into 125
title editing 188

Setting up the browser 36
Settings

Project window 63
Settings pop-up menu (Video Input tool) 78
Setup button (Audio tool) 76
Shutting down the system 228
Shuttling

with J-K-L keys 91
with the mouse 92

Single/Dual Drives button (Digitize tool) 74
Single-layer segment effects 167
Single-roller trim 158
Site settings

defined 63
Small Trim mode

switching between Small and Big Trim mode 
137

Source clips
defined 50
in workflow 52

Source material
displaying in Timeline 116

Source monitor
marking edit points in 94
playing clips in 87, 99
viewing clips in 112

Source/Record mode
defined 50
in workflow 53

Source/Record Mode button 158, 198
Splice-in button 123, 125, 129, 159, 194, 195
Splicing

a clip 129
an audio clip 123
video into audio 125–131

Starting a project
overview 51

Starting Help 36
Starting the application

Macintosh 34
Windows 34

Step buttons 89
Step In button (Timeline) 202
Stepping

with buttons 89
with the keyboard 91
with the mouse 92

Storage space
freeing 222

Storyboard
defined 52
editing 148
marking clips for 145

Subclipping 107
Subclips

consolidating 223
creating 95
defined 50
handle (dot) 95
in workflow 53
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Switching
between Big and Small Trim mode 137
between Digitize mode and Log mode 73

Synched audio
adding 158

T
Tabs

Brief (Bin window) 82
Frame (Bin window) 84
Script (Bin window) 85
Text (Bin window) 83

Tape Name display (Digitize tool) 74
Text for titles

repositioning of 191
Text formatting tools 184
Text tab (Bin window) 83
Text tool

working with 184
Text Tool button 189
Text view 97
Text view (Bin window) 83
Third-party plug-in effects 164
Three-button play 91, 99
Timecode

using as reference for marking 105
Timeline

defined 50
displaying more or less detail 115
displaying source material in 116
focusing 116
lassoing transitions in 136
monitoring tracks in 120
navigating in 114
position indicator 114
scale bar 115
scroll bar 115
segment editing of titles 188
title development 182

Track Selector panel 118
viewing in 114

Title text
repositioning 191

Title tool
creating a new title with 182–189
creating multiple titles 182
window 183

Titles
See also Title tool
editing existing 192
editing into sequence 188
saving 191

Toggle Source button (Digitize tool) 74
Toggle Source/Record button (Timeline) 116
Tool palette 90
Tools for text formatting 184
Track Selector panel

using 118
Tracking audio levels 76
Tracks

monitoring 120
selecting in Timeline 119
titles over video 181

Transition effects
adding 169
applying 166

Transitions
selecting for trimming 135

Transparency selection boxes in Title tool 186
Trash

described 61
Trash button (Digitize tool) 74
Trim A and B sides button 138
Trim A-side button 138
Trim B-side button 138
Trim mode

basic procedures in 135
defined 50
entering 135
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exiting 137
in workflow 53
performing basic trim in 135
selecting single transitions in 135
selecting trim sides in 138
switching between Small and Big Trim mode 

137
using Play Loop button in 136

Trim Mode button 135, 137, 156
Trim sides

selecting 138
Trimming 154–159
Turning on the system

Macintosh 29
Windows 28

Tutorial
installing

Macintosh 33
Windows 29

U
Undo command (Edit menu) 130
Universal Editing and Mastering

brief description 46
User profile

creating new 58
User settings

defined 63
User-selectable buttons 139

V
Variable-speed play See Playback
Vectorscope Monitor button (Video Input tool) 78
Video Input tool 77
Video Input Tool button (Digitize tool) 74
Video output

preparing for 208

Video tracks
monitoring 120

Videotape
recording digital cut to 208

Viewing clips
in bins 96, 112
in monitors 112

Viewing in monitors 112
Viewing source tape name while digitizing 74
Volume

adjusting 159

W
What’s This? Help 37
Windows Color dialog box 187
Windows desktop 28
Workspace

customizing 64
Workspace settings

defined 64
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